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Workshop Overview
Hello and welcome to my most comprehensive Lightroom class to 
date! This workshop will span the course of four weeks, with twen-
ty classes of jam-packed Lightroom training. 

Week one of the workshop is designed to give you a firm foun-
dation of the Lightroom mindset, workfl w, Catalogs, Collections, 
folder systems, adjustments, exporting and printing. Week two will 
focus on organizing and adjusting. This will include projects, key-
words, retouching, noise reduction, vignetting, dehaze, the adjust-
ment brush and flags. In Week three, we’ll cover special features 
such as facial recognition, maps, black & white, HDR, panoramas, 
books, keyword hierarchy and slide shows. Week four will focus on 
fine-tuning your workfl w and that will include fast finding, tips & 
tricks, troubleshooting, mobile, web and publish services.

By the end of the class, you’ll will:

• Learn how to become confident and truly enjoy using Lightroom

• Develop a reliable system that streamlines your work, and lets
you spend more time shooting

• Transform Dull and Ordinary images into Stunning Images

• Know the status of any image at a glance

• Find any important image in 5 seconds or less

Who is this class for?

• Beginners that want an in-depth overview of Lightroom that
starts from the beginning without staying too basic

• Self-Taught users who would like to fill in the gaps in their knowl-
edge and learn the hidden features that are difficul to discover
on your own

• Long-time Lightroom users who want to learn about the newer
features

• Photoshop/Bridge users who want to learn why Lightroom is
better

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  3
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Two Versions of Lightroom
There are now two versions of Lightroom: Lightroom Classic and 
Lightroom CC. Lightroom Classic is a desktop-centered version of 
Lightroom. This is the version we have been used to for years, where 
you store your images on a hard drive and organize them in folders. 
This is the version we will be using in this workshop.  

WHAT IS LIGHTROOM CC?

• Version of Lightroom that uploads all images to Adobe’s servers
online

• Simplified image managemen
(no renaming, folders, etc. to deal with)

• All images available on all devices
(desktop, laptop, phone, tablet)

• Image backups are handled by Adobe on their servers

• Can leverage machine-learning for automatic keyboarding, etc.

Why the name change: CC to Classic for desktop-centered Light-
room? CC stands for Creative Cloud, which makes sense for a cloud-
based version of Lightroom.

WHY I USE LIGHTROOM CLASSIC

• Online is impractical for large image archives
(expensive & slow for large image archives,
I have 200,000+ images)

• CC is still missing many features available in Classic
(HDR, Panoramas, Map, Books, Full Keyboarding, Printing, etc.)

• Amazing organizational choices in Classic are not available in CC

• Currently, CC feels like an overly simplified ersion of Lightroom
(but it has great potential & might eventually be an ideal choice)

• Much of what we learn about Classic also applies to CC

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  4
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LIGHTROOM OVERVIEW

Getting your images into Lightroom

• To see your images in Lightroom, you must fir t import them

• Lightroom only manages those images that you have imported
and ignores the rest of the files clut ering your hard drive

• Lightroom ignores non-photo files like spreadsheets and word
documents

• Lightroom does not force you to change where you store your
images

• Once an image is imported, you can preview it even when the
drive that contains the original is not actively attached to your
computer

• With Smart Previews, you can even adjust your images while the
originals are not available!

• You still need to keep the original files since they are needed in
order to print or export high resolution images

• The originals are not “in” Lightroom
It just knows where they are and has previews of each image

• A single Lightroom catalog can handle hundreds of thousands
of images

Developing a Lightroom mindset

• Everything you do is saved as simple text and therefore can be
saved instantly

• There is no need for open/save commands... There is one for
save, but it’s not what you’d expect

• Changes take up very little space on your hard drive (12K-200K
plus preview), especially compared to Photoshop

• Nothing is permanent... the original is always retained

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  5
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• It’s just the untouched original and a text record of what you’ve
done to it

• All adjustments are text-based and can be copied to other im-
ages easily

• The order you apply adjustments in is unimportant in general
(unlike in Photoshop)

• No need to work on duplicate files sin e original is untouched

• Use a Virtual Copy if you need multiple versions of an image
(Each is based on the same untouched, original image)

The world outside Lightroom

• When you need to share an adjusted image, you export a copy
as a JPEG or TIFF and only that file has the changes permanent-
ly incorporated. You still retain the untouched original

• Deliver the exported images and then trash them… you can al-
ways make more

• Don’t confuse Lightroom by moving, renaming, adjusting or oth-
erwise changing stuff without initiating the change in Lightroom

• Like a warehouse inventory system, if you move stuff, it no longer
matches reality!

• If you need to open an image in Photoshop, start the process in
Lightroom

What about Photoshop & Bridge?

• Lightroom uses the same adjustments that are available in Ado-
be Camera Raw (ACR)

• Lightroom is a good replacement for Bridge and ACR since
it has management features that those two programs do not:
Map, Persistent History, View and Adjustment without original,
Virtual Copies, Book, Slideshows with music, better printing op-
tions and a whole lot more

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  6
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• Use Bridge/ACR when you don’t need to see the image again, or
it’s not a photograph (InDesign, Illustrator, PDF files, e c.)

• When to use Photoshop: when Lightroom is not capable of han-
dling the job or would be inefficie

• Workfl w: Import > Organize > Optimize > Export

JPEG vs. Raw

The two file formats that most people shoot with are JPEG and 
Raw, and it’s important to look at the difference between these two 
formats:

• Raw gives you better looking results when applying color cor-
rection via the white balance sliders

• Raw is capable of delivering additional highlight and shadow
detail compared to JPEG

• Raw contains up to 16,000 brightness levels instead of just over
250, which has the potential of delivering smoother adjustment
results. (which is also why raw files a e larger than JPEG)

• JPEG files are processed in camera, Raw files are processed in
your computer, which is why the unprocessed Raw can look dull
in comparison

• JPEG files apply compression that lowers the quality of the im-
age and introduces artifacts. Those artifacts can become obvi-
ous when extreme adjustments are applied

• JPEG files can be considered delivery-ready, while Raw file
need to be processed and then exported in a different file for-
mat (usually JPEG or TIFF)

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  7
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THE LIGHTROOM INTERFACE
Along the top of the Lightroom interface, you will find the custom-
izable identity plate (on the left) and the names of Lightroom’s 
different modules (on the right). You will spend most of your time 
in the Library module (for importing and organizing) and the De-
velop Module (for adjusting your images). The other options are 
mostly features that help you present your images, like Print and 
Slideshow. 

Regardless of what module you’re working 
in, there will be panels on the left and right 
sides of the screen. These panels contain 
settings/information pertaining to the 
module and they can be hidden from view 
by clicking on the little disclosure triangles 
on the outside edges of the panels. Click 
the little triangle again to expand the pan-
el back into view. Right-click on one of the 
disclosure triangles and a menu will pop 
up that allows you to specify how the pan-
el should behave. Using the manual set-
ting, you would manually click on the dis-
closure triangles to expand and collapse 
the panels. The Auto Hide & Show option 
will cause the panels to stay collapsed un-
til you hover your mouse over the right 
side of the interface, in which case they 
would automatically pop out. 

At the top of Lightroom’s interface, the identity plate is on the left and the various 
modules are on the right. 

Click the little triangles to 
expand and collapse the 
panels in Lightroom

Right-click on one of the 
panel disclosure triangles 
to get a menu that lets you 
determine how the panel 
should behave. 

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  8
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Film Strip At the very bottom of your screen is the Film Strip. This 
section is special because you have access to it in all of Lightroom’s 
modules. This makes it so that you can see and move between your 
images while in the Develop module. Note that you can make the 
Film Strip bigger or smaller by dragging on the line directly above 
it. You can also use the little disclosure triangle to collapse and ex-
pand the Film Strip. 

The Tool Bar Below the image/grid window in the Library module 
is the Tool Bar, which contains tools for changing your image view, 
for flagging photos, sorting, rating, etc. The Tool Bar can also be 
shown or hidden by going to the View menu and choosing Show 
(or Hide) Tool Bar. Alternatively, you can toggle the visibility of the  
Toolbar by tapping the T key.

The Filter Bar When you are in the Library module, you have ac-
cess to the Filter Bar, which can be seen along the top of the im-
age/grid window (the center portion of the interface). This feature 
allows you to limit the number of images you’re viewing by per-
forming a very specific search. If you’re ever in the Library module 
and the Filter Bar is not visible, you can make it appear by going 
to the main menu at the top of the interface and choosing View > 
Show Filter Bar. Alternatively, you can hit the backslash key ( \ ) as 
a shortcut to make it visible. 

The Filmstrip shows small versions of your images along the bottom of the screen.

The Toolbar runs along the bottom of the main image window.

The Filter Bar runs along the top of the main image window.

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  9
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View Modes When you’re in 
Lightroom’s Library Module, 
you will find a series of icons 
in the Toolbar below the image 
window and these icons will 
control what view you’re in. You 
will spend most of your time in Grid View (the fir t icon) and Loupe 
View (the second icon). In Grid View, you can view several images 
at once in a grid that you can scroll down. In Loupe View, you’ll be 
viewing a single, large image. 

There are keyboard shortcuts for moving between modes and it’s a 
good idea to commit these to memory, as they’ll make your work-
fl w much more efficient

• Grid View: G

• Loupe View: E or Space Bar

• Switch between images: Arrow keys

Lightroom has various different full screen modes that you can use. 
We mentioned that you can use the F key to enter Full Screen 
Mode. If you hit Shift+F, it will cycle between different full screen 
choices. You can also switch between modes by going to the Win-
dow menu and choosing Screen Mode. 

Grid View Loupe View

The icons on the left side of the Toolbar
will switch between view modes.

• View image full screen: F

• Develop Module: D

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  10



LIGHTROOM CLASSIC: THE COMPLETE GUIDE
WORKSHOP OVERVIEW & LIGHTROOM TOUR

Copyright 2018 by Ben Willmore. All Rights Reserved

Resizing panels All of the pan-
els in Lightroom can be re-
sized to suit your needs. Hover 
your cursor over the edge of 
the panel until it changes into 
a double-pointing arrow. Then 
click and drag to make the 
panel wider or narrower.

Folder Structure In the Library module, the left side panel is the 
most important area because this is where you navigate all of your 
pictures. In this panel, you’ll find your hard drives and your folder 

list, which contains all of the photos 
you’ve imported into Lightroom. It’s 
not going to show you all the files
on your hard drive. It’s just going to 
show you the ones that have been 
imported. There is a little “light” to 
the left of each hard drive name. If 
the light is green, it means the hard 
drive is connected. If the light is gray, 
it means the hard drive is not con-
nected.

The folder structure you see in this 
panel is reflecting what’s on your 
hard drive. If you move a picture or 
a folder within Lightroom, it will be 
moved on your hard drive.  You can 
expand or collapse the different sec-
tions within the panels in Lightroom 
by clicking on the little disclosure 
triangle to the left of the category 
name. 

Hover your cursor over the edge of a pan-
el and then click and drag to resize it. 

The Folder panel can be found on 
the left side of the Library Module.

Click on the disclosure triangle 
to the left of a folder to reveal its 
contents.

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  11
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The Catalog Panel The Catalog panel is on the left side of the 
screen, right above the Folders panel. It displays basic information 
about your Lightroom catalog, including how many images there 
are (total), how many images were added on the most recent im-
port, etc. 

Adjustment badges When viewing your 
images in the Library module (and in the 
Film Strip), you might notice little badges in 
the corners of the thumbnails (see screen 
shot). These indicate what you’ve done to 
your picture, and there’s a whole bunch of 
them that can show up there. For instance, 
a little square icon indicates that the image 
has been cropped. If there are no badges 
on a thumbnail, it just means that nothing 
has been done to the image. 

Importing at a glance
In Lightroom, you will use the Import Dialog Box to import your 
photos. There are two ways to access the Import Dialog Box:

1. You can go to your operating system and drag a folder of im-
ages onto the Lightroom Icon. When you do this, the Import
Dialog Box will open and on the left side, it will navigate to that
folder on your hard drive.

2. Click on the Import button in the bottom left corner of the Li-
brary module. This will also bring up the Import Dialog Box.

If you chose the fir t option, the source for the images will already 
be selected. If you chose the second option, you will have to tell 
Lightroom where the images are coming from. You can do this by 
navigating to the images’ location on the left side of the dialog box 
where you see your folder structure. Once you’ve chosen the image 

Badges, from left to right:
- Has keywords
- Is in a collection
- Has been cropped
- Has adjustments

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  12
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folder, click on the “Add” button at the top of dialog box. This will 
import the images while keeping them in the same location on your 
hard drive. When you click the Import button on the lower right, the 
images will be imported and you will be taken to the Library module. 

Note that importing will be covered in much greater detail later in 
this course. 

Lightroom’s Import Dialog Box

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  13



DAY 1

HOMEWORK:
ANALYZE YOUR CURRENT SITUATION TO SEE WHERE  

YOU’RE AT AND WHAT AREAS NEED THE MOST WORK.

Brainstorming about your current  
setup and where the weakest areas are 
can help you determine where to spend 
the most time improving your system. 

WEEK 1

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  14



DAY 1

HOW ORGANIZED ARE YOUR IMAGES 
AND PROJECTS?

WEEK 1

If you were to inspect a folder of images that was captured 
three years ago, how long would it take you to evaluate its 
contents and determine the following?

• Which images are ready to show the public?

• Which images are not in a finished state and therefore need more work?

• Which images have already been evaluated and should generally be ignored
since they are not solid images?
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DAY 1

WHERE ARE YOU WEAKEST WHEN IT 
COMES TO LIGHTROOM?

EXAMINE YOUR CURRENT SETUP

WEEK 1

Choose one:

What is your biggest challenge?

Is your folder naming consistent? Y/N

Do you have any duplicate files? Y/N

Are you using a file naming system that is consistent? Y/N

Does each image have a unique file name, or are there many 
duplicate names? Y/N

Adjusting
Ability Organization

Overall  
Understanding Other

WORKSHOP OVERVIEW & LIGHTROOM TOUR  |  16



DAY 1

WHICH OF THESE LIGHTROOM FEATURES 
DO YOU CURRENTLY UTILIZE?

WEEK 1

Can you easily find any image you can remember 
taking?  Y/N
Can you tell where it was taken, who appears in 
the shot and any other important information? Y/N

Collections Keywords Custom labels

RatingsStacking

?
Any negative responses to these questions is an indication of where  
this Lightroom bootcamp class has the largest potential to help you  
improve your current workflow. It’s not something to feel bad about. 
Instead, try to get excited about the fact that you should end up  
radically transforming your experience with Lightroom over the next 
months!
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IMPORTING IMAGES
When you open Lightroom for the very fir t time, the interface will 
be empty, meaning there are no images in it. You need to manually 
import images in order for them to appear in Lightroom, and you 
will utilize Lightroom’s Import Dialog Box to do this. 

The most common way of accessing the Import Dialog box is by 
clicking the Import button at the bottom left of the Library module. 
You can also get there by using the main menu and choosing File 
> Import. Alternatively, you can go to Lightroom’s File menu and
choose Import Photos and Video. You can also drag a folder from
your hard drive over the Lightroom icon and the Import box will
automatically open.

The Import dialog contains many different settings for how your 
images should be brought into Lightroom. Know that after you 
work through these settings, you can save them as a preset so that 
future imports are streamlined. With import presets, you can use a 
condensed version of the Import dialog because you won’t need to 
work through all of the settings. In the condensed version, you sim-
ply choose the import preset, name the shoot, specify the location 
and then hit the Import button. 

As an overview of the Import dialog, it’s divided into four areas:

• The left side is the Source (where your images are coming from),

• The top is where you choose what action is going to take place
when you import your images (move, copy, etc.)

• On the right is the destination, where the images are going

• The main central area contains the image previews

The condensed version of Lightroom’s Import dialog
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Choose the Source When importing, you fir t have to locate the 
images to import. (If you attached a memory card, it is likely that 
Lightroom auto-selects this as the source.)  In the Source panel on 
the left of the interface, you will see any memory card and/or hard 
drives that are attached to your computer. Navigate to the area 
that has the images and select it. The images should appear as 
previews in the main window.

Choose the Action When the previews show up, look at the very 
top. You have four choices: Copy in DNG, Copy, Mode or Add. 

• Add: Add images to the cata-
log without moving them

• Move: Move the images to a
different location on your hard drive

• Copy: Leaves the images in their original location and copies
them to another location. This is generally what we choose when
importing from a card from your camera

• Copy as DNG: Convert into the DNG file ormat on import

The expanded version of Lightroom’s Import dialog
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File Handling: Under File Handling, 
there is a menu called Build Pre-
views. This will determine how the 
previews will look once imported. 
There are four settings. Minimal, 
Embedded & Sidecar, Standard 
and 1:1. I use Embedded & Sidecar. 

• Minimal: Will use previews that your camera created (fastest)

• Embedded & Sidecar: Will take an extra look to see if previews
are included in sidecar files as ell.

• Standard: Create previews that will be able to fit y screen.

• 1:1: Creates full-size previews (largest file size; good for checking
focus on small details like eyes)

The following is my mindset when choosing what kind of previews 
to create. I will choose the Embedded & Sidecar option when I’m 
initially importing my images that already exist into Lightroom. I 
will use the Standard option most commonly when importing new 
images. I’ll choose 1:1 when I’m shooting portraits and know I will 
need to zoom in and check the focus. 

• Build Smart Previews: This is a great feature that creates pre-
views that are actually editable. This way, you can work on the
images without the hard drive containing the images being at-
tached. These previews take up more space than regular pre-
views, but are very convenient when traveling. Smart Previews
can also speed up your work when you’re adjusting your pic-
tures because Lightroom will use the Smart Preview instead of
the full-size file in order to work faster. It will only use the full size
picture when you are zoomed in on your image.

• Don’t Import suspected duplicates: I usually have this check
box turned on, so that I don’t accidentally import the same im-
ages twice. It will only import the images that haven’t already
been imported. If Lightroom detects duplicates, their thumb-
nails will be grayed out in the import image window and they
will not import again.

The Build Previews menu under the 
File Handling tab
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• Make a Second Copy To: If you turn this check box on, you can
choose a second location to import you images to as well. This
feature is great for creating backups when you’re in the field

• Add to Collection If you turn this check box on, a menu will
appear, containing all of the collections you’ve created in Light-
room. (We’ll cover Collections later in the workshop.) Click on
one and when the images are imported, they will automatically
be added to the Collection.

File Renaming The File Renaming section is where you can replace 
the generic file names your camera creates with custom file names 
that you create. In this section, there is a little pop-up menu called 
Template. If you click on the menu, you will get various file nam-
ing template options. If you would like to create a new template, 
choose Edit from the bottom of this menu. A dialog box will appear 
where you can use the various types of information (date, sequence 
number, shoot name, etc.) to customize your file naming template. 
After you’ve created a template, click on the drop-down menu at 
the top of the dialog box and choose “Save Current Settings as 
new Preset.” After giving your new preset a name, it will appear in 
the Template dropdown menu in the future. After choosing a file
naming template, you can also choose the Start Number, which can 
be useful when you’re importing images from a shoot in batches. It 
allows you to start with a sequence number other than one.

The Filename Template Editor is used to create custom file names or your images 
and save the file name settings as p esets for use in the future. 
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Apply During Import The Apply During Import tab will allow you 
to apply different develop presets to your images on import. I don’t 
usually apply any develop settings here in general because there is 
no one develop preset I know I want to apply to every image. 

Also under the Apply During Import tab 
is the Metadata setting. This is where you 
can specify what kind of metadata will be 
attached to your image files upon import. 
An example of this would be your contact 
information and copyright notice. It’s al-
ways good to have this information em-
bedded in your image files. If you have an 
existing Metadata Preset, it will show up in this dropdown menu. If 
not, you can create a new one by choosing the “New” option in that 
menu. When you choose “New,” a dialog box will appear where 
you can fill in several fields of information. There are LOADS of in-

formation fields here, 
and you don’t have to 
pay attention to all of 
them. I generally focus 
on the section called 
IPTC Copyright, as this 
is where I can fill in the 
copyright info I would 
like attached to my 
image files. Remem-
ber to give your new 
preset a name before 
clicking the Create 
button. Note that the 
Metadata setting is 
sticky, meaning it will 
stay the same when 
you go to import your 
next batch of images. 

You can choose to apply a 
metadata preset on import.

The Metadata Preset dialog
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The last area under the Apply During Import tab is the Keywords 
field. This is where you can type in keywords, and they will be ap-
plied to all of the images you are importing. 

Once you’ve worked through all of the settings, you can click the 
Import button in the bottom right of the dialog box. You’ll be taken 
back to the Library module, where there will be a status bar at the 
top as all of the images are imported. 

Select the Destination: (Note this tab will not show up if you chose 
the Add option at the top.) On the right side of the Import Dialog 
Box, you can choose the new destination under the Destination 
tab.  Choose which hard drive you want them to go on from the 
list of available hard drives. Then you can choose a folder beneath 
that. If the images will be going to a new folder, turn on the “Into 
Subfolder” check box and give the folder a name. You can then use 
the small dropdown menu and choose how the images will be or-
ganized. You can choose By Date, By Original Folders, or Into one 
folder. I use Into One Folder. 

Create an Import Preset  After you’ve worked your way through all 
of the settings in the Import dialog, you can save these settings as 
an Import Preset by clicking on the preset menu at the bottom of 
the Import dialog and choosing Save Current Settings as New Pre-
set. You’ll be prompted to give the new preset a name and then click 
Create. Now, this preset will be available in the Import Preset menu. 
Choosing it will 
a u t o m a t i c a l -
ly load in all of 
the settings you 
specified. I like to 
create different 
import presets 
for every type of 
import scenario I 
regularly experi-
ence. 

The Import Preset menu at the bottom of the Import dialog
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WORKING WITH FILES & FOLDERS
Create a folder or subfolder The Folders panel is located on the 
left side of the Library module. To add a new folder, click on the 
little plus icon at the top right corner of the panel. To rename a 
folder, right-click on the name and choose Rename from the menu 
that pops up. To create a folder inside of an existing folder, right-
click on the name of the existing folder and choose Create Folder 
Inside… from the menu that pops up. You’ll be prompted to give the 
new folder a name and then click Create. You can add images to 
a folder by selecting them and then dragging them into the folder 
within the Folders panel.

Show Photos in Subfolders When viewing the contents of a folder, 
you can decide whether you’d like to view just the images inside 
that folder or if you’d like to view the images inside any subfold-
ers [of that parent folder] as well. This setting is located under the 
Library menu. If you don’t want to view images in a folder’s sub-
folder, click on the Library menu and turn off the Show Photos in 
Subfolders setting. 

Renaming file  There are a 
couple of different ways to 
rename files. To rename a sin-
gle fil , click on a file within 
the Library Module to make 
it active and then go to the 
Metadata panel on the right 
side of the interface. The File 
Name field is located near 
the top of the panel and you 
can simply click within it to 
change the file name. To 
change the name of multiple files, make sure they are all selected 
within the Library module and then click on the little icon to the 
right of the File Name field in the Metad ta panel on the right side 
of the interface. The Rename Photos dialog will appear, allowing 
you to choose a filename emplate for the selected images.

We’re renaming a selected file y entering 
a new name within the Metadata panel. To 
rename several images at once, we would 
click the icon on the right (circled) to assign a 
filename emplate.
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Choosing preview type (after import) We talked about creating 
previews during the import process, but what if you want to create 
or change the previews after your images have been imported? 
Select all of the images you want to affect, go to the Library menu 
and choose the Previews option. This will give you a menu of the 
different preview types and you can decide what kind of previews 
you want the selected images to have. 

Assigning metadata (after import) To change the metadata asso-
ciated with an image (or images), makes sure they are all selected 
and then right-click on one of the images and choose Metadata 
Presets from the menu that appears. 

CUSTOMIZING LIGHTROOM
There are several ways that you can customize your Lightroom in-
terface to make it look and work better for you. 

The Identity Plate In the upper left side of your screen is a logo 
that, by default, says Lightroom. This is the Identity Plate and you 
can customize it to show a custom text or logo. Right-click on the 
Identity Plate and choose “Edit Identity Plate” from the pop-up 
menu that appears. You will get a dialog box in which you can 
edit the settings. Use the dropdown menu at the top and choose 
“Personalized.” You can then customize the text, font and color of 

The Identity Plate editor can be accessed by right clicking on the Identity Plate and 
choosing “Edit Identity Plate” or by choosing the Lightroom menu and choosing 
“Identity Plate Setup.”  You can also choose the style of the module names.
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the Identity Plate. If you would like to use a pre-made logo as your 
Identity Plate, turn on the check box that says “Use Graphical Iden-
tity plate” and drag your logo into the text field. (When creating a 
graphical Identity Plate, it’s best to use the PNG file ormat.) 

After creating a custom identity plate, you can save it as a pre-
set by clicking on the second menu at the top of the dialog box 
and choosing “Save Identity Plate As.” Note that any saved identity 
plates can be used later in other areas of Lightroom as well, such 
as the Print Module (you can overlay an identity plate on a print) 
or the Slideshow Module (you can choose to have an identity plate 
appear in your slideshows). 

The Identity Plate Editor also allows you to change the font and 
color of the module names that run along the top of the Lightroom 
interface. 

Customizing the Module Names In the top right of Lightroom’s 
interface, you will find the names of Lightroom’s different mod-
ules. Some of these modules, you will use every day. Others, you 
may never use. If that’s the case for you, it’s possible to change 
which module names appear in this area. If you never use the Web 
or Slideshow modules, why have them visible? To customize this, 
right-click over the names of the modules. A little drop-down menu 
will appear where you can turn on and off the check boxes for the 
different modules. If you turn off the check box for a module, it will 
no longer appear in the menu. You can always go back and make 
it re-appear again by going to that same menu and turning the 
checkbox back on. 

Right-click in the 
area where the 
module names 
are to get a 
menu that allows 
you to choose 
which modules 
are visible. 
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Disabling certain settings If there are any settings that you never 
use, you can temporarily disable them within the interface. To do 
this, right-click in the blank area next to the name of an adjustment 
category/tab. A little dropdown menu will appear where you can 
check off which tabs ou don’t want to appear within the panel. 

Collapse all tabs except the one in use In Lightroom, the left and 
right panels contain lots of different tabs, or settings categories. If 
they are all expanded, you’ll have to 
scroll way down in order to reach the 
ones at the bottom. There is, howev-
er, a setting that will tell Lightroom to 
keep ONLY one of those tabs open at 
a time. This is called Solo Mode. To get 
your interface in Solo Mode, hold down 
the Option Key (Alt on Win) and click 
on one of the little disclosure triangles 
next to the name of the tab. If the tri-
angle is solid, it means that more than 
one tab can be expanded at once. If 
the triangle is speckled, it means that 
the tabs are in Solo Mode. 

If you are in Solo Mode and you temporarily want to have more 
than one tab expanded, hold down the Shift key while clicking on 
the disclosure triangle. This will allow more than one panel to open, 
and when you close it, you’ll return to Solo Mode. 

Auto hide panels Each module of 
Lightroom has panels on the left, 
right, top and bottom. On the out-
side of each of these panels is a lit-
tle disclosure triangle. Right-click 
on that little triangle to get a pop-
up menu where you can change 
the way the panel behaves.

Auto-hide will make it so that you have to move your mouse to the 
side of the screen and click the arrow to make it show up. When 

When the disclosure triangles are 
solid, it means that you can view 
more than one tab at once. When 
they are speckled, it means that 
you are in Solo Mode. 

The menu you get when you right-
click on a panel’s disclosure triangle
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you move your mouse away from the panel, it will disappear again. 
This works for all of the panels within Lightroom. 

Auto Hide & Show makes it so the panel only appears when you 
move your mouse over the edge of the edge of the interface. 

Information overlay settings  Various types of information is shown 
above and below the image thumbnails while in the Grid View in 
Lightroom’s Library module. This information can include file type, 
file name, dimensions in pixels, star rating, etc. You can customize 
what information shows up here by going to the View menu and 
choosing View Options. A dialog will appear that is split into two 
tabs, for Grid View and Loupe View. 

In the options for Grid View, there are many settings you can use 
to determine what info appears on your image thumbnails. As you 
work with the settings, the changes will be updated in your image 
window so you can see how they affect the view.

Above: Various information 
appears around the thumb-
nail in Grid View. Right: The 

information that appears 
can be customized using the 

Library View Options.
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In Loupe View (where a single, large image is displayed in your im-
age window), you can also have information displayed in the top 
corner of the image window. Use the View Options dialog to either 
determine what info appears here, or decide that no info should 
appear at all. To make it so no info appears at all (my preference), 
turn off the Show Info Overlay check box. Alternatively, use the 
various dropdown menus to determine what info should appear 
there. 

Interface Preferences Lightroom’s Preferences can be accessed 
by going to the Lightroom menu (at the top of the screen) and 
choosing Preferences. In Windows, this can be found under the 
Edit menu.

In the Preferences dialog, there are a series of tabs that run along 
the top and these are the different preference setting categories.

An image is being shown in Loupe View and the View Options dialog is being used 
to specify what info should appear. 
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One of those tabs is called Inter-
face and this controls the overall 
look of Lightroom. Here are a few 
of the settings to pay attention 
to:

Show Photos in navigator on 
mouse-over: If you turn this 
check box on, then when you 
hover your mouse over the im-
ages in the Filmstrip, you will see 
a larger preview of the images in 
the Navigator window, which is 
at the top of the left side panel. 

End Marks: End marks are the little graphics that appear at the very 
bottom of the panels on the left and right sides of the interface. 
(You might need to scroll down the panels to see them.) There is 
a setting within the Preferences dialog that allows you to control 
what graphics appear as the end marks. Use the Endmarks drop-
down menu (at the top of the Interface Preferences) to choose 
one of the existing ones (there might only be one) or set a custom 
one.  To choose a custom end mark, choose “Go to Panel Endmarks 
Folder” from the menu. This will take you to the folder on your hard 

drive where the endmarks 
reside. Drag any jpg pr png 
file into this folder and they 
will then appear in the End-
marks menu within the Pref-
erences dialog. It can be 
nice to use your logo as an 
endmark and, if you do this, 
it’s best to use the png file
format. 

The Navigator window can show a pre-
view of the image you mouse over.

You can customize the endmark graphics that 
appear at the bottom of the panels.
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DAY 2

HOMEWORK:
IMPORT YOUR PHOTO ARCHIVES
CREATE A FILENAME TEMPLATE

CREATE A CUSTOM IDENTITY PLATE
FIX OLD FILE AND FOLDER NAMES

CREATE A METADATA TEMPLATE

WEEK 1
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DAY 2

IMPORT YOUR PHOTO ARCHIVES

WEEK 1

1. Click the Import button in the lower left of the Library module
2. On the left side of the screen, point Lightroom to the base folder

that contains all your photographs. The photos might be located
in subfolders, which is fine. You just need to indicate the top-most
folder that those subfolders reside in, and then choose “Include
Subfolders” from the Select Source pop-up menu above.

3. At the top of the import window, choose Add so that Lightroom
does not move any of your images.

4. On the right side of the import dialog box, set the Build Previews
pop-up menu to Embedded & Sidecar so that it can import your
images relatively quickly.

5. Click the Import button in the lower right and then let Lightroom
run as long as is needed, which will often be overnight to get all
your photographs to show up in the program. Once it is done im-
porting, you should be able to find your images by navigating the
Folders section on the left side of the Library module.

The first step to fully adopting Lightroom 
is to import all the photos you’ve shot over 
the years. Here are some suggestions for 
how best to import your photo archives:

IMPORTING IMAGES & CUSTOMIZING LIGHTROOM  |  33



DAY 2

CREATE A FILENAME TEMPLATE

WEEK 1

1. Click the Import button at the bottom left of the Library module.
2. Set the top, center area to Copy and then turn on the Rename Files

checkbox on the right side of the screen, under the File Renaming
heading.

3. From the Template pop-up menu choose Edit to create a new tem-
plate

4. Create your own formula for renaming images. I personally use the
following setup: Date (YYYY)_Date (MM)_Shoot Name_Sequence
#(00001).

5. Once you have the file renaming formula established, choose Save
Current Settings as New Preset from the Preset pop-up menu at the
top of Filename Template Editor window and give it a name.

When you import new images (instead of your 
already shot archives), you’ll most likely want to 
use the Copy setting at the top of the Import di-
alog box and then have Lightroom rename your 
images at they same time they are imported. To 
make this easy, you should create a file naming 
template. To accomplish this, do the following:
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DAY 2

CREATE A CUSTOM IDENTITY PLATE

WEEK 1

Choose Identity Plate Setup from the Lightroom 
menu (Mac), or Edit menu (PC) and customize 
your identity plate. Create a text-based identity 
plate with your company name so that it appears 
in the upper left of the Lightroom interface. Also, 
customize the style of the modules that appear 
in the upper right of the Lightroom interface so 
that it matches the style of your company name. 
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DAY 2

FIX OLD FILE AND FOLDER NAMES

WEEK 1

As an optional bonus project, consider going 
through your archive of images and renaming 
any files that have generic names like the ones 
that were assigned by your camera. You can ac-
complish this by selecting a series of images and 
choosing Library>Rename Photos and then us-
ing the renaming template your created in the 
“Create Filename Template” section above. 
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DAY 2

CREATE A METADATA TEMPLATE

WEEK 1

Choose Metadata>Edit Metadata Presets and at mini-
mum enter information in the IPTC Copyright area so that 
all your images will be marked as copyrighted. Once you 
are done, choose Save Current Settings as New Preset 
from the Preset pop-up menu at the top of the window 
and assign your preset a name. The next time you import 
images into Lightroom, choose the name of the preset 
from the Metadata pop-up menu on the right side of the 
Import window. If you’d like to apply the same settings 
to images you’ve already imported, then select the imag-
es and choose the preset you recently created from the 
Preset pop-up menu in the Metadata section on the right 
side of the Library module. 
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LIGHTROOM CATALOGS & FILE MANAGEMENT
File management might not sound like the most exciting topic in 
the world, but it’s extremely important nonetheless. Having an or-
ganized system for catalogs and file management will make your 
life so much easier and your workfl w much more efficient

Lightroom Catalogs
So what is a Lightroom Catalog? When you import your images, 
Lightroom makes a record for each one of those images, and the 
Catalog is like the database that holds all of those records. Each 
record contains certain information about the fil , including the lo-
cation on your hard drive, much of the image’s metadata (camera 
settings, develop settings, etc.) as well as a thumbnail preview of 
the image. This thumbnail preview is extra handy because it allows 
you to view the image in Lightroom even when the hard drive con-
taining the image is not connected to your computer. 

Note that in order to display an image properly, Lightroom depends 
on the file name and the location within the image’s record. If you 
change one of those things  (as in move an image file or change 
its name) and you don’t change them from within Lightroom, then 
Lightroom will not be able to find the file on your hard drive and 
display it properly in the interface. For that reason, you should only 
move the image or change its name from within Lightroom. 

A visual example of what an image record contains within the Lightroom Catalog. 
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As we mentioned above, an image’s record within the Lightroom 
Catalog also contains the develop settings, or the changes that you 
made to the image within Lightroom. It’s important to remember 
that, when you adjust an image in Lightroom, you are not making 
any changes to the image file itself. Instead, you are creating a set 
of instructions for how Lightroom should properly display the im-
age and this set of instructions is contained in that image’s record 
within the Catalog. If you want a version of the image where those 
adjustments are permanent or “baked in,” you will have to export 
the image. When you export the image, you will get a copy of it 
with the changes you incorporated, while the original image still 
remains untouched on your hard drive. 

Browser (Bridge) vs. Catalog (Lightroom)  When it comes to man-
aging your images, there are two types of programs that you can 
work with: a browser and a catalog. Adobe Bridge is a browser 
program and Adobe Lightroom is a cataloging program. With both 
types of programs, it can be initially slow to see a folder full of im-
ages. With Bridge, it quickly forgets which folders you’ve viewed 
in the past so if you go back to revisit that folder later, Bridge will 
act as if it’s never seen it before and it will again take some time 
to display the image previews on screen. Lightroom is different. 
Because Lightroom is a cataloging program, it stores previews of 
all imported images and can always display them quickly (after the 
initial import). Searching within Bridge is also very different than 
searching in Lightroom. In Bridge, if you run a search on a large 
number of images, it’s going to take a really long time and the hard 
drive containing the images must be attached to your comput-
er. With Lightroom, searching is instantaneous and the hard drive 
containing the images does not have to be connected. 

Because Bridge is a file browser, it needs the hard drive contain-
ing the images to be connected in order for it to be at all useful. 
It’s looking at the images and working with them directly from the 
hard drive. Because Lightroom is a catalog program, it records im-
age previews and file data on the initial import, so it does not re-
quire the hard drive containing the images to be attached in order 
to display them, export or use some organizational tools. 
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Because Lightroom stores records, previews, etc. of your images, it 
takes up more space on your hard drive than Bridge. The more files
you store in the Lightroom catalog, the more space it will take up. 

Personally, I use Bridge for non-photo files (Illustrator files, PDFs, 
etc.) and photos that I will only need temporarily. I use Lightroom 
for all of my regular photography that I want to keep long-term 
records of.

Where is the Catalog? The Lightroom Catalog is an actual file that 
is stored on your computer. Here is how to locate that fil . In Light-
room, go to the Lightroom menu (Edit Menu on Windows) and 
choose Catalog Settings. A dialog box will appear and as long as 
the “General” tab is selected, the top line will tell you the location 
of the Catalog on your hard drive. On the right side is a button that 
says “Show.” Clicking that will take you directly to the file on your 
hard drive. It’s important to know where your catalog file is because 
it’s a file that you’re go-
ing to want to back up. 
The Lightroom catalog 
is actually made up of 
two or three files. The 
catalog itself (the one 
ending in .lrcat)  is the 
file that stores the loca-
tions of all the pictures, 
metadata, and all the 
adjustments that have 
been made to the image 
in the adjustment mod-
ule. It generally takes 
up about 17.5 kb per im-
age. The Previews file
is the one that allows 
you to view your imag-
es even when the hard 
drive containing them 

Locate your catalog file y going to the Catalog 
Settings dialog and clicking the Show button.

When viewing the catalog file on the ha d drive, 
you can see that it’s made up of two or three files
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is not connected to your computer. Each image preview takes up 
about 3% of the space of the original image fil . The Smart Pre-
views file allows you to adjust some of your images when the hard 
drive containing them is not connected. If you’ve never used Smart 
Previews, then you won’t have this fil . Because Smart Previews 
can get quite large, we don’t create them for every single image in 
the catalog. We only create them for the images we know that we’ll 
need to work with and adjust when the hard drive is not connect-
ed. In order for the catalog files to work properly, they must all have 
the same name (not including the file extension). If you change the 
name of one catalog fil , you must change the name of all three in 
order for Lightroom to use them. You must also do this while Light-
room is not running.

One or many Catalogs? As a photographer, you will have to decide 
whether you should have one Catalog that stores all of your im-
ages or several Catalogs with your images divided between them. 
This decision will depend on how you work and how you think. 

The problem with a Lightroom Catalog is that only one person can 
be accessing it at a time. If you’re an individual and you don’t work 
with other photographers, you can easily get away with one cata-
log. However, if you work with multiple photographers and photo 
editors, it might be more convenient to work with multiple cata-
logs. Let’s look at a few scenarios. You may fall into one of these 
categories, or you may be a hybrid of two or three of them. 

PERSONAL SHOOTER

• One person shooting

• One person adjusting

• One person managing everything

=  One Catalog to keep it simple!
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MULTIPLE SHOOTERS, SINGLE ADJUSTER

• Many people shooting

• One person adjusting

• One person managing everything

=  One Catalog to keep it simple!

COMPLEX BUSINESS

• Multiple people shooting

• Multiple people adjusting

• Managed on a project basis

=  One Catalog per Project, Client or Shoot

Preference for multi-catalog workfl ws  If you choose to use more 
than one Lightroom catalog, there are two areas in Lightroom that 
you should know about. The fir t is within the Lightroom Prefer-
ences dialog. If you click on the General tab, you will find a Default 
Catalog setting. This is where you specify which catalog Lightroom 
should open, by default, when you launch the program. You can 
also specify that it open the most recently-used catalog or that 
Lightroom ask you which catalog to open upon launching the pro-
gram. If you hold down the Option key (Alt on Win) while launch-
ing Lightroom, it will also ask you which catalog it should open.

In the General tab of the Preferences dialog, you can specify which catalog should 
be the default catalog when launching Lightroom.
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Catalog backups The Lightroom catalog file contains all of the ad-
justments you’ve made to your images and therefore it’s a good 
idea to back it up. You can tell Lightroom how often to back up the 
catalog by going to the Lightroom menu and choosing Catalog Set-
tings. Within the Catalog Settings dialog, make sure the General tab 
is active and you’ll find a Backup menu at the bottom of the dialog. 
Here, you can specify how often the catalog should be backed up. 
When exiting Lightroom, you’ll also get a dialog box that will ask 
you if you’d like to back up your catalog and how often should it be 
backed up. There is an important setting here, and that’s the back-
up location. Click the 
Choose button to 
specify where the 
backup should be 
saved. It’s important to 
choose a location that 
is on a separate hard 
drive from your main 
catalog fil . This way, 
if something happens 
to your main catalog 
drive, the backup file
will still be safe. When 
Lightroom creates a 
backup fil , it will au-
tomatically be com-
pressed so that it takes 
up less space on your 
hard drive. The name 
of the backup will be 
rather generic text, 
so it’s a good idea to 
rename it so that you 
know what it is.

You can tell Lightroom how often to back up the cata-
log by going to the Catalog Settings dialog and using 
the Backup menu. 

When closing Lightroom, this dialog will appear, ask-
ing you how often you’d like to back up the catalog.
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If something happens to your main catalog file and you need to 
resort to your backup, you’ll fir t need to double-click on the file to 
expand it. Then, you can drag that backup file into the location of 
the original [corrupt] catalog and tell it to replace the old one. 

If you have your catalog set to back up frequently, you’ll eventually 
get quite the collection of Lightroom backups. To keep these from 
taking up too much hard drive space, you may want to start delet-
ing the old backups and just keeping the more recent ones. 

FOLDERS IN LIGHTROOM  
The folders that contain your images can 
be seen on the left side of Lightroom’s Li-
brary module. You will see the names of the 
hard drive[s] that contain your photos as 
well as all of the individual folders and sub-
folders. To the left of the hard drive names, 
there will be a little “light” that indicates 
whether the drive is currently connected. 
If the light it green, it means that the drive 
is connected to your machine. If the light 
it gray, it means that the drive is not con-
nected and you can’t do things that would 
require access to the original files such as 
move them, rename them, export them or 
print them. If you don’t have Smart Pre-
views created, you can not adjust the images when the hard drive 
is not connected. If you did build Smart Previews, you can adjust 
the images even when the drive containing them is disconnected.

If you change the name of a hard drive, Lightroom will not know 
how to access the drive because it’s looking at it purely based on 
file name. This means that the little light to the left of the hard drive 
name will turn from green to gray, letting you know that the drive 
is inaccessible. To fix this, right-click on the name of one of the 
folders within the hard drive and choose Show Parent Folder from 

The folder structure can be 
viewed on the left side of 
Lightroom’s Library module. 
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the menu that pops up. Continue doing this until you move high 
enough in your folder hierarchy that you get to the main hard drive. 
Right-click on the name of the hard drive, choose Show Missing 
Folder from the menu that appears and then point it to the new-
ly-named hard drive. 

Working with folders and file  To move files between folders, se-
lect the images you want to move and drag them into the folder 
you want to place them in. If you want to copy an image to the new 
location, hold down the Option Key (Alt on Win) while dragging 
the photo to the different folder. 

You can create subfolders within 
Lightroom by right-clicking on the 
folder and choosing “Create Fold-
er Inside” from the pop-up menu. A 
box will appear where you can give 
the subfolder a name and specify 
whether you would like to “Include 
selected photos” in the new folder. 
(If you want an empty folder, leave that check box turned off.) 

You can click on a folder to expand it and reveal all of subfolders 
contained within it. Hold down the Option key (Alt on Win) while 
clicking on the triangle to the left of the folder name and all of the 
subfolders will become expanded as well. Also, when you click to 
view a base folder, you can specify whether you would like to see 
all of the images just in that exact folder or whether you want to 
look at all of the images in the subfolders as well. If you want to 
view all of the images in the subfolders too, go to the Library menu 
and choose “Show Photos in Subfolders.” This setting also affects 
the numbers shown to the right of each folder. 

If you ever create an empty 
subfolder, then the name of 
the folder will be gray, indi-
cating that there is nothing 
inside that folder. 

To create a subfolder, right-click on 
the folder name and choose “Create 
Folder Inside.”

A white triangle 
to the left of 
a folder name 
indicates that 
there are sub-
folders inside. 
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A Gray triangle to the left of the folder icon indicates that there are 
no subfolders within it. A white triangle indicates that the folder 
has subfolders and you can click that arrow to expand it and see all 
of the subfolders. 

Lightroom does not automatically show you the path on your hard 
drive that it would use to get to a particular folder. If you need to 
see this path, right-click on the folder and choose Show Parent 
Folder from the menu that pops up. This will show you the folder 
that contains the selected folder. Note that you can also choose to 
Hide Parent Folder by right-clicking and using this same menu.

Note that there is no option for deleting a folder from within Light-
room. If you really want to delete a folder, you will have to right-
click on it and choose “Show in Finder.” Then you will have to man-
ually delete it using your operating system. 

Moving and Renaming Files To move a folder within Lightroom,  
simply click and drag it to a different folder. You can rename a 
folder by right-clicking on it and choosing “Rename” from the pop-
up menu. It’s important to remember that anything you do to the 
folder list in Lightroom will be reflec ed on your hard drive. It’s 
important that you move images and rename them from within 

Lightroom and not on your hard drive. If you move or 
rename an image on via your computer’s operation 
system, Lightroom will not be aware of the change 
and will not be able to locate the file and display it 
properly. As a result, you’ll see a question mark icon 
next to the folder that Lightroom can no longer place 
(see screen shot at left). 

If you ever get that question mark icon, you can right-click on the 
icon and choose “Find Missing Folder” from the pop-up menu. Then 
you can navigate on your hard drive to where the folder is. 

The question 
mark indicates 
the folder can’t 
be located.
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Renaming images There are a 
couple of ways to rename im-
ages within Lightroom. First, 
you can select an image you 
want to rename and then go 
to the right side of your screen 
(within the Library module) 
and choose the Metadata 
tab. Within this panel, there is 
an option called “File Name” 
and you can click in the text 
field and type the new name. 
If you would like to rename all 
of the images within a folder, 
select all the images (Cmd+A 
on Mac, Ctrl+A on Win) and 
then go back to that  Metada-
ta panel and click on the little 
list icon to the right of the File 
Name field. A dialog box will 
appear and you can specify 
how all of the images should 
be renamed. You can also use 
the available naming presets 
or create your own file-na -
ing preset using some of the 
many options available such 
as Date, Custom Text, Se-
quence #, etc. 

Once you’ve taken the time to create a custom naming convention 
for your images, you can save that formula as a preset by clicking on 
the File Naming Menu and choosing “Save Current Settings as New 
Preset.”

After selecting multiple photos to rename, 
click on the little list icon at the top of the 
Metadata panel to get the File Name Dialog 
Box. From the File Naming Menu, you can 
choose Edit to get the Filename Editor.  
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Developing a Folder System Creating a good system for the way 
you use folders and subfolders will help you stay organized, find im-
ages easily and work more efficiently in Ligh oom. 

Not everyone is going to want or need the same kind of system, but 
I am going to show you the system I have developed for my folders. 
You may want to use the same system or adapt it to your needs. 

For every shoot, I have a 
base folder and a few fold-
ers inside. The only images 
I have on the base level of 
a folder are the ones that 
I’m ready to show the pub-
lic. Within that base fold-
er is a subfolder called “In 
Progress.” This is where I 
drag all of the images I’m 
not done working on yet. If 
I am working on an image in the In Progress folder and I decide that 
it’s not that good, then I will place it in a different folder called “Out-
takes.” (This is also a subfolder within the base level folder for the 
shoot.) If I’m working on an image in the In Progress folder and I feel 
that it’s great and ready to show the public, I will drag it into the base 
level folder. Within that base folder, there is also a subfolder called 
“Support Images.” This is for  files that were used in the creation of 
other files. Examples of this are images that were shot to create a 
panorama or that were shot to create an HDR image. With some 
shoots, I also have a subfolder called Personal Images and that is for 
photos of my wife, friends, etc. These are images that are important 
to me but are not part of my portfolio that I will show the public. 

With a system like this, it’s important to pay attention to the setting 
that allows you to see photos in subfolders when viewing the base 
level folder. (Library > Show Folders in Subfolders) If this setting is 
turned on, you will see all of the subfolder images when you click on 
the base level folder. I keep this setting turned off. 

This is how my image folders are structured. All 
of the images that are ready to show to public 
are kept in the base level folder. 
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These presets are included with purchase of the CreativeLive Lightroom CC Photo Editing Workshop and are not to be shared, 
distributed or sold to anyone who has not purchased the course. 

CUSTOMIZING LIGHTROOM: END MARKS

There are a few different ways in which Lightroom allows us to customize the interface. 
One of them is by displaying End Marks at the bottom of the left and right panels with-
in the different modules. These End Mark images can be used simply for decoration 
or  as a way to add your personal brand or logo to the interface. In the case of this 
workshop, we have provided a set of custom End Marks that have been designed as 
graphical guides to help you become more efficien in Lightroom. In order for them to 
appear in your interface, you will have to install them. 

In Lightroom, go to the menu at the 
top your screen and choose Light-
room > Preferences on the Mac, or Edit 
> Preferences on a PC. Then click on
the Interface Tab where you will fin
an End Marks dropdown menu. From
that menu, choose “Go to Panel End
Marks Folder.” The folder will open on
your hard drive and this is where you
can place any End Marks images that
you would like to have access to with-
in Lightroom. The bonus End Marks
files included with the workshop were
delivered in a zipped format and you
will have to unzip them before moving
them to this folder. You can unzip a fil
simply by double-clicking on it.

Now go back to Lightroom, close the Preferences dialog win-
dow and then re-open it again. (There is no need to re-start 
Lightroom for the new End Marks to appear in the menu.) Now, 
when you click on the End Marks dropdown menu, you will see 
the names of the End Marks you just installed. Simply choose 
one to make it visible. 

You will see the graphic appear at the bottom of the panels on 
the left and right sides of the interface.
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HOMEWORK:
DECIDE HOW MANY CATALOGS YOU NEED

BRAINSTORM FOLDER NAMING CONVENTIONS
CREATE IN-PROGRESS & OUTTAKE SUBFOLDERS

BRAINSTORM EXTRA FOLDER NAMES
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Questions:
• How many drives hold your images?

• How many people shoot for your company?

• How many people need access to the images to adjust them,
organize them, print them?

Considering that a single Lightroom catalog can only be open by one 
person at a time, what is the best solution for your situation? A single 
catalog or one for each project or shoot? If you plan to use multiple 
catalogs, then also consider a consistent naming convention.

Taking the above into consideration, how many catalogs 
do you need?

DECIDE HOW MANY CATALOGS YOU NEED
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The main objective is for every single file to have a unique file name. 
What’s the most important information to track? Job number from your 
accounting system? Shoot Date? Location? Shoot Type (portrait, new 
born, wedding, etc). If multiple people shoot at the same time how 
might you keep track of who shot what? (initials?) Should your file name 
start with the year, client’s last name, subject, shoot type? That will de-
termine the sorting order of your folder list. I personally like to see my 
folders chronically, so I use YEAR_MO Shoot Name XXXXXXX. The _ in 
the date helps to visually separate the year and month. Do you need to 
include the day in your file name? The most important thing is that ev-
ery single file should have a unique name so that when someone refers 
to it via email, there is only one file they can be referring to. 

Brainstorm file name conventions here:

BRAINSTORM FOLDER NAMING CONVENTIONS 
THAT WILL BEST SERVE YOUR NEEDS
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Commit from this day forward to using a standardized system to keep 
track of image processing status. Then slowly work backwards through 
your archives as needed. 

Use smart filtering to determine which files should reside in each folder. 
• Filter for File Type to find TIFF and PSD files that might be finished

layered Photoshop files. (Screen shot 1)
• Filter for File type of Raw and Develop Preset of custom to find imag-

es that should most likely reside in your base folder. (Screen shot 2)
• Filter for images that have default Settings to find images that should

most likely reside in your In Progress folder. (Screen shot 3)
• Filter for four or five star images to find images that might belong on

the base-level folder, which is where I keep my finished and ready to
show the public images. (Screen shot 4)

CREATE IN-PROGRESS AND OUTTAKES SUBFOLDERS 
FOR YOUR LAST FEW SHOOTS

1 2

3 4
To filter for  both four and five star ratings, click 
on four stars and set the little rating symbol to 
equal-to-or-greater-than

UNDERSTANDING CATALOGS & FILE MANAGEMENT  |  54



DAY 3
WEEK 1

What subject matter do you capture that is unrelated to the rest of 
the images you might capture in a shooting session? For instance, I 
commonly capture skies, textures and graphics that I use for random 
purposes that have nothing to do with the main subject matter I was 
shooting. What do you capture that is similar and needs to be stored 
in a separate subfolder (alphabet letters?). By storing these types of 
images in a consistently named subfolder, you will be able to utilize 
Smart Collections to automatically gather the images even through the 
originals are spread amongst dozens of folders.

• Skies
• Textures
• Backgrounds

Once you have established a consistent
folder naming system, type up the names
and save the result as a JPEG file (screen
shot from a word processor is fine) and
then load that file as an End Mark in Light-
room. To learn how to install the file as
a Lightroom End Mark, refer to the End
Marks guide that came with this Light-
room Classic Workshop.
The End Marks guide looks like this.

BRAINSTORM EXTRA FOLDER NAMES

• Video
• Personal Images
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BASIC ADJUSTMENTS IN LIGHTROOM: TONE
Now that we’ve talked a bit about organizing, it’s time to move on 
to the fun part: adjusting images! All of the image adjustments are 
made in Lightroom’s Develop module. Once in the Develop module, 
you will see a series of panels on the right hand side of the interface. 
These are the adjustment panels, which we will use to enhance, cor-
rect and optimize our photos. 

In this section of the course, 
we’re going to focus on the Ba-
sic panel, which is located at 
the top of the adjustment pan-
els and contains all of the es-
sential sliders for adjusting your 
images. Let’s look at what each 
of those sliders does. 

Exposure: This slider adjusts 
the lightness of your image as a 
whole. If the entire image is too 
bright or too dark, this is the 
slider that you will turn to fir t. 

Highlights: The Highlights refer 
to the bright areas of your im-
age, and that is what this slider 
will focus on. When you move 
the slider to the right, it will 
only brighten the bright areas 
of your image. When you drag 
it to the left, it will only darken 
the bright areas of the image. 

Shadows: The Shadows slider will isolate the dark areas of your 
image. When you move the slider, only those dark areas will be af-
fected. Dragging the slider to the right will lighten the dark areas 
and dragging it to the left will make the dark areas darker. 

Lightroom’s Basic panel

TRANSFORMING RAW EXPOSURES INTO POLISHED IMAGES  |  57



Copyright 2018 by Ben Willmore. All Rights Reserved

LIGHTROOM CLASSIC: THE COMPLETE GUIDE
TRANSFORMING RAW EXPOSURES INTO POLISHED IMAGES

Whites & Blacks: The Whites and Blacks sliders work with the 
brightest and darkest parts of your images. If you increase the 
Whites, it will make more and more of your picture solid white. If 
you move it the opposite direction, it will take the brightest parts of 
your picture and make them not so bright. If you move the Blacks 
slider to the left, it will make more and more of your picture solid 
black. If you move it to the right, it will lighten things up, starting 
with the darkest part of your picture. The Whites and Blacks sliders 
affect more tones in your picture than the Highlights and Shadows 
slider. I use these when I want to affect a larger brightness range 
than the Highlights and Shadows sliders will allow. I tend to use the 
Whites and Blacks sliders as finishing techniques, meaning I usually 
turn to them after I’ve made all of my other adjustments.

Contrast: The Contrast slider controls the difference between bright 
stuff and dark areas. If you increase contrast, it will make the bright 
areas brighter and dark areas darker. If you lower contrast, it will 
make the bright and dark areas more similar to each other (with 
the brights getting darker and darks getting brighter). When you 
increase Contrast, you’re doing basically the same thing as drag-
ging both the Highlights slider up and the Shadows slider down.

Clarity: This slider will do something similar to what contrast does, 
but it will mainly focus on the areas with detail in your image. It will 
exaggerate those details by increasing the contrast of the fine edg-
es between things. You have to be careful with this slider, because 
using too high of a settings can create a glowing effect on objects 
that contrast greatly with their surroundings. When increased an 
appropriate amount, the Clarity slider can make the fine details in 
an image pop. When decreased an appropriate amount, the Clarity 
slider can create a softening effect on skin. 

Dehaze: When the Dehaze slider is moved to the right, it will dark-
en the dark areas of the image, but once the area gets close to 
black, it will start to hold off on the darkening effect and move on 
to an area thats not so dark, creating a darkening effect without 
pushing the area to black, and so on. This is useful when you have 
a foggy or hazy picture and you want to add contrast.
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THE ADJUSTMENT PROCESS
When working on my images, I generally try to tackle the biggest 
problem fir t. Then I will re-evaluate the image and work on the next 
biggest problem. I will continue this process until I run out of prob-
lems, patience, time or budget. 

We’re going to work on an example image to demonstrate my pro-
cess. In this image, the fir t thing I notice is that the image is too dark 
as a whole. To improve this, I will move the Exposure slider to the 
right until I think the overall brightness looks ok. 

Left: The original, untouched image. Right: The fir t thing we did to this image was 
move the Exposure slider to the right, increasing the overall brightness. 
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After adjusting the overall brightness, I notice that the dark areas are 
still too dark. This is when I’ll turn to the Shadows slider, dragging 
the slider to the right in order to lighten up the darkest areas of the 
picture.

Next, I can tell that the adjustments resulted in the statue in the 
background and the sky becoming too bright so I’ll use the High-
lights slider, dragging it to the left to tone down those bright areas. 

At this point, I’ll start working on the overall contrast of the image.  
I need to decide whether I need a greater or lesser difference be-
tween the brightest and darkest parts of the image. In this case, I 
think I actually need a lesser difference, so I will move the Contrast 
slider to the left slightly. 

Left: The Shadows slider is moved to the right, brightening up the dark areas. 
Right: The bright areas were too bright, so the Highlights slider was moved down.
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Now I think that the image looks a little dull overall and that the 
detail needs to pop out more. The Clarity slider is what will fix this, 
so I’ll drag it to the right until the details of the image start to look 
better.

Before & After View If you ever want to see a before & after view, hit 
the backslash key ( \ ). This will give you a before view, as indicated 
by the word “before” that will appear at the bottom of the interface. 
Hit the backslash key again to return to your “after” view.

Resetting sliders If you would like to reset all of the sliders in a group-
ing, double-click on the name of the grouping above the sliders. For 
example, double-clicking on the word Tone above the sliders in the 
Basic panel will reset all of the toning sliders beneath it. Double-click 
on the name of a slider to reset just that slider. 

Left: The Contrast slider is moved to the left. Right: The Clarity slider is moved to 
the right, making the details pop a little more.  
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Be careful with dark images Whenever you have a dark image, or 
areas of an image that are very dark, and you use the adjustment 
sliders to lighten up those dark areas, you run the risk of introduc-
ing noise into your picture. Noise is that grainy, sandy artifact and is 
usually not a good thing. 

Blacks & Whites as Finishing Techniques When I think I’m done with 
an image, I take one last look at the Blacks and Whites sliders. I’ll 
use the Blacks slider to make sure I have at least a small portion 
of the picture as solid black. When 
an image doesn’t contain any black, 
it can tend to look dull. (There are, 
of course, exceptions where you 
wouldn’t want a black point.)

It can be difficul to really tell if you 
have solid black in your image, so 
there’s a trick. Hold down the Op-
tion key (Alt on Win) while drag-
ging the Blacks slider and you will 
get a view of your image that only 
shows what areas are solid black. 
The same technique can be used 
with the Whites slider. Holding the 
Option key (Alt on Win) while drag-
ging the Whites slider will give you 
a view of your image that shows 
what areas are solid white. 

Auto Settings This is a feature that 
I don’t use very often, but it can 
sometimes be helpful and interest-
ing to try. At the top of the Basic 
Panel (but beneath the Temp and 
Tint sliders) there is a Setting called  
Auto. If you click that button, it’s 
going to adjust multiple sliders in an 
attempt to fix the image. I find that 

We’re holding the Option key while 
dragging the Blacks slider in order 
to get this view that shows what 
areas are solid black. 

The Auto setting will try to intelli-
gently move all of the toning sliders 
automatically.
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this is most useful when you have an overly dull image because it will 
attempt to bring in a black point and a white point. 

While the Auto button will adjust multiple sliders in an attempt to fix
the image, there is a trick for applying the Auto setting to just one 
slider. Hold down the Shift Key and either double click on the slider 
or the name of the slider and it will apply Auto settings to only that 
one slider. It can be useful to do this with the Blacks slider whenever 
you think you’re done editing a picture, because if the darkest part 
of the picture isn’t solid black it can tend to look dull. When you use 
the Auto feature on the Blacks slider, it will ensure that the image 
has a black point and this can help to prevent your image from look-
ing dull. 

How to get more out of the shadows Often times, I will have dragged 
the Shadows slider all the way to the right but I will STILL want those 
shadows to be brighter. There’s a trick for achieving this. Once the 
Shadows slider is maxed out, I will then go to the Exposure slider 
and drag it up until the shadows are as bright as I want them to be. 
The problem with this is that it also brightens the light areas and I 
didn’t want those areas to change. To compensate for this, I will use 
the Highlights slider, dragging it down enough to revert the bright 
areas back to how I want them to be. 

In this image, we lightened up the shadows with a combination of the Exposure and 
Shadows sliders. We then needed to lower the Highlights slider to compensate for 
the increase in exposure in the light areas. 
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More on Dehaze The Dehaze slider will focus on the darkest areas of 
the image, pushing them close to black. Once those areas become 
black, it will stop darkening them and move on to the next darkest 
tones, pushing them to black, and so on. After using the Dehaze 
slider, you’ll have to be careful in adjusting the colors in your image, 
as the Dehaze feature tends to exaggerate any color casts that may 
exist. It’s also a good idea to fine-tune the dark areas using the Shad-
ows slider after working with Dehaze. 

Before and after views, using the Dehaze slider. 
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BASIC ADJUSTMENTS IN LIGHTROOM: COLOR
When it comes to color, there are two different things we can do. 
We can control how colorful an image is and we can control how 
much of a particular color is in an image. We’ll use the Temp and 
Tint sliders to color-correct and control white balance. We’ll use 
the Vibrance and Saturation sliders to determine how colorful the 
image is. 

Temp & Tint The Temperature and Tint sliders collectively control 
the white balance. We use these adjustments to color-correct and 
control how much of a color is in the image.  

With these sliders, it’s important to 
understand that every color has an 
opposite. The opposite of blue is 
yellow and the opposite of green is 
magenta. You can see this reflec -
ed in the gradients on the sliders.  
If there is too much of a particu-
lar color in the image, you would 
move that slider away from the 
overabundant color until the color 
cast seems to disappear. For ex-
ample, if the image has a blue cast to it, you would move the Temp 
slider to the right, away from the blues and toward the yellows.

Sometimes it’s hard to determine where to best place the Temp and 
Tint sliders for optimal white balance. In these cases, we have two 
other ways of figuring that out. Both of these methods will end up 
moving the Temp and Tint sliders to their appropriate positions. 

First, there is a little dropdown menu above 
the Temp and Tint sliders (to the right of WB:) 
and clicking it will give you options to com-
pensate for known light sources such as Day-
light, Shade, Tungsten, etc. This feature works 
well when you know the type of lighting the 
image had. 

The Temp & Tint sliders collectively 
control the white balance of an image.

The White Balance menu
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The White Balance Eyedropper  The 
White Balance Eyedropper is located 
at the top left of the Basic Panel and 
you can use it to hover over your pic-
ture and click on something that should 
contain no color whatsoever. I usually 
look for something that should be a neutral gray. When you click 
on that part of the image, and the area was in fact neutral, then the 
Temp and Tint sliders should automatically be moved to correct 
for the color cast. If that didn’t work, you can always try this over 
and over again, using the eyedropper to sample different areas. If 

the White Balance Eyedropper 
automatically gets deactivat-
ed after you use it to click on 
your image, you can turn off the 
Auto Dismiss check box in the 
lower right corner of the image 
window. This will cause the eye-
dropper to stay active until you 
manually “put it away.” 

When you use the White Bal-
ance Eyedropper to click on an 
area in your image, a zoomed-
up “loupe view” will appear, 
showing you the targeted area 
on a pixel level. If you don’t want 
to see this view, turn off the 
Show Loupe check box in the 
Toolbar below the image. You 
can also control how extreme of 
a zoom view is shown by using 
the Scale slider to the right of 
the Show Loupe check box. 

The White Balance Eyedropper

The White Balance Eyedropper is being 
used to click on a neutral area.

Settings for the White Balance Eyedrop-
per will appear in the Toolbar below the 
image window. 

TRANSFORMING RAW EXPOSURES INTO POLISHED IMAGES  |  66



Copyright 2018 by Ben Willmore. All Rights Reserved

LIGHTROOM CLASSIC: THE COMPLETE GUIDE
TRANSFORMING RAW EXPOSURES INTO POLISHED IMAGES

Tips for Adjusting White Balance When it comes to correcting the 
white balance of an image, I will fir t turn to the White Balance 
Eyedropper and then fine-tune the results using the Temp and Tint 
sliders. Using the Temp slider, I will move it back and forth until I 
see the most separation between colors. If you’re ever having a 
hard time judging whether there is too much blue or yellow in the 
image, here’s a trick. Drag the Saturation slider all the way up. It 
will look pretty bad, but the exaggerated colors will make it easier 
for you to see where there are subtle yellows or blues. Then, after 
you’ve worked with the Temp and Tint sliders, you can set the Sat-
uration slider back to normal. 

You can see a very obvious blue color cast in this image. The Temp slider will be 
used to correct for it. 

Here, the Temp slider was brought to the right, taking away blues and adding yel-
lows, in order to correct the color cast. 
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Correcting White Balance using a gray card 
When shooting in the field, it can be very use-
ful to carry a white balance gray card with 
you. This is a card that is designed to be per-
fectly neutral. Take a picture of it under the 
same lighting conditions you plan to shoot 
under, and you can later use the White Bal-
ance Eyedropper in Lightroom to sample for 
the card, ensuring that your white balance 
will be spot on. 

You can also apply the same white balance settings to all images 
shot under the same lighting conditions. Here’s how to set the white 
balance for all those images at once. First, select all of the images in 
the Library Module. Be sure to include the image that contains the 
gray card and make that image active. Then go to the Develop Mod-
ule and make sure the “Auto Sync” button is turned on at the bottom 
of the adjustment panels on the right side of the interface. Then use 
the White Balance Eyedropper to click on the gray card, correcting 
the image’s color. Because there were several images selected and 
the Auto Sync feature was turned on, the same white balance set-
tings will be applied to all of the selected images. 

This is a WhiBal brand 
gray card attached to  
our camera bag.

Above, multiple images were 
selected in the Library Module, 
with the gray card image active. 
At left, you can see the Auto 
Sync button at the bottom of the 
adjustment panels. 
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Vibrance & Saturation There are two sliders that control how col-
orful an image is: Vibrance and Saturation. Both of them will make 
the image more colorful or less colorful. The difference is that Satu-
ration treats all colors equally. 
The problem with that is that 
some parts of the image may 
already be very colorful, so 
moving the Saturation slider 
to the right might make those 
colors TOO colorful and artifi-
cial-looking.

Vibrance concentrates on the mellow colors and thats where the 
largest change happens. Then it applies the adjustment less and less 
as it gets into the more colorful areas. One of the things to keep in 
mind with Vibrance is that it tends to always make blues more color-
ful (because it thinks you want the skies to pop more), so if you don’t 
want this to happen, be careful with how far you push the Vibrance.

Know that you can often times find a sweet spot or desirable effect 
by moving both the Vibrance and Saturation sliders. Here is how I 
think about color adjustments: I decide that I think should happen 
to the mellow colors and then I’ll use the Vibrance slider to accom-
plish that. Then I use the Saturation slider as an overall color con-
trol. 

Profil  The Profile setting can be found 
at the very top of the Basic panel. (It 
used to be found under the Calibration 
panel.) The profile affects the overall 
color rendering in your image, and also 
the contrast. It’s similar to using differ-
ent types of film on a film cam a.

The Profile menu contains the profiles
that you have chosen as your favorites. 
To access all the profiles, click on the 

The Vibrance and Saturation sliders are near
the bottom of the Basic panel.

The Profile setting can be ound 
at the very top of the Basic 
panel.
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Browse option at the bottom of the menu. Alternatively, you can 
click you on the four squares to the right of the menu as this will 
take you to the  Profile B owser as well.

A categorized list of profiles will appear. 
The Legacy category contains the older 
profiles that used to be standard in Light-
room. The Camera Matching profiles con-
tain the different pictures styles that are 
available when shooting JPEG files with 
your camera. Because it’s camera-based, 
the choices will be different depending 
on what camera you were shooting with. 
The Adobe Raw profiles are choices de-
veloped by Adobe. The profile catego-
ries on the bottom half of the list provide 
more creative uses of the technology. 
These include Artistic profiles, Black and 
White profiles, etc. When using one of 
these profiles, an Amount slider will ap-
pear at the top of the Profile Browser and 
you can use this to control how strongly 
the effect will be applied. 

When you hover your cursor over one 
of the profiles, you will see a preview 
of what the profile will look like on your 
image. You will also see a little star icon 
appear in the upper right corner of the 
thumbnail. Click this star to add the profile to your favorites menu. 

When you’re done in the Profile Browser, click the word Close in 
the upper right corner of the panel. 

If you ever find that you’re having a hard time getting the colors to 
look good in your image, you can always play with different profiles
as a way of shifting the colors in a way that might be desirable for 
you. 

Clicking on the four squares 
to the right of the Profile
menu will cause the Profile
Browser to appear.
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I do not suggest adding these images to your personal catalog (simply 
to avoid clutter). Choose File>Open Catalog and point Lightroom to 
the associated catalog file, then navigate to the images via the Collec-
tions list in the Library Module. Many of the images will already have 
the features incorporated into the image. When that is the case, dou-
ble-click on the heading above each set of sliders to reset all related 
sliders to zero before experimenting with each feature. If you’d like to 
start from scratch, then click the Reset button in the lower right of the 
develop module. 

THIS WEEK’S HOMEWORK INVOLVES A LIGHTROOM 
CATALOG FILE FULL OF EXAMPLE IMAGES. 
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SHARING FINALIZED FILES
When we makes changes to our images in Lightroom, the original  
image files are not being touched or modified. All of the changes are 
recorded in a separate, “sidecar file” that contains a set of instruc-
tions for how Lightroom should display the image. That means that 
when you look at a raw file on your hard drive (not using Lightroom), 
you won’t see the adjusted version that you see in Lightroom. 

If you want to share an image that you adjusted in Lightroom, you 
will have to export it somehow, in a format that reflects all of the 
changes you made. When you export from Lightroom, you will get a 
new image file with all of your changes/adjustments “baked in.” The 
original file will till remain untouched on your hard drive. 

To export a selected image from Lightroom, go to the File Menu and 
choose “Export” or “Export with Preset.” If you choose “Export with 
Preset,” you’ll choose from the list of Export Presets that appears. 
Know that you’ll have to fir t create your custom Export Presets, but 
after you do, it will make the process fast and seamless. 

To quickly export an image from Lightroom, use the File menu, choose Export with 
Preset and then select a preset from the list. 
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Creating Export Presets After you create your own, custom presets, 
they will appear in the “Export with Preset” menu. To create a cus-
tom preset, choose File > Export. The Export Dialog Box will pop up 
and give you lots of settings to work with. 

On the right side, there are several different sections of settings that 
can be collapsed and expanded. On the left is a list of the pre-exist-
ing presets, meaning the ones that come with Lightroom.

Start by exploring the existing presets and choose one that is some-
what close to the preset you’d like to create. That will load in all the 
settings for that preset on the right side of the screen. This will make 
it so that you don’t have to work with all the settings from scratch. 
You will at least have a starting point. 

Lightroom’s Export Dialog Box. This is where you can create custom Export Presets. 
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Now, let’s look at what kinds of settings are available in the Export 
Dialog Box: 

Export Location: When you export an image, this is where it should 
go on your hard drive. You also have the option of creating a sub-
folder to go inside the chosen folder. Within the Export Location 
menu, there is a “Choose folder later” option and this can be useful 
if you will be using the export settings as a preset. When using the 
preset, Lightroom will ask what folder the image should be saved to.

File Naming: If you leave this section alone, it will use the original file
name that was applied. If you turn on the “Rename to” check box, 
you will have the option of giving the image[s] a new name. Here, 
you will also have access to any file name templates you have creat-
ed. I usually keep this setting off because I like using the original file
name. 

Video: This area is just asking whether you want to include any vid-
eo files th t may be in the group of images you’re exporting. 

File Settings: Here is where you choose the format for your export-
ed images. I usually use JPEG for my exported images. If you choose 
JPEG, there will be a Quality slider on the right, and this will af-
fect the file size. This section also contains a color space dropdown 
menu, and your selection here really depends on how you use your 
photos and how you’re going to print them. Note that any images 
that are being used for on-screen viewing should be sRGB. 

Image Sizing:  If you keep this check box turned off, Lightroom will 
export the full size photo. If you turn it on, you will get options for 
image width, height and resolution. If you’re emailing the image or 
posting it online, you will want to create a much smaller version us-
ing these settings. If you plan on printing your images, it’s a good 
idea to use a resolution of 240-360 in order to get the highest qual-
ity print.

Output Sharpening: Lightroom wants to know if it should sharpen 
for print or screen. When you print, things don’t look as sharp as 
they do on screen, so you over-sharpen when you print. There is also 
an “Amount” dropdown menu on the right.
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Metadata: Metadata is information about your picture that isn’t the 
picture itself. This might include camera settings, keywords, capture 
date, etc. Use the Include menu to specify what types of metadata 
you’d like to be included. If you tagged the image with any key-
words, this is where you can specify whether or not the keywords 
be included in the exported fil . If you want to export the keywords, 
you would choose the “all” setting. 

Watermarking: You can apply custom watermarks to your images 
on export, and here is where you would tell Lightroom to do that. 
If you click on the Watermark check box, you can choose between 
your watermark presets.

Post-Processing: This is where you determine what happens after 
you export the image[s]. Usually, this can be kept at “Nothing” but 
there are options here for opening in the Finder or opening in anoth-
er application. 

Once you have gone through all of the above settings, you can save 
them as a new Export Preset. Click the Add button in the bottom 
left corner of the Export Dialog Box in order to save these settings 
as a new preset. You’ll be prompted to give your new preset a name 
and click “Create.” Then, your preset will appear in the “Export with 
Preset” menu in the future. 

Making several presets very quickly  You can create several presets 
that are all similar to each other in that they are based off of another, 
pre-existing preset. To do this, fir t go to the preset list on the left 
side of the Export dialog and click on the preset you want to base 
things on. Then, go to the setting that will vary in the new preset and 
set it how you’d like. In the video example, we made the image size 
vary, so we clicked on the Image Sizing tab and changed the image 
size to 1500 px x 1500px. Then, click the Add button below the pre-
set list and give it a name. It’s a good idea to include the name of the 
preset it’s based on as well as whatever variation it has. For example, 
we used the name “1500 sRGB to Desktop.” Repeat this process, 
creating several variations of the same preset. In our example, we 
created several presets where the only thing that differed was the 
image size.
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CREATE CUSTOM WATERMARKS
There are a few different places within Lightroom where you can 
use and create custom watermarks. The Export Dialog Box is one of 
them. To create a custom watermark, use the watermarking drop-
down menu and choose “Edit Watermarks.”

The Watermark Editor will appear on your screen. In the top right of 
this dialog box, there are two options for “Watermark Style.” If you 
choose a Text watermark, then you simply type in the text that you 
want to appear in the text field below the image window. In the Text 
Options area, you can style the type by changing fonts, colors, etc. 

The Watermark Effects area will allow you to change the opacity 
and specify the size and proportions of the watermark as it sits on 
your image. The Shadow settings will allow you to create a drop 
shadow for your watermark. Turn on the Shadow check box to add 
the drop shadow and then use the sliders to determine how opaque 
the watermark should be, its offset, angl , etc. 

The Anchor setting allows you to determine the position (lower right 
corner, upper left corner, etc.). 

To get the Watermark Editor, choose Edit Watermarks in the Export Dialog Box.
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If you choose to use a graphic instead of text, you will have to click 
the “Choose” button and navigate on your hard drive to a pre-made 
graphic that you created for this purpose. Note that it’s best to use 
the png file ormat for this. You will still have the Watermark Effects 
options available when you use a graphic watermark. 

To save your watermark for future use, click on the dropdown menu 
in the top left and choose “Save Current Settings as New Preset.”

Remove the background on a graphic to use as a watermark  If you 
are going to use a graphic as a watermark, it should have a trans-
parent background. In order to remove the background on a logo or 
graphic, you’ll fir t want to make sure that the graphic is truly black 
and the background is truly white. To do this, open the image in Pho-
toshop, go to the Image menu and choose Adjustments > Levels. 
Drag the white slider to the left to force areas to white and drag the 
black slider to the right to force more areas to black. Here is a trick 
for determining which areas are perfectly white and perfectly black. 
Hold down the Option key (Alt on Win) while dragging these sliders 
and you will get a preview of what is solid white (when you’re drag-

To save a watermark for future use, choose Save Current Settings as New Preset. 
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ging the white slider) and what is solid black (when you’re dragging 
the black slider). Once you have moved the sliders to make the im-
age black and white, click the OK button. 

Now you can remove the white background on the image. Go to the 
Channels panel (It’s usually grouped with the Layers panel), hold 
down the Command key (Ctrl on Win) and click on the top thumb-
nail (the RGB/CMYK composite channel). This will give you a selec-
tion of everything that’s white in your picture. In this case, we want 
the opposite because the black area contains the graphic, so we’ll 
go to the Select menu and choose Inverse. The graphic or logo will 
now be selected and you can go back to the Layers panel. With the 
graphic selected, click on the Adjustment Layer icon at the bottom 
of the Layers panel (it looks like a circle that’s half black, half white) 
and choose “Solid Color” from the menu that appears. The Color 
Picker will appear and you can use it to choose the color of the 
graphic and click OK. This will create a new Solid Color layer and the 
selection will automatically be applied to the layer mask. You can 
now throw away the original layer. Lastly, you can remove any empty 
space from the outer edges of the document by going to the Image 
menu and choosing Trim. To save the graphic, go to the File menu 
and choose Save for Web. In the Save for Web dialog, change the 
top menu to PNG-24 and make sure the Transparency check box is 
turned on.  Click the Save button and you’ll be prompted to name 
the graphic and choose where it should be saved. 

A selection of 
the graphic 
was convert-
ed into a Sol-
id Color layer, 
which will 
be used as a 
watermark.

CREATING FINALIZED FILES & PRINTING  |  80



Copyright 2018 by Ben Willmore. All Rights Reserved

LIGHTROOM CLASSIC: THE COMPLETE GUIDE
CREATING FINALIZED FILES & PRINTING

Sharing export presets between computers After you’ve taken 
the time to create export presets on one computer, know that you 
can copy them to any other computers you also run Lightroom on. 
You’ll need to find the file that stores all of the presets and you can 
do that by going to the Export dialog (File > Export), expanding 
the Post-Processing section and using the “After Export” menu to 
choose “Go to Export Actions Folder Now.”  This will take you to the 
location where you will find the Export Presets fil , which you can 
copy and use on another machine.

PRINTING
Lightroom has an entire module just for printing, and you can either 
click on the word “Print” in the upper right corner of the interface 
or you can use the keyboard shortcut Command+P (Ctrl+P on Win) 
to take you there.

The Print module is similar to the Export Dialog Box in that there are 
loads of settings on the right and a series of presets on the left. The 
presets are actually print templates and if you hover your mouse 
over them, you will see previews in the Preview window above the 
template list. Because there are so many settings available, I rec-
ommend finding a print template that is closest to what would suit 
your needs and then use that as a starting point. 

Left: To locate the file ontaining Lightroom’s presets, go to the Export dialog, 
expand the Post-Processing tab and choose “Go to Export Actions Folder Now” 
option from the After Export menu. Right: Lightroom’s Export Presets are stored 
along with all the other preset files on the ha d drive. 
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Page Setup & Print Settings In the lower left, you’ll find the Page 
Setup and Print Setting buttons.  If you click on Page Setup, you 
will get a dialog box where you can specify the printer you want 
to use, paper size, orientation, etc. If you click the Print Settings 
button, you will get your standard Print dialog box where you can 
specify settings like paper type and how it’s loaded, the ink type, 
resolution, etc. 

On the right side of the interface, you will find all of the Print mod-
ule settings, broken up into tabs for Layout, Style, Identity Plate, 
etc. We’ll look at them individually: 

LAYOUT STYLE

When creating a print layout, you 
can choose between a single im-
age, a Picture Package or a Cus-
tom Package. A Picture Package 
will put multiple images on one 
page in varying sizes. The number 
and sizes of the pictures will be 
determined under the “Cells” tab. 

Lightroom’s Print module. The Print Templates (presets) are located on the left and 
the print settings are located on the right.

The Layout Style section is where you 
can tell Lightroom if you’re printing a 
single image or a package of images. 
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CELLS

The Cells section will only be available when the Picture Package 
option is chosen within the Layout Style tab. It provides several 
options for image sizes that can go in your picture package. If you 
don’t see the size you want as one of the options, click on little 
triangle to the right of one of the sizes. That will give you a menu 
where you can choose a different size. As you add more cells to the 
package, Lightroom will create additional pages as needed. 

LAYOUT 

The sliders in this tab are useful when you 
have Single Image/Contact Sheet selected 
in the Layout Style settings. The Rows and 
Columns sliders will create a grid of imag-
es on your page. (as opposed to displaying 
just one) The Margins sliders will let you de-
termine how much space appears on the 
outer edges of the page and the Cell Spac-
ing sliders will determine how much space 
is between each image cell on the page. 

At left is an example of a picture package. At right is the Cells section, where you 
can specify what image sizes should go in the package. 

The Layout settings will 
be accessible when you 
choose a Single Image/
Contact Sheet style. 
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IMAGE SETTINGS

The settings in this area will specify 
how you want the individual images 
in your Layout to be displayed. 

Zoom to Fill: Will cause each image 
to be cropped in order to fit the cell 
shape and size.

Rotate to Fit: Will rotate each im-
age within the cell frame in order to 
best fit the pho o.

Repeat One Photo per Page: Turning this setting on will repeat the 
same photograph in every cell on the page, as opposed to having 
a different image in each cell. 

Stroke Border: If you turn this check box on, each image cell will 
be given a stroke, or outline. The slider will control how thick that 
stroke is and there is a color picker on the right so you can deter-
mine the color of the stroke.

GUIDES

If you turn on the guides, you will be given a better sense for how 
things are set up because you can actually see the margins and 
lines that divide up the cells.

PAGE

Page Background Color Turning on this checkbox will allow you 
to insert a background color on your 
print page.

Identity Plate If you created a custom 
Identity Plate (or more than one of them), you will have the option 
of overlaying those on your print sheet. Click on the little arrow 
in the bottom right of the preview window and you will get a list 

The Image Settings in the Print 
module
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of all your pre-made identity plates. 
Once it’s on your print sheet, you can 
use your mouse to reposition it on the 
page. As a reminder, the Identity Plate 
is the text or image that appears in the 
upper left corner of Lightroom’s inter-
face. If you right click on it, a menu 
will pop up and you can choose “Edit 
Identity Plate” to change the current 
one or create a new one. 

The Override Color check box will 
only be accessible if you are using a 
text Identity Plate. You can turn on the 
“Render on every Image” check box if 
you would like the Identity Plate to be 
overlaid on every photo. 

Watermarking Turn this check box on if you would like one of your 
watermarks to be set over your images. The dropdown menu will 
give you a list of all the watermarks you have previously created. 

Page Options Turn on the Page Options check box to enable set-
tings that allow you to add page numbers, page info (the print set-
tings that were used) and crop marks (guides on the edges of the 
page to help you cut out the images). 

Photo Info Turn on the Photo Info check box to enable a menu that 
allows you to specify what types of file info should appear beneath 
each printed image.

Click on the arrow in the bottom 
right corner of the Identity Plate 
preview window to get a list of all 
your pre-made Identity Plates. 
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PRINT JOB

If you chose a print template preset that works really well for you, 
then this may be the only section you need to focus on. Here are 
the settings within this tab:

Print To: This setting basically 
gives you the choice between 
printing to your printer or print-
ing to a JPEG file for another 
person (or lab) to print for you. 

Draft Mode Printing: Turning 
this setting on will speed up the 
printing process but the quality 
will be lower. I usually keep this 
off

Print Resolution: Here, you can 
force it to use a particular reso-
lution. If you leave this off, then 
Lightroom will determine the 
resolution.

Print Sharpening: Whenever you print an image, it looks softer 
than it did on screen. These settings will allow you to choose the 
amount of sharpening and the kind of paper you’re printing on.

16 Bit Output: This checkbox will send extra data to your printer 
in order to keep smooth transitions smooth. This is more useful in 
images like merged panoramas. 

Color Management This is where Lightroom learns how to shift 
the colors in the picture to make them look right on your particular 
printer. Use the dropdown menu to tell Lightroom what kind of pa-
per and printer you’re using. If you don’t see the profile you need, 
you’ll have to click “Other” and turn on the check box (from the 
long list that appears) for the paper you want. 

The Print Job settings in the Print module
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Print Adjustment: If you set up your profiles correctly, you won’t 
likely have to use this, but these sliders will let you tweak the bright-
ness and contrast of your print. They won’t affect the image you 
see on screen. They’ll just affect the print. 

Print Layout Tips

After you’ve added image cells to your print sheet, there are a few 
tips for customizing them. 

• Reposition the images on the page by clicking and dragging
them to a new location.

• If your images are set to “Zoom to Fill,” you can reposition an
image within its cell by holding down the Command Key while
dragging the images.

• The Custom Package selection in the Layout Style section will
allow you to have multiple images in different sizes and shapes
on one layout.

• To save a template that you customized, click the little plus (+)
icon to the right of the Template Browser heading. You’ll be
prompted to give your new template preset a name.

CREATE SAVED PRINT
This is a great setting for saving prints you love so you can use 
them again later. After you finished setting up your print, click on 
the “Create Saved Print” button in the top right of the image win-
dow. A dialog box will appear where you can give the Print a name 
and choose where you would like it to be located. Then click Create.

The next time you go to the Library module, you will see a collec-
tion with the name of the print you just saved. There will be a little 
printer icon next to the name. 
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Then you can drag other im-
ages into the Collection with 
that name. When you open 
that collection and hit Com-
mand+P (Ctrl+P on Win), the 
images will be brought to the 
Print module with all of the 
same settings. Then you can 
just hit the Print button. 

The Create Print feature will let you save a print that you really love. 

After you used the Create Print feature, the 
print name will then be found as a Collection 
within the Library Module. 
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HOMEWORK:
BRAINSTORM COMMON DELIVERY NEEDS

CREATE EXPORT PRESETS
CREATE PRINT TEMPLATES

CREATE WATERMARKS
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• Size (for email, print, online?)

• File Format (JPEG, TIFF, etc.)

• Is there anything special about how those files should be named?

• Are there any consistent locations you need files to be saved to?
(Portfolio folder, folders that are automatically synced to ipad, etc?)

• Should these files include all the keywords you’ve tagged onto an
image (search terms you’ve added to the images such as who ap-
pears in the image or where the photo was taken)?

When you deliver files to other people (friends, 
clients, family, etc.), what are the most common 
requirements for those files?

BRAINSTORM COMMON DELIVERY NEEDS
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Choose File>Export, click on the preset on the 
left side that is closest to what you desire and 
then modify the settings on the right before  
clicking the Add button in the lower left to  
save a new preset. Repeat this process until 
you’ve created presets for all the various uses 
you can think of for your images.

CREATE EXPORT PRESETS

The Export dialog box in Lightroom
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Brainstorm about your printing needs. 
CREATE PRINT TEMPLATES

• What are the standard paper sizes that you print to
most commonly?

• How many images should appear on each page?

• When a single image appears, should there be any other
information presented (your signature, name, web site, etc.)?

• Do your clients ask for specific sizes for images on a regular
basis, if so what sizes to they most request?

Create print layouts to match your most common 
needs and then save them as a template on the 
left side of the Print module. 
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When printing or exporting an image, you can 
overlay a watermark. Brainstorm what kinds of 
watermarks would be the most useful for your 
organization. Do you need to mark your images 
with a copyright notice, a “proof only” overlay,  
or add a subtle mark that displays your website 
address? 

To create a watermark, choose Edit Watermarks 
from the Lightroom menu (Mac), or Edit menu 
(PC). 

CREATE WATERMARKS
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COLLECTIONS
Collections give you a different way of organizing your images 
within Lightroom. You can use them to group images together 
for whatever purpose you like. It’s important to understand that 
when you place an image into a Collection, the image is not moved 
on your hard drive, it’s not moved away from its original folder in 
Lightroom, and no copy is being created. The Lightroom Catalog 
simply refers to that image fil . One image can also reside in more 
than one Collection. 

You can compare the concept of Collections to the concept of a 
playlist in iTunes. You end up dragging songs into your playlist and 
it doesn’t move them on your hard drive. It just remembers what 
songs are on your list. You can change the order of the songs but 
they will still not change locations on your hard drive. 

The Collections panel can be found on the left side of the Library 
module and the Develop module. To create a new Collection, click 
the little plus icon (+) at the top of the Collections panel and you 
will get a small dialog box where you can give your new Collection 
a name. After you create the new Collection, it will appear in the list 
within the Collections panel. 

To add images to a Collection, you can simply drag them on top 
of the Collection name within the Collections panel.  If you click on 
the name of the Collection, you’ll see all of the images that reside 
in the Collection. 

Images are being added to a Collection by dragging them over the Collection name.
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If you’re ever looking at an image within a Collection and you want 
to find its folder location, right-click on the image and choose “Go 
to Folder in Library” from the pop-up menu that appears. To re-
move an image from a Collection, simply activate it and hit the De-
lete key. This will remove the image from the Collection, but it will 
NOT remove it from your hard drive. It will still reside in its original 
folder.

Smart Collections A Smart Collection is essentially a saved search.  
Any images that follow the rules, or search parameters, that you 
specify will automatically be added to the Smart Collection. For ex-
ample, if you tell the Smart Collection to include all 5-star images, it 
will not only add all your current 5-star images, but it will add any 
images you rate with fi e stars in the future. To create a new Smart 
Collection, click on the little + button at the top of the Collections 
tab and choose “Create Smart Collection.” A dialog box will appear 
where you can give it a name and create rules for what images should 
go into the Smart Collection. Create a rule by clicking on the drop-

The Create Smart Collection dialog box. Here, we have three rules created for how 
Lightroom will add images to this Smart Collection. 
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down menu at the left side of the main window (the white area) and 
choose the fir t type of criteria you’d like to use. You’ll have many 
choices such as rating, date, label color, file name, etc. Once you 
choose a rule, you’ll get further settings pertaining to that rule. For 
example, if you choose rating as a rule, you will have to choose how 
many stars and whether you should include images that are greater 
than or equal to, equal to, etc. If you would like to add another rule, 
click on the little + button to the right of the fir t rule.  After setting 
up all of the rules for your Smart Collection, click the Create button. 

In the Collections panel, all Smart Collections can be recognized by 
the little gear icon that appears next to the Smart Collection name. 
To the right of the name is a number, which indicates how many im-
ages are inside the Collection.

Uses for Collections
Collections can be extremely useful in helping you organize your 
images. Just to give you a few ideas, here are a couple ways that I 
use them. 

To organize projects by status I have differ-
ent Collection Sets for Active Projects and 
Projects Archive. Within each of those sets, 
I have a separate set for each client. Then, 
there is a set for my Portfolio, which has 
Collections within it for the different cate-
gories (Landscapes, Travel, etc.).

To structure a presentation 
When organizing the images 
for this workshop, I created 
a different Collection Set for 
each week. Within those were 
Collection Sets for each day, 
and then individual Collec-
tions for each topic. 

I create Collection Sets for 
the different statuses of 
my projects

The  
Collections 

I created 
to organize 

this class
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In Progress with Smart Previews This collection automatically adds 
all images that are in one of my “In Progress” folders AND that have 
Smart Previews. Smart Previews allow you to adjust your pictures 
when the hard drive containing them is not connected to your ma-
chine. This is useful to me because it tells me which photos I can 
process while I’m traveling and don’t have my main image hard drive 
with me. 

Outtakes with Smart Previews  As I’m working through the images 
in my “In Progress with Smart Previews” Collection, I will undoubt-
edly come across images that I just don’t like and I know that I’m 
not going to work on them any further. In this case, I move them 
into another Smart Collection I have, called “Outtakes with Smart 
Previews.” Because I know that the 
Smart Previews are no longer nec-
essary for the images in this fold-
er, I can discard them. This is the 
fir t thing I do when my hard drive 
starts to become too full. To dis-
card the Smart Previews for imag-
es, fir t select the images and then 
choose Library > Previews > Dis-
card Smart Previews. 

Highest Rated Images If you regularly rate your images, you can 
create a Smart Collection that displays all of your four or fi e star 
ratings. To do this, you’d choose the Rating option from the left 
menu in the Create Smart Collection dialog. Then you’d set the rule 
to “is greater than or equal to” and then specify four or fi e stars. 
Then, every time you rate an image as four or fi e stars, it will auto-
matically be placed in this Smart Collection. 

I have different Smart Collections for 
“In Progress with Smart Preview” and 
“Outtakes with Smart Previews.” 

The formula for setting up the “In Progress with Smart Preview” Smart Collection
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Organize my Portfolio 
Images by the Location 
I created a Collection Set 
called Locations and then 
placed several Smart Col-
lections inside, represent-
ing different locations. 
Images are automatically 
added to the Smart Col-
lections based on key-
words and rating. 

Collection Sets After you’ve started to create Collections, you’ll 
probably want to start organizing them. One way of doing that is 
to create Collection Sets. To do this, click on the little plus icon to 
the right of the Collections heading and choose “Create Collection 
Set” from the menu that pops up. 

A Collection Set is similar to a fold-
er, but it doesn’t actually reside 
on your hard drive. If you choose 
to create a Collection Set, you will 
get a dialog box where you’ll be 
prompted to give the Collection 
Set a name and then click the Cre-
ate button. You will see the new 
Collection Set in the Collections 
panel, and it will have a little file
box icon next to it. 

A Collection Set is essentially a container for Collections. That 
means that you can drag Collections into this set. You can right 
click on the name of the Collection Set and choose to create a new 
Collection Set, either inside a current Collection Set or on its own.

Photos are automatically added to these Smart 
Collections based on location keywords.

To create a new Collection Set, click the 
+ button at the top of the Collections tab
and choose “Create Collection Set.”
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Searching Collections At the top 
of the Collections panel, there is 
a search field. When you type a 
search term here, the Collection 
Sets will expand to show you all 
Collections that contain that word. 
Note that there is a small side 
menu on the left side of the search 
field that allows you to choose be-
tween searching All [Collections] 
or Synced Collections.  In most cas-
es, you’ll likely want to keep this set 
to All. (The Synced option refers to 
Collections shared with Lightroom 
Mobile, the topic of a different les-
son.) 

If the search field is not visible, note 
that you can show or hide the field
by clicking on the little plus icon at 
the top of the panel and toggling 
the “Show Collection Filter” option. 

Collections Panel in Every Module One of the nice things about 
Collections is that you can find the Collections panel in every mod-
ule of Lightroom. That is not the case with the Folders panel, which 
can only be found in the Library Module. This gives you the ability 
to access different images without switching modules to do so. 

Search your collections using the field
at the top of the Collections panel.

Click the little menu on the left side of 
the Search field o specify whether you 
want to search all Collections or Synced 
Collections (Lightroom Mobile).
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Quick Collection This is kind of like a temporary Collection. I think 
of it as a virtual post-it note within Lightroom and I use it when I 
need to quickly group some images together. It is always located 
under the Catalog tab on the left side panel. 

You’ll notice that there is a lit-
tle + sign to the right of the 
words “Quick Collection.” 
This indicates that there is a 
keyboard shortcut for add-
ing images to this collection, 
and that is the B key. You can 
also add a photo to the Quick 
Collection by clicking the lit-
tle circle in the upper right of 
the image thumbnail.

To empty the contents of the Quick Collection, right click on it and 
choose “Clear Quick Collection.” Alternatively, you may want to take 
the contents of the Quick Collection and turn it into a permanent 
Collection. Right click on it and choose “Save Quick Collection.” A 
box will appear where you can give the new Collection a name. 
Then, it will be created and appear in your main Collections list. 

Set Target Collection (for Keyboard Shortcut) We mentioned 
above that, by default, the B key is the keyboard shortcut for add-
ing images to the Quick Collection. That’s because the Quick Col-
lection is set as the Target Collection. You can change which Collec-
tion is the Target Collection, and therefore control which Collection 
images will be added to when you hit the B key. To do this, right 
click on the name of the Collection and when the pop-up menu 
appears, choose “Set as Target Collection.” Now you will see the lit-
tle + sign to the right of that Collection’s name. Note that pressing 
the B key a second time on the same image will remove it from the 

The Quick Collection is always located under 
the Catalog tab on the left side of the inter-
face, below the Preview window. 
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Collection. This is something to be careful of because you may end 
up accidentally removing images that are already in the Collection 
you want them in. 

The Spray Can The Toolbar 
below the main image win-
dow contains an icon that 
looks like a spray can and 
this allows you to quickly 
“spray” a designated setting 
onto your images in the Grid 
View. When you activate the 
tool, a menu will become 
available to the right and this is where you determine what setting 
you want to apply using the spray can. In this example, we chose 
Target Collection. The Target Collection is set as the Quick Collec-
tion, so we can use the tool to “spray” (by clicking and dragging) 
this setting onto various images. When we click on a thumbnail 
with the spray can, it will be added to the Quick Collection. When 
you’re done using the spray can, click back in the space that you 
found it to “put it away.” Note that if the Toolbar is not visible on 
your screen, you can toggle its visibility by tapping the T key or 
going to the View menu and choosing to Show or Hide Toolbar. 

After activating the spray can, you can use 
the menu to determine what setting it will ap-
ply to the images. In this example, the spray 
can will add images to the Target Collection, 
which is the Quick Collection. 
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IMAGE ORGANIZATION: SORT BY STATUS
I have developed a very specific and streamlined system for how 
I organize my images into folders after a shoot. It makes it so I 
always know the status of each image and can readily show my 
portfolio-worthy photos within a moment’s notice. Let’s look at the 
process for creating a system like that.

Create main folder for shoot on import When I import my images 
from the memory card, I will create new folder and place all the 
images in that folder. 

In-Progress Subfolder As soon as my images have finished im-
porting, I will create a subfolder within the base level folder called 
“In Progress.” Then, I will move ALL of the images from the shoot 
into this folder. As I work on the images within my In Progress fold-
er, I will eventually get to the point where I can call some of them 
complete (done adjusting) and ready to show the public. I will take 
these images and drag them into the base level folder for the shoot.  
Then I know that, whenever I look at my folder list (looking at the 
base level folders), the number that is shown next to each folder is 
the number of images that are ready to show the public. 

Outtakes Subfolder I also create an “Outtakes” subfolder within 
the base level folder. This is where I put all the images that I’m really 
not happy with and don’t need to see again. 

Working through the images from a shoot Here is how I work my 
way through the In-Progress folder right after importing images 
from a shoot. I will select the fir t image in the folder and hit the 
Space Bar to make the image fill the screen. As I make my fir t pass 
over the images, I will use the arrow keys to move between them. 
As I look at each image, I decide whether or not it’s one that I want 
to work on. If it is, then I will hit the P key on my keyboard to Flag 
it, or designate it as a “Pick.” If I see an image that I don’t like and 
don’t feel it’s worth my time, then I will hit the X key to designate it 
as a reject. (Note that there are menu commands to do this as well 
and you can find them by selecting the Photo menu and choosing 
Set Flag.) As I move through my images, I will keep one hand on 
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the right arrow key and another hand on the P and X keys. This will 
allow me to very quickly move through an entire set of images and 
designate which ones I want to work on and which ones are no 
good. 

Tip: If you press the Caps Lock key, Lightroom will automatically 
advance to the next picture when you hit the P or X key. This will 
make the process even faster.

After you’ve gone through this process, move back to Grid view 
and you will see that the images you marked as “Picks” have a lit-
tle white flag icon in the corner of the thumbnails. The images you 
marked as rejects have an icon that looks like a black flag with an X 
in it. You can then select all of those reject images and drag them 
into the Outtakes folder. 

Filtering by Flag The Filter Bar can be found above the main im-
age window in the Library Module and you can use it to fil er your 
newly-flagged images by flag type. Note that if the Filter Bar is 
not visible in your interface, you can toggle its visibility by tapping 
the \ key. Select Metadata in the Filter Bar and you will get various 
columns containing fil er parameters. Click on one of the column 
headings to get a menu where you can specify what you want to 
fil er by. We’ll choose Flag. A list will appear below the heading that 
tells us how many images in the selected folder are Rejected, how 
many are Flagged and how many are Unflagged. Click on one of 

After flagging our images, you’ll see that the rejects become grayed out and get a 
black flag i on and the picks get a white flag i on. 
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these items to view all of the images with that particular label. We’ll 
click on the Rejected item to view all of the images tagged as Re-
jects. Then, We’ll drag all of these images into the Outtakes folder. 

Choosing the best image from each sequence When looking 
through your images, you will probably find several sets of images 
that are very similar to each other. I like to narrow my shoot down 
further by selecting only the best one from each of these series. 
Lightroom gives us tools for comparing these kinds of images. First, 
select all of the images that are similar to each other. Then click on 
the little Survey View icon (see screen shot) at the bottom left side 
of the main image window. This will give you a view that shows 

only the images that you 
currently have selected. 
This way, you can compare 
them side by side. In the 
lower right corner, there 
will be an X and clicking 
it will remove it from the 
sequence. So as you de-
termine that some of the 
images aren’t as good as 
the others, you can hit the 
X to remove them from 
the view. Keep narrowing
down until you only have 
one or a few final images 

The Filter bar is being used to fil er images based on Flag. 

Survey View will help you compare like images 
and narrow down to the best ones.
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that you’ve determined are the best ones. Back in the Grid View, 
you can take the other images (the ones you removed) and move 
them to the Outtakes folder. 

Compare View To narrow down 
a set of images even further, you 
can use Compare View, which 
you get to by clicking the Com-
pare View icon at the bottom left of the main image window. In this 
view, you will only see two images at time. The one on the left is the 
Select and the one on the right is the Candidate. There will be little 
X buttons on the bottom right of each image. When you click the 
X for the lesser of the two images, one of your other selected im-
ages will take its place. While working through your images, if you 
find that you like the Candidate image more than the Select image, 
you can turn the Candidate into the Select by clicking the icon on 
the right side of the Toolbar below the image window. You keep 
hitting the X as you compare images and eventually, you will have 
narrowed down to a single image. Back in Grid view, the image that 
is the most selected is the one you chose.

Above, we are comparing two images in Com-
pare View. Right: This icon will take the Candi-
date image and turn it into the Select.
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Stacking  Once I start to accumulate a lot of images in my base lev-
el folder, it means that I have many images from that shoot that I’m 
ready to show the public. What I don’t want, however, is to have too 
many images that look too similar to each other when I’m showing 
the collection to another person. If I have a handful of similar shots, 
I will place them in a Stack with my favorite image on the top of the 
Stack. When you stack images in Lightroom, it’s just like stacking a 
pile of photographs on your desk. One will be on top and that’s the 
one that people can see. You can always unstack them later so that 
you can see the rest of the images. To group images into a stack, 
select all of the images you want to group and make sure that your 
favorite image is the most selected. Then choose Photo > Stacking 
> Group into Stack. Alternatively, you can use the keyboard short-
cut Command+G (Ctrl+G on Win). When a set of images has been
grouped into a stack, you will see a little number in the upper left
side of the thumbnail, indicating the number of images in the Stack.

Left: Two images are selected and will be placed in a stack. The one on the left is 
the most selected so it will appear on the top of the stack. Right: When images are 
stacked, the number in the upper left of the thumbnail indicates how many images 
are in the stack.
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Color Labels Another way of sorting your pictures is to add color 
labels. With an image (or images) selected, go to the Photo menu 
and choose Set Color Label. There are fi e color labels available to 
you, and you can give them custom names based on how you’re 
going to use the labels. To do this, go to the Metadata menu and 
choose Color Label Set > Edit. A dialog will appear where you can 
assign custom names to each of the color labels. You can also save 
the label set as a preset by clicking on the menu at the top of the 
dialog and choosing to Save Current Settings as New Preset. 

Here, we are  
assigning custom 
meanings to each of 
the different color 
labels.
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BEN’S SMART COLLECTIONS
HOW TO INSTALL THE BONUS SMART COLLECTIONS SET

This guide is an excerpt from Homework Assignment: Week 2, Day 1

Before importing the smart collections provided with this assign-
ment, you will have to unzip the file y double-clicking on it. Then, 
go to Lightroom’s main menu and choose File > Import from an-
other Catalog. When you are prompted to navigate to the other 
catalog on your hard drive, choose the unzipped fil , “Bens Smart 
Collections.lrcat.” 

If using Lightroom 7.3 or newer, you will be prompted to update 
the catalog file be ore importing. This is so the same catalog can 
be used to load the Smart Collections regardless of which version 
of Lightroom you are using.

To confirm th t everything loaded, 
take a look at the Collections list on 
the left side of the Library module, 
where you should fins a ollection 
Set called “Bens Smart Collections.” 
Note: After importing, there will be 
one extra photo in your catalog. 
Look for a folder in your folder list 
that’s called “DELETE THIS NOW,” 
right-click on it and choose “Re-
move.” 

Here is a summary of the Smart Collections included with this workshop:

Recently Captured Useful to quickly find an image ou remember capturing recently that 
you might have accidentally stored in the wrong folder, or simply don’t remember its location 
in the folder list. After using these smart collections to locate the image you were looking for, 
right-click on the image and choose Go To Folder in Library to see which folder the image is 
located within.
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Recently Edited To quickly locate an image you can re-
member processing in the last few days. 

Hero Images Lacking Keywords This collection will only be 
useful if you have adopted my standardized folder naming 
conventions (In Progress, Outtakes, Support Files, etc.). If 
you’ve decided to use different naming conventions, then 
you’ll have to modify this smart collection to reflect those
changes. The collection is attempting to only locate im-
ages that are on the base level of each folder by ignoring 
images that are found in subfolders that are named using 
my standard naming convention. It is my goal to keyword 
100% of the images that appear in this collection. Note: 
adding a single keyword to any of the images that appear 
in this collection will cause the image to be removed from 
the collection since it will no longer match the search crite-
ria that the collection is based on. If you often press return 
or enter after entering a keyword, but then add additional 
keywords afterward, then you might want to select the 
images you’d like to keyword and put them into the Quick 
Collection and keyword them from there so they don’t dis-
appear the moment you add your fir t keyword.

Superhero Images Similar to above, but only finds base-l vel folder images that have been 
rated 5 stars. I only use fi e star ratings for my absolute best images. 

Outtakes with Smart Previews I use this collection anytime my hard drive is starting to get 
full. I click on the collection name, type Command-A (Mac), or Ctrl-A (PC) and then choose 
Library>Previews>Discard Smart Previews. I feel safe doing so since images in the Outtakes 
folder are ones that I shouldn’t have to work on or use in a project and the smart previews 
just allow me to adjust those images when the drive containing them is not attached. 

Support images with Smart Previews Similar to the Outtakes with Smart Previews collection. 
Support Images are those that were used to produce a panorama, hdr or layered Photoshop 
file and arely need to be used again, so it’s usually safe to discard the smart previews to 
save space.

In Progress with Smart Preview Since images in folders named In Progress still have work 
left to be done and a Smart Preview allows me to adjust an image when the drive containing 
the original is not mounted, then this collection shows me which images I should consider 
adjusting while traveling.

BEN’S SMART COLLECTIONS
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Raw Outtakes If the hard drive that contains my original images is getting to be full and I’d 
like to free up space, then I use this collection to locate all the images that I might consider 
converting to lossy DNG files sin e they take up a lot less space on my hard drive. To make 
the conversion, choose Library>Convert Photo to DNG using the following options (KAREN, 
show screen shot instead of showing this as text): Only Convert Raw files, Dele e originals 
after, dng, 7.1,Medium, Embed off, Use Lossy ON, Embed original OFF

Automatic Portfolios Finds images that have been tagged with the keyword of Portfolio as 
well as a keyword related to the category of portfolio listed. Double-click on each of these 
portfolios to see which keywords you should tag on your images to get them to automatical-
ly appear in these collections. 

Collect All Textures, Skies, Backgrounds, Etc. I capture images of textures, skies and back-
grounds all over the world and they are stored in standardized folder names inside the main 
folder for a shoot. That means I might have a folder named 2016_03 Moscow Russia with a 
subfolder named Textures that contains all of the textures I captured in that location. These 
collections automatically collect all those images into one place to make them easy to find
since I rarely remember where or what I was shooting when I took a random photo of a sky 
that I might decide to use later.

Rename _MG_ Files This smart collection allows me to find images th t still have file names
that were generated by my digital camera. I believe every image should have a unique file
name so there is never any confusion as to which file someone is eferring to. My digital 
camera defaults to file names th t begin in _MG_. The number that appears to the right of 
this collection name tells me if any images slipped through and didn’t get renamed. When I 
see a number appear next to this collection name, I click on the collection, Right-click on the 
fir t image, choose Go to Folder in Library, select all and then choose Library>Rename Photo. 
Just be careful since you might not realize that the folder has an odd sort order (you want it 
by capture time), or if some images are in stacks that are collapsed and therefore won’t be 
included.  

ISO Related These are useful when you need to consider applying noise reduction to a large 
number of images based on how high of an ISO setting was used. 

In Progress Rated or Flagged This helps me find images th t I might want to consider add-
ing Smart Previews to before I leave on a trip where I’ll be away from my main image storage. 
I don’t add smart previews to all of these images since that would take up a considerable 
amount of space on my hard drive, but this collection helps make me think about what I 
should consider processing soon. You might want to modify these collections to add a date 
range so it doesn’t search your entire hard drive and instead concentrates on your more re-
cent images.

BEN’S SMART COLLECTIONS
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CREATE FILTER PRESETS

CULL DOWN A SHOOT
DEVELOP A STAR RATING SYSTEM
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Consistency is the key to being effective since it will allow you to take 
advantage of features such as Smart Collections and the Filter Bar to 
quickly separate your images into different categories. 

Consider how you currently think about and like to manage projects. 
What details do you need to track and how might you use collections 
to help you keep track of project details? 

• Portfolios by location, project or subject matter?
• Family events over the years such as Christmas, Birthdays, etc.?
• Client images that need to be sent to have prints made?
• Images from long-term projects that need to be processed (my

yoga shots would be one example where I shoot them all over the
world, but might want to collect the ones that I’m most anxious to
process in one spot)

What type of collections would best suit your particular organization?

Consider creating related collections now so that the collection list can 
serve as a reminder for how you plan to organize your images in the 
future. 

BRAINSTORM IDEAL PROJECT 
MANAGEMENT STRATEGIES
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UTILIZE SMART COLLECTIONS
I did your homework for this one! When I was originally writing this 
PDF, I started this section by having you brainstorm about what kind 
of smart collections might be useful and then was going to talk you 
into creating those collections. Then, I just went and created them 
for you and will instead describe what the smart collections do and 
then you can decide if you’d like to load them and possibly delete (by 
right-clicking) any that you don’t think will be helpful, or modify (by 
double-clicking the name) to make them better suit your needs. Then 
if you can think of any other smart collections that are not in this list, 
then go create them yourself and consider that extra credit homework. 

How to load the provided Smart Collections:
Before importing the smart collections provided with this assignment, 
you will have to unzip the file by double-clicking on it. Then, go to 
Lightroom’s main menu and choose File > Import from another Cata-
log. When you are prompted to navigate to the other catalog on your 
hard drive, choose the unzipped file, “Bens Smart Collections.lrcat.” To 
confirm that everything loaded, take a look at the Collections list on the 
left side of the Library module, where you should find a Collection Set 
called “Bens Smart Collections.” Note: After importing, there will be one 
extra photo in your catalog. Look for a folder in your folder list that’s 
called “DELETE THIS NOW,” right-click on it and choose “Remove.” 
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HERE IS A SUMMARY OF THE SMART COLLECTIONS 
INCLUDED WITH THIS HOMEWORK ASSIGNMENT
Recently Captured Useful to quickly find an image you remember 
capturing recently that you might have accidentally stored in the 
wrong folder, or simply don’t remember its location in the folder list. 
After using these smart collections to locate the image you were look-
ing for, right-click on the image and choose Go To Folder in Library to 
see which folder the image is located within.

Recently Edited To quickly locate an image you can remember pro-
cessing in the last few days. 

Hero Images Lacking Keywords This collection will only be useful 
if you have adopted my standardized folder naming conventions (In 
Progress, Outtakes, Support Files, etc.). If you’ve decided to use dif-
ferent naming conventions, then you’ll have to modify this smart col-
lection to reflect those changes. The collection is attempting to only 
locate images that are on the base level of each folder by ignoring 
images that are found in subfolders that are named using my standard 
naming convention. It is my goal to keyword 100% of the images that 
appear in this collection. Note: adding a single keyword to any of the 
images that appear in this collection will cause the image to be re-
moved from the collection since it will no longer match the search cri-
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teria that the collection is based on. If you often press return or enter 
after entering a keyword, but then add additional keywords afterward, 
then you might want to select the images you’d like to keyword and 
put them into the Quick Collection and keyword them from there so 
they don’t disappear the moment you add your first keyword.

Superhero Images Similar to above, but only finds base-level folder 
images that have been rated 5 stars. I only use five star ratings for my 
absolute best images. 

Outtakes with Smart Previews I use this collection anytime my hard 
drive is starting to get full. I click on the collection name, type Com-
mand-A (Mac), or Ctrl-A (PC) and then choose Library>Previews>Dis-
card Smart Previews. I feel safe doing so since images in the Outtakes 
folder are ones that I shouldn’t have to work on or use in a project 
and the smart previews just allow me to adjust those images when the 
drive containing them is not attached. 

Support images with Smart Previews Similar to the Outtakes with 
Smart Previews collection. Support Images are those that were used to 
produce a panorama, hdr or layered Photoshop file and rarely need to 
be used again, so it’s usually safe to discard the smart previews to save 
space.
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In Progress with Smart Preview Since images in folders named In 
Progress still have work left to be done and a Smart Preview allows 
me to adjust an image when the drive containing the original is not 
mounted, then this collection shows me which images I should consid-
er adjusting while traveling.

Raw Outtakes If the hard drive that contains my original images is 
getting to be full and I’d like to free up space, then I use this collection 
to locate all the images that I might consider converting to lossy DNG 
files since they take up a lot less space on my hard drive. To make the 
conversion, choose Library>Convert Photo to DNG using the following 
options:
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Automatic Portfolios Finds images that have been tagged with the 
keyword of Portfolio as well as a keyword related to the category of 
portfolio listed. Double-click on each of these portfolios to see which 
keywords you should tag on your images to get them to automatically 
appear in these collections. 

Collect All Textures, Skies, Backgrounds, Etc. I capture images of 
textures, skies and backgrounds all over the world and they are stored 
in standardized folder names inside the main folder for a shoot. That 
means I might have a folder named 2016_03 Moscow Russia with a 
subfolder named Textures that contains all of the textures I captured 
in that location. These collections automatically collect all those imag-
es into one place to make them easy to find since I rarely remember 
where or what I was shooting when I took a random photo of a sky 
that I might decide to use later.

Rename _MG_ Files This smart collection allows me to find images 
that still have file names that were generated by my digital camera. I 
believe every image should have a unique file name so there is nev-
er any confusion as to which file someone is referring to. My digital 
camera defaults to file names that begin in _MG_. The number that 
appears to the right of this collection name tells me if any images 
slipped through and didn’t get renamed. When I see a number appear 
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next to this collection name, I click on the collection, Right-click on the 
first image, choose Go to Folder in Library, select all and then choose 
Library>Rename Photo. Just be careful since you might not realize 
that the folder has an odd sort order (you want it by capture time), or 
if some images are in stacks that are collapsed and therefore won’t be 
included.  
ISO Related These are useful when you need to consider applying 
noise reduction to a large number of images based on how high of an 
ISO setting was used. 
In Progress Rated or Flagged This helps me find images that I might 
want to consider adding Smart Previews to before I leave on a trip 
where I’ll be away from my main image storage. I don’t add smart pre-
views to all of these images since that would take up a considerable 
amount of space on my hard drive, but this collection helps make me 
think about what I should consider processing soon. You might want 
to modify these collections to add a date range so it doesn’t search 
your entire hard drive and instead concentrates on your more recent 
images.

Now that you’ve got your homework already done for you in this sec-
tion, why don’t you consider if these smart collections should be or-
ganized into collection sets, or if they should be renamed to include 
numbers at the beginning to influence their sort order. 
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CREATE FILTER PRESETS
Unlike Smart Collections, which search your entire library of pho-
tographs, the Filter Bar performs searches on the set of images 
you are currently viewing. That means the Filter Bar can be applied 
to any folder or collection to  limit the number of images you are 
viewing based on search criteria. 

I find the Metadata section of the Filter Bar to be most useful and 
like to set up presets that I use frequently. Below are some that I 
use all the time. 

Brainstorm what you think would be useful for your specific situa-
tion and create your own presets. Just be careful, since any choic-
es that are highlighted within the columns will be incorporated in 
your preset. If you’d rather just have the column represented and 
not a specific entry within the column (like ISO instead of ISO 400), 
then be sure the top-most choice in each column is active before 
creating a preset. Once you’ve dialed in the settings you’d like to 
use in the future, click on the pop-up menu that’s found just to the 
left of the lock icon in the upper-right of the Filter Bar and choose 
“Save Current Settings as New Preset.”
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Some Filter Bar presets I use all the time:

Find Processed Images When I encounter an older folder that is 
not using my standardized folder naming convention, then I use 
this setup to quickly find images that should possibly be moved 
to various subfolders. TIFF and PSD files might be finished images 
that should go to the base-level folder. Images with Custom devel-
op presets are also candidates for the base-level. Same with imag-
es that have been rated or flagged. Images with a develop preset 
of Default Settings should most likely end up in the In-Progress 
folder. Finally, images flagged as rejects should go into the Out-
takes folder. 
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Shallow Depth of Field I find these filter choices useful when I’m 
searching for images that should have narrow depth of field or 
have a good amount of foreground to background compression. 
Any images shot with a longer focal length lens at f4 or lower will 
most likely feature shallow depth of field. Also, images captured 
with a long lens should show a good amount of compression.

Multi-Shooter This setup can be useful when more than one per-
son was shooting an event. First setup the left-most column to limit 
your view to the date range you’re thinking of, then you can sep-
arate things down to which camera captured the action and then 
further narrow it down to wide or detail shows and possibly even 
find images that have some motion blur. 
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Brainstorm some of your own Filter Bar Presets:
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CULL DOWN A SHOOT
Find a folder of unprocessed images and think through how you 
would best use a combination of flags (pick and reject), ratings and 
possibly even color labels to narrow down the shoot to the most 
important images. 

The closer you can get to a standardized system, the easier things 
will be when you revisit a folder many months later and need to 
reacquaint yourself with the shoot.

ORGANIZING IMAGES & MANAGING PROJECTS  |  125



DAY 6
WEEK 2

DEVELOP A STAR RATING SYSTEM
Brainstorm a consistent star rating system that you will apply from 
now on to every image that you consider to be finished. Also fig-
ure out a consistent method for marking an image as being fin-
ished and ready to show the public. I personally have those images 
as the only ones that are allowed to reside in the base-level folder 
of a shoot. All non-finished and not ready for public view images 
are in the In-Progress and Outtakes subfolders. Then, once the 
base folder gets to have more than a dozen images, I rate the im-
ages using 5 stars for my absolute best work regardless of subject 
matter, 4 stars if the best of this shoot and 3 stars is the 2nd best 
of the shoot. I rarely use 1 or 2 stars for my base-level images, but 
frequently use them for images in the In-Progress folder. That’s my 
system, but it might not be right for you, so brainstorm what works 
and doesn’t with my system and then modify it to your own needs.	

• 1=
• 2=
• 3= 2nd Class Citizen
• 4= Hero
• 5= Super-hero
• Only 3+ stars are for public view
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LIGHTROOM KEYWORDS
Keywords are essentially tags that you apply to your images. You 
keyword your images in Lightroom because it makes them easier 
to find later and you can use them when fil ering/sorting. There are 
several places within Lightroom where you can add keywords to an 
image, so let’s look at a few. 

Adding Keywords When you are viewing an image in the Library 
module, you will find a Keywording panel on the right side of the 
interface. At the top of this panel, there is a rectangular field that 
will display any keywords applied. To add keywords to an image, 
click in the text field that says “Click here to add keywords.” Type 
in any words that will help you think of the image later. For exam-
ple, if it’s an image of the Golden Gate Bridge, your keywords may 
be: Bridge, Golden Gate Bridge, San Francisco, California, Red. It’s 
important that you separate your keywords with commas because 
Lightroom allows you to have multi-word keywords and you want 
it to know that “Golden Gate Bridge” is one keyword and not three. 

Here, we are entering keywords for this image into the field within the eywording 
panel on the right side of Lightroom’s Library Module. 
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When you start using a word 
that you’ve used in the past, 
Lightroom will give you a sug-
gestion as to what it thinks the 
word would be. If that’s the 
word you want, just hit enter 
and that word will be applied. 

Usually, when going through 
a process like this, we would 
move between our images us-
ing the left and right arrow 
keys. However, because we are 
working with text fields, the left 
and right arrow keys will simply 
move us between letters in our 
text fields instead of between images. To move between images 
during this keywording process, hold down the Command Key (Ctrl 
on Win) when using the arrows.

You can tell what keywords have 
been applied to an active image by 
looking at the text field in the Key-
wording panel. If you have multiple 
images selected, the keywords for 
them will still appear in this field
and you will likely see asterisks 
next to some of them. An asterisk 
indicates that at least one of the 
selected images has this keyword, 
but not ALL of the selected images 
have it.

The Keywording panel is displaying 
the keywords for a selected group of 
images. The asterisks indicate that 
the keyword is applied to at least one 
of the selected images, but not all of 
them.

After you type in keywords for an image, 
they will appear in the main text field u -
der the Keywording panel.
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Keyword List When you add keywords 
to an image, the keywords are all being 
added to a master Keyword List that 
Lightroom creates. You’ll see that there 
is a separate panel for the Keyword 
List on the right side of the interface. In 
the Keyword List, there will be a num-
ber to the right side of each word. That 
number indicates how many images 
have been tagged with that keyword. 
If you would like to view all the images 
tagged with a particular keyword, hov-
er over the word in the Keyword List. 
When you hover your mouse over the 
word, a little arrow will appear. Click on 
the arrow and Lightroom’s fil er fea-
ture will show you all the images that 
were tagged with that keyword.  

When you have an image selected, the Keyword List will display 
little check marks to the left of each keyword that has been applied 
to the image. If there was a keyword applied erroneously, simply 
click on the check box to remove it.  

If you want to change 
a keyword (because of 
a misspelling, perhaps), 
simply double-click on 
the word in the Keyword 
List and you will get the 
“Edit Keyword Tag” di-
alog box. Here you can 
change the keyword and 
work with some options 
related to it. 

All of the keywords you have 
ever used will appear in the 
Keyword List. If you hover over 
one of the words, an arrow will 
appear on the right. Clicking it 
will cause Lightroom to show 
you only the images tagged with 
that keyword. 

Double-clicking on a keyword within the Keyword 
List will open the “Edit Keyword Tag” dialog box. 
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When you update a keyword using the Edit Keyword Tag dialog, all 
of the images using that keyword will be updated as well. 

You can add a keyword to the keyword list (without actually apply-
ing it to an image) by typing the word into the field at the top of the 
Keyword List panel. To remove a keyword from the list, right-click 
on the keyword and choose Delete from the menu that appears. 
Had that keyword been applied to any images, it will be removed 
from those images’ keywords. 

Adding Synonyms That same “Edit Keyword Tag” dialog box will 
allow you to add synonyms for your keywords. This can be useful 
when you think that you might use different search words in the 
future. For example, you might create a keyword of “Bicycle,” but 
know that down the line, you might use the search term of “Bike” 
instead. If you add synonyms, then the images tagged with the 
keyword will come up when you search for that keyword or any of 
its synonyms. 

Double-clicking 
on a keyword 
within the Key-
word List will 
open the “Edit 
Keyword Tag” 
dialog box and 
it’s here that 
you can add any 
synonyms for the 
chosen keyword.
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Include on Export When you export your images, you can decide 
whether the keywords should stay attached to the image (within 
its metadata) or if they should be thrown away. In the Export di-
alog, the Metadata section includes a dropdown menu where you 
can determine how much metadata should be included with your 
image. If you choose to export “All Metadata,” the keywords will be 
included. If you have certain keywords that you don’t want to be 
exported, there is a way to specify that. 

Including your keywords 
can be a useful thing when 
exporting for something 
like a stock photography 
site that relies on keywords. 
But sometimes, you’ll have 
certain sensitive keywords 
that you don’t want includ-
ed. Double-click on a key-
word within the Keyword 
List. When the “Edit Key-
word Tag” dialog box ap-
pears, you will see a check-
box that says “Include on 
Export.” Turning this check-
box off will make it so that 
particular keyword is never 
exported with your images. 
As a personal preference, I 
usually add a little symbol to 
the end of my keyword tag 
when I turn this check box 
off. This way, when I look at 
my Keyword List, I can rec-
ognize the ones that I’ve 
marked as sensitive and that 
will not be exported. 

When I choose to not include a keyword on 
export, I will put a little # symbol next to it so 
I can recognize it as a sensitive keyword when 
I look at my keyword list. 

If you don’t want a keyword to be exported, 
double-click on the word to call up the Edit 
Keyword Tag dialog and turn off the “Include
on Export” check box. 
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Searching Keywords  There 
is a search field at the top of 
the Keyword List panel and 
you can use this to search for 
a specific keyword in your list. 
The result[s] will appear un-
der the search field and you 
can click on the number to 
the right of the keyword to 
see every image that has been 
tagged with it. 

Keyboarding Panel Options  
At the top of the Keywording 
panel, there is a menu that will 
let you specify what should 
appear in the large text field
below. The default choice is 
All Keywords, which will ob-
viously display every keyword 
the image is tagged with. If 
you change the menu to Will 
Export, then any keywords 
you set to not be included on 
export will also not appear in 
the list.

Utilizing special symbols You don’t have to be adding keywords to 
a specific image in order to create a new keyword. To create a new 
keyword, click on the little + symbol at the top of the Keyword List 
tab. 

It can be useful to use special symbols with certain keywords as a 
personal indicator or, in other words, a note to yourself. For exam-
ple, I create keywords that indicate things an image might need, 
like retouching, color correction, etc. I will begin each of these key-

Search for keywords using the field t the 
top of the Keyword List panel. 

Use the menu at the top of the Keywording 
panel to specify what should appear in the 
large text field within th t panel. 
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words with an exclamation point (!). This not only tells me that it’s 
a different kind of keyword, but when I type in a keyword for an 
image and I start with !, Lightroom will give me recommendations 
that include all the other keywords that start with !. (see screen 
shot) 

Keyword Suggestions Another 
area within the Keywording tab 
is Keyword Suggestions. This is 
an automatically-generated list 
of keywords that you use a lot or 
have used a lot recently. If you 
are tagging a shoot and Light-
room notices that you keep us-
ing some of the same keywords 
over and over again, those key-
words will end up in this list and 
you can simply click on them to 
add them to your images. 

Keyword Sets If there are cer-
tain keywords that you know 
you use all the time, you can 
create a Keyword Set with those 
words. Keyword Sets are groups 
of Keywords that are easily ac-
cessible via the Keyword Set 

In the left screen shot, you can see that my keywords that begin with “!” are all 
things that my images might need. In the screen shot at right, you can see the rec-
ommendations that Lightroom provides when I type ! into the Keyword field.

The Keyword Suggestions list, found in-
side the Keywording tab. 

The Keyword Set area within the Keyword-
ing tab.

MAKING IMAGES SEARCHABLE WITH KEYWORDS  |  134



Copyright 2018 by Ben Willmore. All Rights Reserved

LIGHTROOM CLASSIC: THE COMPLETE GUIDE
MAKING IMAGES SEARCHABLE WITH KEYWORDS

area at the bottom of the Keywording tab in Lightroom. I have a 
few different Keyword Sets and the main one contains the Key-
words I use more than any others. This includes my wife’s name, 
my bus’ name, Light Painting (a type of photography I do), etc. You 
can have multiple keyword sets and you can switch between them 
using the Keyword Set dropdown menu in the Keywording tab. 

To create a new Keyword Set, click on the Keyword Set dropdown 
menu and choose “Edit Set.” The “Edit Keyword Set” dialog box 
will appear and there will be nine text fields for typing in keywords. 
Once you’ve typed in the words you want in your new set, use the 
dropdown menu at the top and choose “Save Current Settings as 
New Preset.”

Lightroom also provides 
us with keyboard short-
cuts for applying the 
keywords in our keyword 
sets. If you hold down 
the Option Key (Alt on 
Win), you will see that a 
number will appear next 
to each of the words in your Keyword Set. Keeping the Option Key 
held down, type a number on the keyboard to add its keyword to the 
selected image[s]. 

You can create new Keyword Sets using the “Edit Keyword Set” dialog box. 

Holding down the Option Key (Alt on Win) will 
allow you to use keyboard shortcuts to apply the 
keywords in your selected Keyword set. 
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Filtering for Keywords You don’t have to use the panels on the right 
side of the interface to search images by keyword. You can also use 
the Filter Bar, which is located above the main image window in the 
Library module. In the top part of the Filter Bar, choose Text, and 
then use the Text dropdown menu to choose Keywords. Enter in 
the keyword (or keywords, separated by commas) you would like to 
search for in the field to the right. Keep in mind that you’ll also have 
to pay attention to the second dropdown menu, where you specify 
whether you want to see images that contain the keyword or con-
tains words from the keyword.

Keywords and Smart Collections  A Smart Collection is basically a 
saved search. It is automatically populated based on search criteria 
that you specify and we can use keywords as part of this search cri-
teria. To create a new Smart Collection, click on the little plus sign 
to the right of the Smart Collection header on the left side of Light-
room’s interface. In the dialog that appears, give the Smart Collec-

The Filter Bar is being used to 
search images by keyword. 

In the Create Smart Collection dialog, we specified th t the collection Search by 
keywords and that the keywords should contain “cat.”
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tion a name (we chose Animals) and then use the menu on the left 
to choose Keywords from the search options. A menu will appear 
to the right and we’ll choose “contains” and then we’ll type in the 
desired keyword. In the example, we used Cat. This tells the Smart 
Collection to automatically include all images that contain the key-
word of “cat.” 

Include on Import You can 
keyword your images as you 
import them by using the 
Keywords field on the right 
side of the Import dialog. 
Just note that the keywords 
you include here will apply to 
every single picture so you 
need to make sure that the 
keywords you choose per-
tain to all of them. Apply keywords while you’re importing imag-

es by typing them into the Keywords field in
the Apply During Import panel of Lightroom’s  
Import dialog. 
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BEN’S KEYWORD STARTER SET

This Lightroom Bootcamp Workshop comes with a starter set of Lightroom Keywords. 
In order to use them, you will have to install them. 

Note: If you already have existing, unorganized keywords, I’d suggest you move them 
so they do not clutter up the structured list you are about to load. To do so, open the 
Keyword List area on the right side of the Library Module, Click the “+” at the top of 
the panel and create a new keyword named zUnsorted. Then click on the top-most 
keyword in the list, scroll to the bottom of the list and shift-click the second to the last 
keyword (the last one should be zUnsorted) and then drag the selected keywords on 
top of the zUnsorted keyword so they become children of that keyword.

If you already have a keyword  hierarchy, then you 
should be aware that there is no automated way to 
merge two keyword lists. It is a manual process of 
dragging and dropping keywords to reorganize them 
or selecting and pressing delete to remove duplicates.

To install the keyword set, fir t unzip the file by dou-
ble-clicking on it. Then, open Lightroom, click on the 
Metadata menu at the top of the screen and select “Im-
port Keywords.” You’ll then be prompted to navigate 
to the keyword file on your hard drive and click the 
“Choose” button. After you do this, you will see the new 
keywords in the Keyword List panel on the right side of 
Lightroom’s Library Module. 

Now, you can use these new keywords and apply them 
to your images. From within the Keyword List panel 
(shown at right), you can apply keywords to the select-
ed image[s] by clicking the little check box to the left 
of the keyword name. This will not only apply the cho-
sen keyword but it will also apply any parent keywords. 
In the example at right, we added the “China” keyword 
and Lightroom automatically added the “Asia” keyword as well. 

You can also add keywords by typing them into the  field in the Keywording panel or 
by choosing them from the Keyword Suggestions list.  

HOW TO INSTALL & USE YOUR LIGHTROOM KEYWORD SAMPLER SET



DAY 7
WEEK 2

HOMEWORK:
CREATE KEYWORD SETS

KEYWORD LAST FEW SHOOTS
CREATE KEYWORD-BASED SMART COLLECTIONS
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As with everything you do in Lightroom, I find it is best to develop a 
standardized system that you apply consistently across all your imag-
es. Here are a few things you should consider before you get too in-
volved with keywording your images:

CAPITALIZATION
Capitalization is ignored when searching based on keywords, so it can 
be considered a personal preference. Do you prefer Initial Caps or all 
lowercase keywords. Lowercase takes less effort since you never have 
to think about pressing the Shift key, but you might also find the Initial 
Capitals simply looks better (I do). Whichever your preference, think 
through it now before you start tagging too many images with key-
words. The nice thing is that you can always edit your keywords after 
tagging images and all images tagged with the keyword you are edit-
ing will be updated to reflect the changes you make. 

TAGGING YOUR IMAGES WITH KEYWORDS ALLOWS 
YOU TO LATER FIND THE IMAGES USING THE FILTER 
BAR, SMART COLLECTIONS, OR THE KEYWORD LIST. 
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NON-EXPORTING KEYWORDS
When you create a keyword via the + icon next to the Keyword List 
(or double-click on an existing keyword in the keyword list) you can 
choose if the keyword should be included with any images that are 
exported from Lightroom. There is no visual indication that a keyword 
will not export, so it can be useful to add a special character to the 
end of the keyword name to remind yourself that it will not export. I 
personally use #, but you might prefer something else, or to not mark 
those keywords in any way special. It’s just good to think about it be-
fore you keyword too many images in your catalog since it takes a lot 
of time to go back later and modify all those keywords.

SPECIAL CHARACTERS
What special information do you need to track about your images and 
what special characters might you use at the beginning of a keyword 
to help you be consistent with how you keywords your images? For 
instance, if you always use ! at the beginning of keywords that keep 
track of work that needs to be performed on an image, then simply 
typing ! into the keyword field will present you with a list of all the key-
words that start with that character and therefore you’ll see a list of all 
the work-related keywords. Those might include ! Retouching Needed, 
! Color Correction Needed, etc. It all depends if you work in a single
person organization where you do everything, or if you have different
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people who specialize in retouching, etc. Brainstorm what is unique 
about your business and how special characters can be used to pres-
ent a list of related keywords.  Note: The following special characters 
cannot be used in keywords: comma, semicolon, vertical bar, period, 
slash, asterisk (at the end), space (at the beginning)

Think about the subject matter you shoot most frequently and any key-
words that you might frequently want to tag to your images. It might 
be useful to get those keywords into a keyword set so they can be ap-
plied to an image with a single click of your mouse. Each keyword set 
can contain up to nine keywords. 

If you’re a landscape shooter, you might consider keywords such as 
Waterfall, Lake, Mountain, Landscape, Wildlife, Flowers & Plants, Fall, 
Spring, Winter, Summer

If you shoot weddings, maybe you should setup a keyword set that 
includes Bride, Groom, Ceremony, Reception, Ring, Bouquet, Bride’s 
Maids, Groomsmen

CREATE KEYWORD SETS
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BRAINSTORM WHAT MIGHT BE YOUR MOST COMMON KEYWORDS 
AND CREATE APPROPRIATE KEYWORD SETS
Do this by choosing “Edit Set” from the pop-up menu found in the 
Keyword Set area on the right side of the Library module. Once you’ve 
entered the keywords you desire, then choose Save Current Settings 
As New Preset from the pop-up menu that’s found at the top of the 
Edit Keyword Set window. You can create as many keyword sets are 
you’d like.
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I concentrate on keywording my finished and ready to show the public 
images. Why don’t you get some practice by keywording the finished 
images from the last few shoots you processed? When keywording im-
ages, keep in mind the following suggestions:

• Some things don’t need to be keyworded since they are already at-
tached to your images and can be searched for using the Filter Bar at
the top of the Library module: date of capture, f-stop, portrait/land-
scape orientation

• Keywords can be multiple words long with spaces, so there is no
need to use underscores to make them a single word.

• Separate keywords with commas when entering them into the key-
word field.

• You can keyword your images even when the hard drive that con-
tains the originals is not actively mounted on your computer.

KEYWORD LAST FEW SHOOTS
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Only add keywords for concepts that have the potential to help you find 
that specific image in the future. Some concepts to consider include:
• prominent colors:

• red
• blue

• important content:
• monk
• bicycle
• temple

• action happening
• singing
• fighting
• running

• concepts
• happiness
• contentment

• photographic details
• shallow depth of field
• macro

• compositional elements
• framed
• leading lines
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Now that you’ve keyworded a bunch of images, consider creating 
smart collections that can help you find specific sets of images. Brain-
storm how an automatically generated collection of images might 
help your workflow. Just like in yesterday’s homework where I had 
portfolio collections that were automatically populated when I tagged 
an image with the keywords Portfolio and  Landscape. You could cre-
ate smart collections that automatically collect all five star rated imag-
es that are tagged with the keyword Bride for instance. Think through 
what might be most useful in your situation, create a few smart collec-
tions and then tag images with the appropriate keywords to test that 
your collections are working properly. 

Overall, don’t get too crazy about spending time keywording your im-
ages at this point. Just get used to the process and then get ready to 
dive in deep when we have our second session on keywording later in 
the bootcamp. That’s when you’ll learn to organize your keywords and 
fully utilize their power. 

CREATE KEYWORD-BASED 
SMART COLLECTIONS
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CROPPING & STRAIGHTENING
The Crop Tool is located at the top of the 
adjustment panels on the right side of 
Lightroom’s Develop module. When you 
activate the tool, the Crop and Straighten 
settings will appear underneath it and you 
will see crop handles appear around your 
image. Note that you can also use the “R” 
key on your keyboard as a shortcut for ac-
tivating the Crop Tool. 

To crop your image, 
simply click and drag 
the handles that appear 
over your image. If you 
would like to rotate the 
image as well, move your 
mouse outside the crop 
box and you will see 
that your cursor turns 
into right-angle arrows. 
When this happens, you 
can click and drag up 
and down to rotate the 
crop box. 

You can also click and 
drag within the crop box 
to reposition the image 
within the box. 

Below the Crop Tool icon 
is a series of settings for 
the Crop and Straighten 
Tools. To straighten the 
image, you can adjust 

The Crop Tool can be found 
above the adjustment panels 
in the Develop Module.

With the Crop Tool active, you can click and drag 
on the crop handles to adjust the crop. 

To rotate the image within a crop, click outside of 
the crop frame and drag up and down to specify 
the rotation.

FIX PROBLEMS THAT DON’T AFFECT THE WHOLE IMAGE  |  148



Copyright 2018 by Ben Willmore. All Rights Reserved

LIGHTROOM CLASSIC: THE COMPLETE GUIDE
FIX PROBLEMS THAT DON’T AFFECT THE WHOLE IMAGE

the Angle slider and this will rotate the cropping rectangle in the 
same way that it would rotate if you clicked and dragged outside of 
the cropping rectangle with your mouse. To the left of that slider is 
an icon that looks like a bubble level. If you activate this tool, you can 
move your mouse over the image, click and drag out a straight line 
over an area that should be horizontal or vertical. When you release 
the mouse button, Lightroom will attempt to straighten the image 
based on that guide you created. 

With many images, Lightroom can actu-
ally calculate how to straighten the image 
on its own. This is especially the case in 
images where the horizon is in the photo 
or when there are obvious vertical lines in 
objects like buildings. To do this, click the 
little “Auto” button located above the An-
gle slider in the adjustment panel. Alterna-
tively, hold down the Shift Key and double-click on the word “Angle” 
next to the slider. This will also cause it to apply the Auto settings. 

The Straighten Tool is being used to drag out a line along a sign 
to indicate an edge that is supposed to be horizontal. To activate 
this tool, we clicked on the icon that looks like a bubble level. 

The Auto setting will attempt
to straighten the image. 
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Cropping to an Aspect Ratio Within 
the Crop Tool settings, there is an area 
called “Aspect.” To the right of the word 
is a dropdown menu with a list of aspect 
ratio presets for the Crop Tool. This will 
allow you to crop your image to a spe-
cific ratio that matches the paper size or 
the frame size you (or your clients) have 
in mind. If you don’t find the ratio that 
you need, you can choose “Enter Cus-
tom” and type in your own custom ratio. Once you choose a ratio, 
the little lock icon will be turned on and your Crop Tool will be locked 
into that ratio. Click the lock icon again to unlock the restraint. 

Constrain to Image You’ll find that when 
using the Crop Tool, you can not drag 
the crop handles outside of the image 
window. In other words, the Crop Tool 
will not allow you to introduce empty 
space around the edges of your image. 
Even when the “Constrain to Image” 
check box is turned off, you will not be 
allowed to do this in most cases. The time you’ll find this setting to 
be of use is when you apply lens corrections to your image or some 
kind of setting that will correct for distortion. When this happens, 
the edges of the image can become curved with empty, white space 
around the edges. In this scenario, the “Constrain to Image” setting 
will force you to crop out that white space. If the check box is turned 
off, you will be allowed to include that white space in your image 
when cropping.

The Crop Tool & The Arrow Keys The arrow keys are usually used to 
move between images, but when the Crop Tool is active, they can be 
used to move the image around in the crop frame. But what if you 
want to move between images while keeping the Crop Tool active? 
To do this, hold down the Command key (Ctrl on Win) and then use 
the arrow keys.

The Aspect Ratio dropdown menu

The Constrain to Image setting
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SPOT REMOVAL
Spot Removal is Lightroom’s 
tool for retouching and it 
can be especially useful for 
removing sensor dust spots 
from your camera. Note that 
Lightroom’s version of the 
tool is going to be a little more 
limited than Photoshop’s ver-
sion. The Spot Removal Tool 
can be found at the top of 
the adjustment panels in the 
Develop module, right next to 
the Crop Tool. 

When you activate this tool, 
you will see some settings 
appear below the icon. These 
include sliders for Size, Feath-
er (how soft the edge is) and 
Opacity. Your cursor, when 
you mouse over the image, 
will also appear as a circle, 
which will be used to click on 
the area you want to retouch. 
The size slider will make that 
circle larger and smaller. Al-
ternatively, you can use the 
bracket keys ( [ ] ) as short-
cuts to make the circle larger 
and smaller.  You can also use 
the scroll wheel on your mouse. The Feather slider will control how 
soft the edge of the retouching circle will be. And again, you can 
alternatively use the keyboard shortcut, which is to hold down the 
Shift key while either using the scroll wheel on your mouse or two 
fingers on your track pad. For removing dust spots, I generally keep 
this setting at zero. 

The Spot Removal Tool can be found at the 
top of Lightroom’s adjustment panels in the 
Develop module. 

An example of a sensor dust spot that we’ll
want to remove using the Spot Removal Tool.

The settings for the Spot Removal Tool ap-
pear when the tool is active.
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What you want is a brush that is just a little bigger than the problem 
area you’re trying to retouch so that the edge of the brush doesn’t 
touch the problem spot. Instead, it only touches the surrounding 
area. It’s going to look all the way around the area where the brush 
is and make sure that it matches that brightness and color. 

After you’ve set the size and softness of 
the Spot Healing Tool, click over the area 
you want to retouch.  When you click, it 
will choose a spot from the surrounding 
area to copy from and it will move it over 
to cover up the area you want to change. 
Note that Lightroom isn’t always smart 
when it chooses the surrounding area to 
copy from. Sometimes it chooses a bad 
area that has some kind of unwanted detail in it. When this happens, 
you can manually reposition that sampling area (the bolder of the 
two circles) by clicking and dragging on the circle. Alternatively, you 
can press the forward slash key ( / ) and it will force Lightroom to 
choose a different place to copy from. 

Visualize Spots If you had a lot of dust spots on your sensor, it can 
be difficul to spot them all when viewing your photos. If you want 
to get a better idea of where the spots are so that you can remove 

them, Lightroom has 
a feature for just that. 
When the Spot Remov-
al Tool is active, you will 
see a “Visualize Spots” 
checkbox visible below 
the image window. If 
you turn that checkbox 
on, you will get a differ-
ent view of your image 
that makes it more ob-
vious where the spots 
are. Don’t worry though. 
This view is temporary! 

When you click on a spot to 
remove, the tool will sample 
from a nearby area in order 
to fill the ci cle contents.

The Visualize Spots check box is turned on, showing 
a different view of the image that makes sensor dust 
spots more noticeable.
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Use the slider next to the checkbox to make the spots more and less 
pronounced. Now, you can use the Spot Removal Tool while in this 
view to remove all of those obvious spots. Note that the keyboard 
shortcut for the Visualize Spots feature is the “A” key.

There is another useful setting that 
can be found to the left of the Vi-
sualize Spots check box called “Tool 
Overlay.” If you click the little drop-
down menu to the right of that, you 
will get some options for when the 
little retouching circles will be visi-
ble. The default setting is “Always” 
and that means that, regardless of 
where your mouse is, the spots will 
be visible. I like to change this setting to “Auto,” which will hide the 
spots when your cursor is not over your image. 

Retouching Several Images at Once You can also use the Spot Re-
moval Tool to retouch several images at once. This can be useful 
when you have sensor dust specks (because they’re located in the 
same place on every photo) and a series of images that are fairly 
similar to each other. 

First, select all of the 
photos you’d like to ap-
ply the retouching to  
(by clicking on the fir t 
image, holding Shift and 
then clicking on the last 
image) and then decide 
which of the images 
would be the most use-
ful to be viewing at the 
time you apply the re-
touching. Click on that 

The Tool Overlay menu controls when 
the little retouching circles will appear 
over your image. 

To retouch multiple images at once, we fir t select-
ed all the images in the Library module. 
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image to make it the active one and then move to the Develop mod-
ule. In the Develop Module, make sure that the “Auto Sync” setting is 
turned on at the bottom right side of the interface. Now you can use 
the “Visualize Spots” setting to retouch out all the dust spots.

Now, because there may 
be differences in subject 
matter across the dif-
ferent images, the Spot 
Removal Tool may have 
caused problems in some 
of them. Inspect each of 
the images you had se-
lected to see if there are 
any issues. When you 
see a problem, turn the 
Auto Sync feature OFF 
so that you’re not going 

to change all the other images. Then go in and either remove or re-
position the sampling circles from the Spot Removal Tool. 

With the Auto Sync feature turned on, we  used the “Visualize Spots” setting to 
retouch out the spots. 

You’ll likely have to go back and fix i sues that 
popped up in some of the other selected imag-
es. In this example, one of the spot removal areas 
overlapped a person’s foot.
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More Precise Retouching There are some times when you need to 
copy from very precise areas with the Spot Removal Tool. There are 
a few other things to try in these cases. First of all, you are not lim-
ited to retouching with a perfect circle when using the Spot Re-

moval Tool. You can ac-
tually use it to click and 
drag to paint over any 
awkwardly-shaped ob-
jects that you want to 
remove. When you do 
this, it will still work the 
same way by sampling 
from a nearby area to 
fill in the spa e. 

The Clone Setting When tackling a more complicated retouch job, 
the other thing you can do is switch from the “Heal” setting to the 
“Clone” setting. You can do this in the Spot Removal Tool settings 
just below the tool’s icon. 

With the Heal setting, the tool 
is only going to try and match 
texture, so you can actually be 
copying from an area that’s a 
different color and it’s still go-
ing to match the color of the 
surrounding area while match-
ing the texture and/or detail 
from the sampling area. The Clone setting works differently. With 
the Clone setting, it’s just going to blatantly copy without doing any-
thing extra. It’s literally making an exact copy of the sampling area. 
This can be useful when you need precise retouching or when the 
Heal setting doesn’t work. When using the Clone setting, you’ll likely 
need to bring up the Feather setting so that there is not an abrupt 
transition where the edge of the brush is. 

Activate the Clone setting for more
complicated retouch jobs

You can also use the Spot Removal Tool to click and 
drag out a non-circular shape. 
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The Opacity Setting Use the 
Opacity setting within the Spot 
Removal Tool when you don’t 
want to completely remove some-
thing. An example of this would 
be a birth mark on someone’s 
skin, where you want to lessen 
the appearance of it without re-
moving it completely. 

Before and After Views  At the bottom of the Spot Removal Tool 
settings, there is a little “light switch” and you can use this to tempo-
rarily disable the work you did us-
ing the tool. This will give you be-
fore and after views so that you 
can evaluate your work. If you’re 
completely unhappy with the 
changes you made, you can click 
the Reset button to eliminate all 
the work done with the Spot Re-
moval Tool. 

When you’re finished using the Spot Removal Tool, click back on the 
tool’s icon in the Tool Bar and you will go back to using all the other 
regular adjustments in Lightroom. 

Use the Opacity setting if you want to 
tone down a spot but not remove it.

Turn off the “light switch” to temporarily 
deactivate the changes made using the 
Spot Removal Tool.
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THE ADJUSTMENT BRUSH
The Adjustment Brush allows you to paint 
in an adjustment on an isolated area of 
your image. The tool can be found above 
the adjustment panels and, when activat-
ed, you’ll see a series of sliders that go with 
it. You’ll find that many of the settings are 
the same as the ones in the Basic panel. 

Start by moving the sliders based on what 
you want to fix or optimize in the image. 
For example, if there is one area that you 
would like to be brighter, you can drag ei-
ther the Exposure slider or the Shadows 
slider to the right. Note that you are not 
going to see any change in your image 
at fir t. That’s because you need to use 
the Adjustment Brush to paint in the area 
you want to affect. So at fir t, you are ba-
sically guessing as to how far the sliders 
should be moved. That’s ok though, be-
cause you can go back and fine tune the 
sliders afterwards. 

There are a series of brush set-
tings for this tool and they can 
be found below the adjustment 
sliders. The size slider controls 
the size of the brush. You can 
alternatively use the left and 
right bracket keys ( [ ] ) or the 
scroll wheel on your mouse to 
change the size. The Feather 
slider changes the softness of 
the brush and uses the same 
shortcuts as the Size setting 
when you add the Shift Key. 

The Adjustment Brush and its 
settings

The brush settings for the Adjustment 
Brush tool 
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You can use the Adjustment Brush 
to adjust different areas of your im-
age with different settings. To start 
a new adjustment, click the little 
“New” button above the adjustment 
sliders. After you’ve made more 
than one adjustment, you’ll see a 
different pin for each adjustment. 
The pin with the little black circle 
in the middle represents the active 
adjustment. If you want to tweak 
one of these adjustments, click on 
the little pin to make it active. 

Note that when you start a new adjustment, the sliders may be set 
to the locations you placed them for the previous adjustment. Dou-
ble-click on any one of the sliders to move it back to its default set-
ting. Double-click on the word Effect (above the adjustment sliders)
to reset all of the sliders beneath it.

The Adjustment Brush is being used to lighten the round bushes.

Click the New button when you want to 
paint in a new and different adjustment
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When you paint over your image with the Adjustment Brush, you 
will see a pin (a small circle) appear, representing the adjustment. 
If you hover your mouse over the pin, you will see an overlay of the 

area that was adjusted. If you 
would like this overlay to stay 
on, turn on the “Show Selected 
Mask Overlay” check box at the 
bottom of your image window. 
You can also use the “O” key as 
a shortcut to turn this feature 
on. You may want to turn this on 
before you even start painting. 

If you turn on the Erase setting, located be-
low the adjustment sliders, you will remove 
your adjustment instead of add to it. You 
can also switch to Erase mode by holding 
down the Option Key (Alt on Win) while us-
ing the brush. 

Below the adjustment sliders, you will see brush settings A and B. 
These just allow you to have two sets of brush settings that you can 
quickly switch between. 

Hover your cursor over one of the adjustment pins to get an overlay that shows the 
area affected by that adjustment. 

Hovering your mouse over the pin created 
by the Adjustment Brush will place an over-
lay on the painted area. To keep this overlay 
on, turn on the “Show Selected Mask Over-
lay” box below the image window. 

The Erase setting
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Auto Mask This is a setting that can make your work with the Ad-
justment Brush a bit easier. The Auto Mask check box can be found 
at the bottom of the Brush settings. 

When you turn this on, Lightroom is 
going to look at what is underneath 
the little plus sign (+) in the middle of 
the brush and try to limit the adjust-
ment to areas that are similar. This can 
be useful when painting over areas 
that have a hard edge and you want 
to prevent over-spray. Note that you 
need to be careful when you have Auto 
Mask turned on because it can create a 
blotchy look in the interior of the area 
you’re painting. What I do with this 
feature is keep it turned off while I’m 
painting the inside area of the object 
I’m painting and then turn it on when 
I get to the edges. You can also use 
the Auto Mask feature when using the 
brush in Erase mode. 

Flow When adjusting something like 
skin, you might want to use the Flow 
setting with the Adjustment Brush. 
The Flow setting allows you to con-
trol how much should be put in on 
the fir t pass of the brush. This allows 
you to pass over an area more than 
once in order to build up the effect.

The Moiré Slider One of the sliders that can be found within the 
Adjustment Brush settings is the Moiré Slider. In photographs, some 
fabrics end up with a really strange pattern that looks like two screen 
doors overlapping each other. This is a moiré pattern and this slider 
is designed to fix it. Simply use the Adjustment Brush to paint over 
the fabric and then drag the slider up until the effect goes away.

The Auto Mask setting

The Auto Mask setting helps to 
prevent over-spray when painting 
with the Adjustment Brush.

The Flow setting that goes along with 
the Adjustment Brush. 
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Adjustment Brush to counteract regular adjustments I will some-
times use the Adjustment Brush to counteract an adjustment that 
I’ve made to the image as a whole. For example, I might use the 
Highlights slider to bring all of the highlights in the image way down. 
Then, if there is an area that didn’t 
benefit from that effect, I’ll counter-
act that by looking at the Highlights 
slider setting and applying the op-
posite of that, using the Adjust-
ment Brush, to bring the Highlights 
setting in that area back to zero.  

Adjustment Brush Presets If you 
create a custom setting using the 
sliders for the Adjustment Brush, 
you can save that setting for use in 
the future. Click on the little drop-
down menu to the right of the word 
“Effect.” At the bottom of the menu, 
choose the setting called “Save Cur-
rent Settings as New Preset.” Then, 
you’ll be prompted to give the new 
preset a name and click Create. In 
the future, this new preset will be 
available in the preset menu. The Adjustment Brush Presets drop-

down menu
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THE GRADUATED FILTER
There are two other tools that work the same way as the Adjustment 
Brush but apply the adjustment in a different way. The Graduated 
Filter is one of them and it can also be found at the top of the ad-
justment panels. You can also activate it by tapping the M key. When 
active, all of the adjustment sliders pertaining to the tool will appear 
beneath the Toolbar (just like with the Adjustment Brush). 

With the Graduated Filter, you click on your picture and drag over 
the area you want to adjust. (Hold Shift to create a perfectly hori-
zontal or vertical plane.) Three lines will appear, indicating where the 
gradient will be. Any area that is outside of the fir t line is getting the 
full adjustment. Any area outside of the third line is getting no ad-
justment. In between those two lines is where the adjustment fade 
in, and it will be applied as a gradient. It will be the strongest near 
the fir t line and the weakest near the third line. You can also click 

Above: The Graduated Filter is being used to drag out a 
gradient on the image. We’ll use it to lighten everything on 
the bottom part. Right: We’re hovering our cursor over the 

adjustment pin to get an overlay that shows where the fil er 
is being applied.
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and drag on the Graduated Filter lines to adjust their positions. You 
can choose to move the adjustment sliders before and/or after you 
drag out the Graduated Filter. You can also determine whether the 
three lines representing the gradient should stay visible or disappear 
using the “Show Edit Pins” menu below the image window. I like to 
keep this menu set to Auto, which will make the lines disappear only 
when my cursor is not hovering over the image. 

Here, you can see how the Graduated Filter was used to lighten up the bottom of the 
image. After the gradient was dragged out, we lowered the contrast and increased the 
whites.
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Adding a color with the Graduated Filter In addition to the adjust-
ment sliders, you also have access to a color setting when using the 
Graduated Filter. It can be found below all of the adjustment sliders 
and it allows you to introduce a specific color into your picture using 
the fil er. Click on the color swatch and a color picker will pop up, 
allowing you to select the color you want to add.  

The Graduated Filter Brush Af-
ter you use the Graduated Filter, 
you can use the brush setting to 
add or remove the effect from 
areas outside of the adjustment 
plane. The Brush feature can be 
found at the top of the Graduat-
ed Filter sliders. 

The color picker is being used to choose a blue color that will be introduced into part 
of the sky using the Graduated Filter. 

The Brush setting for the Graduated Filter

FIX PROBLEMS THAT DON’T AFFECT THE WHOLE IMAGE  |  164



Copyright 2018 by Ben Willmore. All Rights Reserved

LIGHTROOM CLASSIC: THE COMPLETE GUIDE
FIX PROBLEMS THAT DON’T AFFECT THE WHOLE IMAGE

In the example image, we used the Graduated Filter to introduce 
more blue into the corner of the sky. This also added blue to part of 
the building and we want to remove that. We’ll activate the Graduat-
ed Filter Brush, set it to Erase using the settings beneath the sliders, 
and then paint over the area where we didn’t want the effect to be 
applied. 

Range Mask The Range 
Mask feature can be found 
at the very bottom of the 
adjustment slider panel and 
it’s also available when us-
ing the Adjustment Brush 
and the Radial Filter. The 
setting will allow you to iso-
late things based on Color 
or Luminance (brightness). 

The Graduated Filter Brush is being used to remove Graduated Filter effect from a part 
of the image. Here, we used the fil er to make the corner of the sky more blue. We are 
using the brush, set to the Erase setting, to remove the blue from the building. 

The Range Mask setting allows you to choose 
what lightness range or color range will be affect-
ed by the adjustment. 
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If you choose Lumi-
nance from the Range 
Mask menu, a slider will 
appear and you can use 
the two “knobs” on the 
slider to specify what 
brightness range the fi -
ter should affect. The 
Smoothness slider will 
control the transition. 

When you’re done using the Graduated Filter, click back on the tool 
icon to exit the tool and go back to the regular adjustment sliders. 

THE RADIAL FILTER
The Radial Filter (located next to the 
Graduated Filter) works in the same 
way as the Graduated Filter and the 
Adjustment Brush, but instead of go-
ing across a straight line or painting 
out the adjustment, you click and 
drag to define an oval shape on your image. You can then use your 
mouse to click and drag on the oval to change the size/shape. Click 
and drag on the actual pin to reposition the entire oval/circle. Then, 
dial in the setting you want using the adjustment sliders. 

By default, whatever adjustment you 
make will affect what’s outside the 
oval. If you prefer that the adjustment 
affect what’s inside the oval, click on 
the “Invert Mask” check box below 
the adjustment sliders. The Feather 
slider is located below the adjust-
ment sliders and it will determine 
how soft or abrupt the transition is. 

The range mask setting is being used to narrow the 
adjustment down so that it only affects the brightest 
areas.

The Radial Filter Tool.

Turn on the “Invert Mask” checkbox if 
you prefer the adjustment to happen 
inside of the oval. 
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Sometimes, you’ll want to apply one adjustment outside of the 
oval and another adjustment inside of the oval. You’ll have to ap-
ply two instances of the fil er in order to do this, but there’s a way 

to make sure that they are per-
fectly lined up. Make the fir t 
adjustment that will affect the 
outside of the oval. Then, right-
click on the adjustment pin and 
choose Duplicate from the menu 
that appears. Then, turn on the 
Invert check box so the new ad-
justment will affect what’s inside 
the oval and use the adjustment 
sliders accordingly. 

The Radial Filter was 
used to create an oval 
around these Gondo-
la drivers so that we 
could make adjust-
ments to only the area 
outside of the oval. 

Duplicate an adjustment by right-clicking 
on the adjustment pin and choosing Dupli-
cate from the menu that pops up.
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I do not suggest adding these images to your personal catalog (simply 
to avoid clutter). Navigate to the images via the Collections list in the 
Library Module. For each Collection, choose the related tool and then 
click the Reset button at the bottom of the options for the tool to see 
what the image looked like before the tool was used. Then experiment 
with each tool and either attempt to recreate a result shown or create 
your own interpretation of the image. 

THIS WEEK’S HOMEWORK INVOLVES A LIGHTROOM 
CATALOG FILE FULL OF CHALLENGE IMAGES. 
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DEVELOP MODULE TIPS
Apply the same adjustments on multiple images In Lightroom, you 
can make adjustments to more than one image at once. First, select 
all of the images you want to adjust within the Library module. If 
they are grouped all together, just click on the fir t image, hold the 
Shift key and then click the last image. This will select them all. 

Then decide which image you want to be viewing while making your 
adjustments and click on it once to make it the most selected. 

Click D to get to the De-
velop module and make 
sure the Auto Sync button 
is turned ON. The setting 
can be found in the bottom 
right corner of the Develop 
Module and it will either be 
set to Sync or Auto Sync. If 
it’s set to Sync, click on the 
little “light switch” to the 
left of the button and it will 
switch to Auto Sync. With 
Auto Sync turned on, Lightroom will make the adjustments on all of 
the images you have selected. If it’s turned off, it will only adjust the 
current image, the one you’re currently viewing. 

But what if you forget to turn on the Auto Sync setting? Know that 
you can still apply the adjustments you made on your current  image 
to the other selected images. To do this, click the Sync button and 
the Synchronize Settings dialog box will appear. Here, you can turn 
on the check boxes for the settings you would like to copy across all 
images. Then click Synchronize. 

There is another way to sync specific settings across images. Choose 
the image you want to copy settings FROM. Then right-click on the 
image and when the pop-up menu appears, choose Develop Set-
tings > Copy Settings. You’ll get the same dialog box with check 
boxes for all the different develop settings. Choose which settings 

Click the little switch (circled) to change the but-
ton between Sync and Auto Sync.

IMAGE ADJUSTMENT TECHNIQUES  |  171



Copyright 2018 by Ben Willmore. All Rights Reserved

LIGHTROOM CLASSIC: THE COMPLETE GUIDE
IMAGE ADJUSTMENT TECHNIQUES

you would like to copy and then click the Copy button. Next, select 
the images you want to copy the settings TO, right click your on 
your mouse and choose Develop Settings > Paste Settings. 

If you’d like to apply the adjustment settings from the image you 
most recently adjusted and copy them to another image, open the 
other image in the Develop Module and click the Previous button in 
the bottom right. 

Snapshots In the Develop module, there is a tab within the panel on 
the left side called Snapshots. A Snapshot saves the current state 
of your image so that you can go back to it again. It’s also useful for 
creating different versions of the same image. Once you’ve applied 
adjustments to your image and you would like to save those set-
tings, click the plus symbol (+) at the top of the Snapshots tab. You’ll 
be prompted to give the Snapshot a name, and then it will appear in 
that tab so that you can click on it later to return to the current state 
of your adjustments. 

In the Synchronize Settings dialog, turn on all the check boxes for the settings you’d 
like to sync between images. Use the buttons in the lower left to automatically turn all 
of the check boxes on or off.
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When you create a Snapshot, in your Lightroom Catalog fil , a sep-
arate set of instructions is created with the name of the Snapshot.

If you right-click on the name of a 
Snapshot, a menu will give you some 
options. You can delete or rename the 
Snapshot and you can also update 
the Snapshot with the image’s current 
settings. You can have as many Snap-
shots as you’d like for an image. Note 
that when you look at your images in 
Grid view, you will only see one varia-
tion of the image. You will have to return to the Develop module and 
click through the different variations within the Snapshot area. 

I like to use Snapshots to create different crop options for an image 
or to show the progression of an image as it goes through the edit-
ing process. 

A new Snapshot can be added by clicking the + button on the Snapshots tab.

Right-click on the name of a Snap-
shot to get more options.

IMAGE ADJUSTMENT TECHNIQUES  |  173



Copyright 2018 by Ben Willmore. All Rights Reserved

LIGHTROOM CLASSIC: THE COMPLETE GUIDE
IMAGE ADJUSTMENT TECHNIQUES

Sharpening & Noise Reduction Noise is another artifact that can 
crop up in your image, and it looks like a sandy, grainy kind of ef-
fect that can be monochromatic or colored. Noise is something 
that can appear as a result of shooting at a high ISO or from light-
ening up the shadow areas in your image. As you get into the dark-
er areas of your picture, the camera captures more noise, so when 
you lighten those shadows, you can see it much more easily.

To correct for this, go to the Detail 
Tab in Lightroom’s Develop mod-
ule. In the Detail tab, you will find
the settings for Noise Reduction 
and Sharpening. We are actually 
going to start with the sharpening 
settings. By default, Lightroom ap-
plies a certain amount of sharpen-
ing to every image. Sharpening will, 
however, accentuate the noise. We 
want the sharpening to be applied 
only to areas of the image where it 
will be beneficial, and not to areas 
where it may cause more noise or 
other unwanted artifact.

To control where the sharpening will be applied, we’re going to use 
the Masking slider. When Masking is set to 0, everything in your 
image is sharpened. As you bring up this slider, it’s going to sharp-
en less and less of the image, but in order to see exactly where 
the sharpening will happen, you’ll want to hold down the Option 
key (Alt on Win) as you click and drag on the slider. If the slider is 
pushed all the way to the left, the view will be white and that means 
that everything in your image is being sharpened. As you drag that 
slider to the right, more and more black will appear in your view. 
In this view, anything that is white will be fully sharpened, anything 
that’s black will not be sharpened at all and anything that’s gray 
will be partially sharpened. Move the slider up until all the areas 
without usable detail in the image turn black. 

The settings for Noise and Sharpening 
can be found within the Detail tab in 
Lightroom’s Develop module. 
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Now we’ll go down to the area called Noise Reduction. Here, we’ll 
focus on the two sliders called Luminance and Color. The Color 
slider is for noise that looks like multi-colored specks. If this is the 
kind of noise you have, you’ll want to work with this slider. The Lu-
minance slider deals with specks that just vary in brightness. You’ll 
find that this is more common than color noise. The trick here is 
increasing the slider amount enough that is reduces the noise, but 
not so much that it removes too much detail, making the image 
look soft. The Detail slider (directly below the Luminance slider) 
limits how much the slider above can affect the picture. I like to 
keep this at the highest setting that doesn’t bring the noise back. 
After adjusting the Luminance slider, try bringing the Luminance 
Detail slider all the way up and then gradually bringing it down 
again so see where that sweet spot is. The Contrast slider adds 
contrast back into the image so that it feels like it has a bit more 
detail.

Holding down the Option key (Alt on Win) will change the view of your image as you 
drag the Masking slider. It will help you better visualize what areas of your image are 
being sharpened. 
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Sometimes, when you bright-
en the dark areas of an image 
and then apply noise reduction, 
you get some blotchy color ar-
tifact (see screen shot). When 
you get this negative effect, ex-
periment with the Smoothness 
slider, which is at the bottom of 
the Detail tab. This sometimes 
does a good job at smoothing 
that out. 

Another issue you might have when applying noise reduction is that 
the colors start to blur together in areas where there is fine detail. In 
this instance, you would turn to the Detail slider. This slider tries to 
create a more distinct difference in color between things. You just 
don’t want to bring this up so high that the noise reduction is re-
duced. 

Additional Sharpening Tips: The Radius slider controls how much 
space is used by the sharpening. When sharpening is applied, it puts 
a little halo around the edges of detailed areas in the image. The 
Radius slider determines how wide the halo will be and how far the 
sharpening should extend. Hold down the Option key (Alt on Win) 
while dragging the Radius slider and you will get a view of your 
image that better shows you how much the slider is affecting the 
image. If you hold down the Option key (Alt on Win) while dragging 
the Amount slider, your image will temporarily become black and 
white. This can better help you evaluate the sharpness of your im-
age. Release the Option key and it will go back to normal. 

When working with sharpening and noise reduction, it is best to use 
a zoomed-in view of your image. (1:1 or larger) This will better help 
you to see how the sliders are affecting the fine details in the image.

An instance when you may want to try 
using the Smoothness slider to correct 
for the blotchy color.
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CORRECTING LENS DISTORTION
Different lens situations can cre-
ate some distortion in our im-
ages. With some, it’s intentional, 
as in the case of a fish ye. With 
others it’s unintentional and it’s 
something you’ll want to correct. 
To fix this kind of distortion, we’ll 
turn to the Lens Corrections tab 
on the right side of Lightroom’s 
Develop module. 

The fir t setting to turn to is the 
Enable Profile Corrections check 
box. This will cause Lightroom to 
correct for distortion based on 
the specific lens you have, and 
it often times does an amazing 
job! Note that it’s not going to 
be able to do that for every lens, 
and that’s because Lightroom needs the specific profile for your 
lens. If it doesn’t have that, it won’t know what formula to use. To 
specify the lens profil , click on the Profile category at the top of 
the Lens Corrections tab and you will find categories for the Make, 
Model and Profiles for the lens. You generally don’t have to change 
these settings because the information about your lens will already 
be contained in your metadata. Note that the Profile Corrections 
setting also tries to correct for any vignetting caused by the lens. 

Amount Sliders When you think about what we use a Lens Profile
for, it’s to correct for distortion and to brighten the corners of your 
image (most lenses can deliver more light to the center of your 
image than it can to the corners). If you ever want to lessen or in-
crease either of those corrections when applying a lens profil , use 
the Amount sliders at the bottom of the Profile section of the Lens 
Corrections tab. 

The Lens Corrections panel in Lightroom’s 
Develop Module
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Chromatic Aberration Within the Profile category of the Lens Cor-
rections tab, there is a check box called “Remove Chromatic Aber-
ration.” Chromatic aberration is an artifact that can appear in areas 
of high contrast in your image such as where a roof or a tree meets 
a bright sky. They appear as colored halos around those high-con-
trast areas. To correct for this, turn on this checkbox. 

The Enable Profile orrections setting was used to correct for the distortion in this 
image. This is a rather extreme example, as it was shot with a fish ye lens.

Left: You can see 
the colored halo 
artifact, known as 
chromatic  
aberration. 

Right: The image, 
after the Remove 
Chromatic Aber-
ration check box 
was turned on.
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The Lens Corrections panel is divided into two sections, Profile and 
Manual, and you can click between the two at the top of the pan-
el. The Profile settings (the ones we’ve covered so far) are based 
on Adobe’s testing of each individual lens. If these setting are not 
enough, or are not working to your liking, switch to the Manual 
settings. Within the Manual area, the Defringe settings allow you 
to manually correct for chromatic aberration. Click on the Defringe 
eyedropper and use it to click on the colored halo (chromatic aber-
ration) on your image. Note that you’ll need to be zoomed in really 
close. When you click on the artifact, the Defringe sliders will auto-
matically be moved, defining the range of color that it found when 
you clicked. The Manual settings in the Lens Corrections panel also 
include sliders for manually controlling how much the image is dis-
torted and how much vignetting there is.

Left: The Manual settings in the Lens Cor-
rections panel. Above: The Defringe eye-
dropper is being used to click on an area 
with chromatic aberration.
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Upright Another type of distortion 
can occur if you photograph some-
thing that has horizontal and/or ver-
tical lines and you are shooting from 
an angle. An example would be if you 
tilt your camera up when shooting a 
building or something with tall, ver-
tical edges. The distortion will make 
it look like the vertical lines are mov-
ing toward each other, as if they are 
going to converge. To correct for 
this, you can use the Upright settings 
within Lightroom’s Transform panel. 

Start with the buttons at the top of 
the Transform panel. Let’s look at 
what they do:

• Auto: This setting will look for vertical or horizontal lines and, if
it thinks they’re converging, it will try to correct for it.

• Level: This setting will only look at horizontal lines and try to
make them perfectly horizontal. It will leave vertical lines alone.

• Vertical: This will look at only the vertical lines and try to make
them perfectly vertical. It will ignore horizontal lines.

The distortion in the above image was caused by shooting the scene at an angle. It was 
corrected using the Upright settings. 

The Transform panel
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• Full: This option looks at both horizontal and vertical lines, try-
ing to make them all straight.

• Guided: For ultimate control, use
this setting. When you click the
Guided button, you will manual-
ly drag out lines that represent
what’s supposed to be horizontal
and/or vertical. Hover your mouse
over the image and the cursor will
turn into a crosshair. It will also give
you a zoomed up view of precise-
ly what you’re clicking on. Click on
the end of a line that you want to
straighten and drag along the line,
releasing the mouse button after
you’ve created a guide that match-
es the line. Do the same thing with
another line somewhere else in
your image. You are basically tell-
ing Lightroom what is supposed
to be perfectly horizontal or per-
fectly vertical. After dragging out
the second line, Lightroom will
attempt to straighten the image.
You can drag out a maximum of
two horizontal lines and two verti-
cal lines using this tool.

After Lightroom attempts to correct for the distortion, you may end 
up with empty canvas area on the edges of the frame. In this case, 
I would click on the Crop Tool to eliminate that. When the Crop 
Tool is active, a “Constrain to Image” check box will appear within 
the tool’s settings. Turning this check box on will crop the image to 
the largest possible rectangle that won’t include and empty white 
space. 

The Guided Upright tool is being 
used to drag out a line on something 
that’s supposed to be vertical. 
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The Transform sliders can also help to correct for distortion and I 
will usually turn to these if I need to correct any negative effects 
after using the Guided tool. Let’s look at what they do:

• X Offset: M ves image left or right within the frame

• Y Offset: M ves image up or down within the frame

• Scale: Makes image larger or smaller within the frame. Making it
smaller will introduce white space around the edges.

• Aspect: After correcting for distortion, objects can sometimes
tend to look stretched. If this is the case, the Aspect slider can
be used to narrow or lengthen the image.

• Rotate: Simply rotates the image

• Vertical: Tilts the image up and down

• Horizontal: Tilts the image left and right

After correcting for the distortion, we ended up with empty space around the edges. 
In this case, we would use the Crop Tool to eliminate the white areas.
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I do not suggest adding these images to your personal catalog (simply 
to avoid clutter). Choose File>Open Catalog and point Lightroom to 
the associated catalog file, then navigate to the images via the Collec-
tions list in the Library Module. Many of the images will already have 
the features incorporated into the image. When that is the case, dou-
ble-click on the heading above each set of sliders to reset all related 
sliders to zero before experimenting with each feature. If you’d like to 
start from scratch, then click the Reset button in the lower right of the 
develop module. 

THIS WEEK’S HOMEWORK INVOLVES A LIGHTROOM 
CATALOG FILE FULL OF EXAMPLE IMAGES. 
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THE HISTOGRAM
The Histogram is located in 
the top right corner of Light-
room’s Develop Module. It is 
basically designed to tell you 
how bright the various areas 
in the image are. The blacks 
are represented on the far 
left side of the chart. If there 
is a bar on the far left side, it 
means that there are blacks 
in the image. The middle of 
the chart represents 50% 
gray, so if there are bars 
there, you know that you 
have 50% gray tones in the 
image. The right side of the 
chart represents white.  

For every image, the histo-
gram will always have one 
line that goes all the way to 
the top. That is the shade 
that takes up the most space 
in the image. The heights of 
the other bars in the histo-
gram will be based on how 
much of each shade there is 
in relation to the shade that 
takes up the most space.  

It’s important to know that there is no “right” or “perfect” histogram. 
It’s just a tool that gives you information about your picture. One of 
the main things I use the histogram for is determining whether I truly 
have blacks and whites in my image. 

Lightroom’s histogram tells you how much of 
each tone is in your image. In this histogram, we 
can tell that there are no whites in the image 
because there is a gap on the right side, which is 
the side that represents the whites.

The spike on the left side of the histogram tells 
us that black is the tone that takes up the most 
space in the image. 
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The Lightroom histogram not only gives you information about the 
tones in your image, but it also provides color information as well. 
There are both gray bars and colored bars in the chart, and in the ar-
eas where the colors closely line up with the grays, there will be little 
to no color in the image. In the areas where the color spikes separate 
from the gray bars, you know that there is a good amount of color. If 
there is a color spike on the left side of the histogram, you know that 
there is a lot of color in the shadow areas of the image. 

How Adjustments Affect the Histogram 
Let’s look at how the histogram will shift 
to reflect the changes you make in the 
Basic panel. Because the Exposure slider 
affects the overall brightness of the im-
age, this slider will move the entire his-
togram. Increasing the Exposure setting 
will shift the entire histogram over to the 
right. Decreasing Exposure will shift it to 
the left. 

The Contrast slider will make the  his-
togram wider or narrower. Increasing 
Contrast will cause the chart to spread 
apart, forcing the bars on the right side 
farther right and forcing the bars on the 
left side farther left. Decreasing Contrast 
will cause the histogram bars to move to-
ward the center of the chart. 

The Whites and Blacks sliders will affect 
the right and left sides of the histogram. 
Dragging the Whites slider to the right 
will push more and more bars over to the 
right side of the histogram. If there are no whites in the image and 
you want there to be whites, use the Whites slider and move it to 
the right until the bars extend to the far right side of the histogram. 
Moving the Blacks slider to the left will push more and more bars 
over to the black side of the histogram. 

Moving the sliders in the Basic 
panel will cause the histogram 
to shift. Here, we’re dragging the 
Whites slider to the right and it’s 
forcing more bars to the right 
side of the histogram.
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HSL IN LIGHTROOM
HSL stands for Hue, Saturation & Lu-
minance and you can define a color 
using those three things. You can use 
the sliders to adjust each color individ-
ually.  The HSL tab can be found in the 
right adjustment panel in Lightroom’s 
Develop module. There is a separate 
section for Hue, Saturation and Lumi-
nance. 

Hue: The basic color; The Hue slid-
ers will actually shift the colors.

Saturation: How colorful it is; The 
Saturation sliders will make the  in-
dividual colors more or less colorful. 

Luminance: The color’s lightness; 
Use these sliders to individually 
work with the brightness of each in-
dividual color.

Within each section of the HSL tab, there are sliders for all the in-
dividual colors and these allow you to isolate one color and adjust 
it independently of the rest of the image. For example, if you are in 
the Saturation section and you drag the blue slider to the right, the 
blues in your image will become more colorful. If you drag it to the 
left, the blues will become less colorful. 

The Targeted Adjustment Tool This is a feature that you’ll find in 
each section of the HSL tab and it looks like a little circular donut 
in the upper left. When you click on this icon to turn the feature on, 
Lightroom will figu e out which sliders should be moved when you 
move your mouse on top of your picture and then click on some-
thing. For example, if you are in the Luminance section and you 
activate the Targeted Adjustment Tool, if you click and drag up on 
an area of your image that is red, all parts of the image with that 
same red will become brighter. If you drag down, those areas will 

The HSL panel in Lightroom’s 
Develop Module is split into three 
sets of sliders: Hue sliders, Satura-
tion sliders and Luminance sliders. 
Switch between them by clicking 
on the categories at the top of the 
HSL panel. 
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become darker. You will see that Lightroom automatically moves 
the sliders for you when the Targeted Adjustment Tool is used, and 
it will sometimes have to use more than one slider at a time in order 
to target the exact color you clicked on.

If you use the Targeted Adjustment Tool with the Hue setting, then 
it will actually shift the colors. If you use it with the Saturation set-
ting, it will make the area more or less colorful. 

Note that when you use the Luminance sliders to darken certain 
colors, those colors may also become more saturated. That’s just 
something that can happen when we make colors darker. Because 
of this, you might have to go in and fine tune the Saturation sliders 
for those colors as well. 

If you would like to see a before and 
after view (and this goes for any of 
the adjustment tabs in the Devel-
op module), just click on the little 
“switch” (see screen shot) in the up-
per left corner of the tab.

The targeted adjustment tool is being used to change the hue of the stack of hats. We 
are clicking and dragging up and down on the image and Lightroom detects that there 
are both yellows and greens in the area, so it is moving both of those color sliders 
simultaneously. 

Toggle this switch to temporarily 
disable the adjustments made in the 
panel below.
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You can also use the HSL section to create a selective color effect. 
To do this, you would work with the sliders in the Saturation section 
and drag all of them to the left except for the one color you want to 
isolate. For example, if you have a picture of a red car (and it’s the 
only red thing in the photo), you can drag the Saturation sliders all 
the way to the left for every color except red. That way, the car is 
the only thing in the image that’s not black and white. 

I find that I often times need to use this panel to adjust the greens 
in an image with trees or grass. Because greenery can sometimes 
look too yellow and/or too saturated, I will use the Green Hue slider 
and drag it to the right, toward green and away from yellow. The 
greens usually end up looking too saturated at this point, so I’ll 
then drag the Green Saturation slider down to compensate. Lastly, 
I’ll lower the Green Luminance slider. 

Here, the HSL sliders were used 
to create a selective color effect. 
In order to make this blue vehicle 
pop, the Saturation sliders were 
dragged all the way down for every 
color except blue and purple (there 
were some hints of purple in the 
reflection ). 
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In the top image, the 
mountains looked overly 
blue. We fi ed this by 
dragging down the Blue 
Saturation slider.

Above, you can see a before (left) and after (right) view, where we used the HSL sliders 
to adjust the greens. To achieve this result, the Green Hue slider was moved to the right, 
the Green Saturation slider was lowered and the green Luminance slider was lowered.
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The HSL panel usually displays one set of sliders at a time. You’re 
either looking at the Hue sliders, the Saturation sliders or the Lumi-
nance sliders. There is a way to view them all at once (stacked on 
top of each other vertically) and that is by clicking on the word “All”  
in the top right corner of the HSL panel.

The Color tab, which is grouped 
with the HSL tab, gives you anoth-
er way of working with the HSL 
adjustments. In this tab, each color 
appears as a swatch along the top. 
Click on one of them and the three 
sliders (Hue, Saturation and Lumi-
nance) for that color will appear 
below. 

EFFECTS
The fir t feature under Effects is 
called Post-Crop Vignetting. A vi-
gnette essentially darkens the out-
er edges of an image.  Note that  
a vignetting setting can also be 
found in the Lens Corrections area. 

The settings that are found under 
the Lens Corrections tab are de-
signed to compensate for things 
that your lens did to the image. 
Lenses will often times deliver less 
light to the corners of the frame 
than to the center. When you use 
the vignetting feature in the Lens 
Corrections area, it’s going to ap-
ply the adjustment to the corners 

The Color tab gives you a different way 
of working with the HSL sliders. 

The Effects tab in Lightroom’s Develop 
module
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of the original image, what your lens actually captured. This is dif-
ferent from how the Post-Crop Vignetting settings work. Just as 
the name implies, the Post-Crop Vignette will apply the vignette 
effect to the cropped image, not the original image. When we use 
this feature, we generally intend to add an effect, not make a cor-
rection. 

When you darken the edges of your image, it naturally draws the 
viewer’s eye toward the center, closer to where your subject is. 

Let’s look at the sliders within the Post-Crop Vignette settings: 

Amount: This slider is the main control for the effect. Bringing this 
down will darken the edges. Bringing it up will brighten the edges.

Midpoint: This slider determines how far toward the middle of the 
image the effect can extend. Tip: If you hold down the Option Key 
(Alt on Win) while dragging the slider, it will act as if the Amount 
slider is maxed out. This will make it much easier to tell where the 
adjustment is being made. 

Roundness: This determines whether the effect is more round or 
more rectangular. Again, you can hold down the Option Key to get 
a temporary view of what it would look like with the Amount set-
ting all the way up. 

Here, you can see the view of an image as we 
are cropping it. The red circles indicate where 
a Lens Corrections vignette would be applied. 
The green circles indicate where a Post-Crop 
Vignette would be applied. 
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Feather: The Feather slider determines how soft the edge is. Do 
you want a crisp transition or do you want it fade out toward the 
middle?

Highlights: This slider prevents bright areas near the edge of your 
picture from being darkened.

Style: At the top of the Post-Crop Vignette settings, there is a 
drop-down menu called “Style.” This will control how the vignette 
is rendered. 

Highlight priority: Useful if you have very bright areas near the 
edge of your photo because it will protect them from looking 
unnatural.

Color Priority: Blends the colors and looks the most natural. I 
usually use this setting, unless I happen to have something bright, 
like the sun, near the edge of my image. 

Paint Overlay: This is like putting black ink around the edges of 
your image. The darkness doesn’t blend into the image as much 
and for this reason, I never use this setting. (It’s there because it’s 
how the old version of the Vignette effect used to work.)

The before and 
after view when 
using the Post-
Crop Vignette 
settings. Notice 
how the eye 
is more easily 
drawn to the 
center of the 
frame in the im-
age on the right.
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Radial Filter for Vignetting The Radial 
Filter provides another method of apply-
ing post-crop vignetting, and it actually 
gives you more control because you can 
choose exactly where the vignette is ap-
plied. The Radial Filter can be found in the 
Toolbar directly beneath the Histogram 
in the Develop Module. Click on the icon 
to activate the tool and a series of sliders 
will appear that allow you to decide how 
the fil er will be affecting the image. 

When activated, use the Radial Filter to 
click and drag on your picture to define
the area you want to work on. It will be 
a circular, or oval, shape. Tip: If you hold 
down the Command key (Ctrl on Win) 
and double-click on the image, it will au-
tomatically create an oval that extends to 
all four edges of the frame.

By default, the adjustments/effects are going to be applied outside 
of this oval. Use the Feather slider at the bottom of the adjustment 
sliders to determine how soft of a transition there will be between 
the inside and outside of the oval.

When the Radial Filter is ac-
tive, the sliders that go along 
with it will appear below.

The Radial Filter was 
used to drag out an 
oval on this image.  

By default, the  
adjustments will be 

applied to everything 
outside of the oval.
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Use the adjustment sliders on the right to create the vignette. This 
can be done with any combination of the sliders that affect tone. 
I move the Exposure and Highlights sliders down (to the left) until 
I’m happy with the darkening effect. 

There are now a couple ways to fine-tune the area where the dark-
ening effect is happening. You can drag the sides of the oval to 
change the size and shape. By default, if you drag one side of the 
oval, the opposite side will move with it. If you want to move one 
side independently of the other, hold down the Option key (Alt on 
Win) while you click and drag. The Radial Filter Brush also gives 
you control over where the effect is applied and you can activate 
it by clicking the Brush button above the adjustment sliders. When 
the Brush is active, scroll down below the adjustment sliders and 
turn on the Erase setting. This will allow you to use the brush to 
erase the darkening effect on very specific areas of the image. This 
can be very useful when part of the main subject extends close to 
the edge of the frame (where the vignette is) and you don’t want 
them to be darkened.

The Brush feature is being used to erase the effect created by the Radial Filter in a 
specific a ea.
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SPLIT TONING
Split toning is another way 
we can fine-tune the color 
in our images. The tech-
nique allows you to force 
color into the bright and/or 
dark parts of your picture. 
Whenever I get an image 
that has very different sub-
ject matter for the bright 
areas and the dark areas, I 
consider using a split tone 
effect on it.

The Split Toning tab can also be found on the right panel in Ligh-
room’s Develop module. There are a set of sliders for the Highlights 
and a set of sliders for the Shadows. This allows us to add one color 
to the highlights and a different color to the shadows of our image. 

You will use the Hue slider under the Highlights to choose a color to 
add to your highlights. Note that you will see no difference in your 
image when you move this slider if the Saturation slider is set to 0. 
There is a trick for getting a preview of what color you are apply-
ing though. If you hold down the Option key (Alt on Win), you will 
get a view of what your image would look like with the Saturation 
slider set to 100. This will be overkill, of course, but it will give you 
a good idea of the color you are choosing. Then you can move the 
Saturation slider up (for real this time) to slowly add your selected 
color in to the highlights of the image. You will do the same thing 
to add a different color into the shadows of your image. 

If you don’t like working with the Split Toning sliders, there is a dif-
ferent way to select the colors. If you use the little triangles to the 
right of the shadows and highlights sliders to collapse the sliders, 
you will only see the rectangular color patch. If you click on it, you’ll 
get a color picker and you can use that to choose the color you’d 
like to add to the highlights and shadows. 

Lightroom’s Split Toning panel
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The Balance slider controls where the highlights end and where 
shadows begin. Again, you can hold the Option key (Alt on Win) 
to get a view of what it would look like with Saturation set to 100.

Click on one of 
the color swatch-
es and a color 
picker will appear, 
giving you an-
other method of 
selecting a color.

The color effect 
you can see at 
left was created 
using the Split 
Toning panel. In 
the screen shot 
below, you can 
see that a yellow/
orange hue was 
added to the 
highlights and a 
purple hue was 
added to the 
shadows.
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Split Toning to Correct a Blue Cast The Split Toning settings can 
also be used to correct for over-exaggerated blues (which could 
possibly be a result of the Vibrance slider). Blues especially tend 
to appear too intense in areas that have a lot of shade. To correct 
for this, use the Shadows settings under the Split Toning tab and 
introduce more yellows into the shadows. (Yellow is the opposite 
of blue and will therefore tone down the blue hue.) 

Split Toning for Black and White Images Split Toning is great to 
apply to black and white images to give them a little more depth 
and interest. When doing this, you don’t have to apply a color to 
both the highlights and the shadows. Sometimes I apply a warm 
color to the shadows and cool color to the highlights, or sometimes 
I just apply a color to the shadows and leave the highlights alone. 

The Split Toning settings were 
used to add interest to this black 
and white image. A blue tone was 
pushed into the shadow areas and 
the highlights were left as is.
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CURVES
The Curves adjustment provides an-
other method of fine-tuning imag-
es in Lightroom. Know that Curves 
in Lightroom is nowhere near as 
powerful as Curves in Photoshop. 
In Photoshop, Curves can be used 
as adjustment layers, which allow 
us to work with a mask. 

I find that I turn to the Lightroom 
Tone Curve panel when I have 
maxed out one of my toning sliders 
in the Basic panel and I still want to 
take that adjustment further. 

In Lightroom’s Tone Curve panel, 
there is a Point Curve and a Para-
metric Curve. The Point Curve al-
lows you to drag dots/points right 
on the curve. With the Parametric 
Curve, you manipulate the shape 
of the curve using sliders. Switch 
between the Point Curve and the 
Parametric curve by clicking on the 
little icon to the right of the Point Curve menu at the bottom of the 
panel. The Point Curve menu gives you different presets for how 
the curve should be adjusted. Choosing the Linear option from this 
menu will return the curve to its default setting. 

The Parametric Curve  When using the Parametric Curve, there are 
four sliders to work with. The Highlights and Shadows sliders will 
limit the adjustment to the lightest and darkest areas and they work 
in a similar way to the Highlights and Shadows sliders in the Basic 
panel. The Lights and Darks sliders work on a larger tonal range, 
affecting the highlights and shadows but also extending into the 
mid-tones. 

The Tone Curve panel in Lightroom. 
Switch between using the Parametric 
Curve (shown) and the Point Curve by 
clicking on the circled icon. 
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Below the curve chart, there are three sliders and you can use these 
to define what is considered a highlight or a shadow. Drag the white 
slider to the right and less of the tonal range will be considered high-
lights and the Highlights slider below will adjust accordingly. 

The Tone Curve has a 
direct adjustment tool 
that looks like a little do-
nut in the upper left cor-
ner of the panel. After 
you click on it to make 
it active, use it to click 
and drag up or down 
within your image. It will 
target the tone that is 
directly beneath your 
cursor, making it light-
er or darker as you drag 
up or down. The sliders 
will automatically adjust 
accordingly. 

The Point Curve When working with the Point Curve, I like to set 
the dropdown menu to Linear so that I’m starting from zero, with 
no adjustment already applied. This curve is essentially telling you 
how much light will be used to reproduce your image. The left side 
represents the blacks, and that is why the line is all the way at the 
bottom on the left. No light is required to produce black. As you 
move toward the right, you’re working with brighter and brighter 
shades. Halfway across the curve, it’s thinking about 50% gray and 
that’s why the line is exactly at the midpoint here. The far right side 
represents white, and that’s why the curve is at the very top. It takes 
the maximum amount of light to produce white.  

Click on the curve to drag it up or down and the result is similar 
to using a dimmer switch. Push it up and you will add light. Push it 
down to remove light. 

Using the Para-
metric Curve 
settings, the 
Shadows slider 
is being moved 
to the left and 
you can see the 
coordinating 
range on the 
curve being 
moved down to 
make that tonal 
range darker.
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The Point Curve also has the little 
donut icon in the upper left. When 
active, you can click on your image 
and a point will be added to the 
curve, representing the tone that 
you clicked on. Drag up or down to 
move the point up or down on the 
curve, therefore affecting the bright-
ness of the targeted tonal range. To 
get rid of a point on the curve, right 
click on it and choose Delete Control 
Point from the pop-up menu.

Points were added to the curve and 
then moved up and down to affect 
the targeted tones.
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I do not suggest adding these images to your personal catalog (simply 
to avoid clutter). Choose File>Open Catalog and point Lightroom to 
the associated catalog file, then navigate to the images via the Collec-
tions list in the Library Module. Many of the images will already have 
the features incorporated into the image. When that is the case, dou-
ble-click on the heading above each set of sliders to reset all related 
sliders to zero before experimenting with each feature. If you’d like to 
start from scratch, then click the Reset button in the lower right of the 
develop module. 

THIS WEEK’S HOMEWORK INVOLVES A LIGHTROOM 
CATALOG FILE FULL OF EXAMPLE IMAGES. 
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VIEW YOUR IMAGES ON THE MAP
Lightroom’s Map Module allows us to view our images on a map. 
In order to get our images to appear on the map, Lightroom must 
have information about where they were captured. We’ll start with 
an overview of the Map Module and then cover how to get our im-
ages on the map. 

Map Module Overview
You can access the Map module by clicking on it in the upper right 
of Lightroom’s interface. In order to get the map, you will have to 
be on the Internet so that Lightroom can access Google’s map sys-
tem. 

When the map appears, you will see pins for all the images in your 
selected folder that have GPS data attached to them. If there is no 
GPS data on your images, then you won’t see any pins. But that’s 
ok. Lightroom allows you to manually enter in location information 
for all of your images. When looking at your pins on the map, you’ll 

In Lightroom’s Map Module, you will see pins representing all of the images that have 
been tagged with GPS data. 
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notice that some (or most) of them 
will have numbers on them. The 
numbers indicate how many images 
were shot in that location.  You can 
zoom in and out on the map by us-
ing the slider below the map window 
or by using the + and - keys on your 
keyboard. To move around within 
the map view, you can just click and 
drag with your mouse. 

To zoom in on a specific area, hold 
down the Option Key (Alt on Win) 
and draw out a box around the area 
you want to fill your screen. When 
you let go, the map will zoom to the 
area you just selected. 

When you hover your 
mouse over one of the pins 
on the map, an image box 
will pop up that shows you 
a thumbnail for an image 
that was shot in that lo-
cation. If more than one 
image was shot in that lo-
cation, then you will see a 
little arrow on the right side 
of the thumbnail. You can 
click on this arrow to cycle 
through the different imag-
es that were shot there. 

When you look at the pins on your map, you might notice that some 
of them are rounded-corner rectangles and some of them have a 
little pinpoint sticking out of them. The ones that are rounded-cor-
ner rectangles are marking images that were spread out over a 
larger location. If you zoom in on those, you these pins will split up 

You can either use this slider or the 
+ and - keys to zoom in and out on
the map.

To zoom in on a specific a ea, hold 
down the Option Key (Alt on Win) 
and then drag out a box on the area. 

If more than one image was shot in a location, 
you can click on the right-arrow button to cy-
cle through the different image thumbnails.
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into multiple pins with more refined locations. The pins that have a 
little point coming out of them indicate that the image[s] were all 
shot in one specific loc tion. 

To see a guide that lists what all the little symbols mean, go to the 
main menu and choose View > Show Map Key. If you no longer 
need the key, click the little X in the upper right to make it go away. 

If you click on one of the photos on the bottom of the screen, it will 
highlight the pin for that image on the map. 

There is a search field in the top right of the Map interface, and you 
can use this to type in a specific location. Lightroom will then zoom 
to that location on the map and show you pins for any images that 
were shot there. Remember, you have to be connected to the Inter-
net for this to work.  

On the left side of the in-
terface, you’ll find an area 
for Saved Locations and 
this is for locations that 
you frequently shoot at 
or want to be able to view 
quickly. Save a location by 
navigating to the location 
on the map and then click-

Left: Some of the markers have pins coming out of them (like the one on the left) 
and others don’t. If there is not a pin coming out of the marker, it means that the 
images are spread out over a larger location. Right: The map key.

The Saved 
Locations tab  
can be found 

on the left 
side of the 

Map Module.
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ing the little plus icon (+) at the top right of the Saved Locations 
tab. A location circle will appear on the map and a dialog box will 
appear where you can give the location a name and drag the slider 
left and right to specify the radius of the location. As you drag the 
slider left and right, you will see the radius get bigger and smaller 
on the map. Click the Create button and that location will show up 
within the Saved Locations panel. The number to the right of the 
location indicates how many images fall within that location radius. 

Getting your Images to Appear on the Map
Geotagging Images Some cameras 
have a built-in GPS feature, which 
means that location data is auto-
matically in recorded in your images’ 
metadata. There are also accessories 
that will attach to your camera and 
tag your images with your shooting 
locations. 

If you don’t have a camera or acces-
sory that records GPS data, you can 

When you save a location, you can specify how large you want the radius to be. 

This Canon GPS Receiver GP-E2 is 
an example of one of the devices 
that can attach GPS data to your 
images.
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also use your phone to record your location. Some camera makes 
have phone apps that communicate with the camera, using the 
phone’s GPS data to tag the images shot with your camera.

There are also apps for 
creating a tracklog, which 
will record your location 
once a minute. You just 
need to make sure that 
it can record in GPX for-
mat and that the clock 
on your camera matches 
the clock on your phone. 
Then, you can load that 
tracklog into Lightroom 
and it will add the loca-
tions based on your time 
stamps. To load a track 
log, click on the icon within the Toolbar at the bottom of the Map 
Module and choose Load Tracklog from the menu that pops up. 

Manually Placing Images on the Map If your images are not al-
ready tagged with GPS data, you can still place them on the map 
manually. First select the folder or collection of images that you’d 
like to place on the map and then move to the Map module. 

Now, use the search box in the upper right to enter in the location 
of the fir t image you want to tag. You can be more general and 
enter in something like San Francisco or you can be specific and 
type in something like Coit Tower. Once Lightroom moves the map 
to that location, you can still zoom in and out and drag around 
the map to find the precise location you’re looking for. Then, drag 
the image up to that location on the map. When you let go of the 
mouse button, Lightroom will create a pin for that image on the 
map. 

Note that if you’re having a hard time figuring out where an image 
was shot, you can use the menu below the map, on the left, to 
switch to satellite view, which might give you a better view. 

Click the icon shown to load 
a tracklog for tagging your 
location data.
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After you have tagged an image with location data, those coordi-
nates will be saved within the image’s metadata. Viewing the im-
age in the Library Module, you can find the Metadata panel on the 
right side of the interface. Scroll down and you’ll find the GPS in-
formation.

You can drag an image onto a precise location on the map.

The GPS coordinates 
are displayed within the 
Metadata panel on the 
right side of Lightroom’s 
Library Module. 
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FACIAL RECOGNITION
In Lightroom, it is not uncommon that you’ll need to search for im-
ages with specific people in them. Because of that, it’s very useful 
to include people’s names in your keywording process. Then, you 
can use the Filter Bar, using the Text option, and search for a per-
son’s name.

Lightroom has made it extremely 
easy to keyword images with people 
in them by including a feature called 
Facial Recognition. The Facial Rec-
ognition button (see screen shot) 
is located in the Tool Bar below the 
main image window in Lightroom. 
Note: If the Tool Bar is not visible on 
your screen, click on the View menu 
and select “Show Toolbar.” 

When you click the Facial Recognition button (the little face icon), 
you will be given the option to search for faces in your entire cata-
log (this might take a while) or to only search for faces in the fold-
er you’re looking at. With this second option, Lightroom will only 
search for faces in the current folder and when you ask it to do the 
search. In the class demonstration, we’re going to choose the sec-
ond option, “Only Find Faces As-Needed.” 

As Lightroom searches for 
faces, you will see a prog-
ress bar in the upper left 
corner of the interface, un-
der the Identity Plate. This 
indicates that Lightroom 
is working on something. 
When it’s done, you will get 
an isolated view of all the 
faces that Lightroom found 
in the folder. 

The Facial Recognition button can 
be found in the Tool Bar beneath 
the main image window.

The options you will get when you select Facial 
Recognition
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Instead of showing the images as a whole, 
you will see zoomed-in versions that just 
isolate the face. Below each face will be a 
little question mark. This means that Light-
room doesn’t yet know who the person is. 
Click in that field below the face to type in 
the person’s name. If you happen to see a 
little number icon in the top left corner of 
an image, that means that Lightroom thinks 
there are more than one photo of that same 
person, and if you click on the icon, it will 
expand to show you the other photos. 

After you start typing names in, Lightroom will start to recognize 
faces that have already been tagged and it will give you sugges-
tions when it sees a face that it recognizes. In those cases, there 
will be a suggested name in the place of the question mark below 
the image. There will also be an X and a check mark. If Lightroom 
is correct in determining who the person is, click the check mark.

The results after Lightroom searches for faces in a folder

Click the question mark to 
type in a name.
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Within the Facial Recognition interface, there are two sections: 
Named People (above) and Unnamed People (below). When you 
add a name to one of the faces in the Unnamed People section, it 
will move to the Named People section. You can also select fac-
es from the Unnamed section and drag them over a face in the 
Named section, telling Lightroom that they are all the same person.

If you would like to see the entire image instead of the zoomed-in 
view, simply double-click on one of the faces and you will see the 
entire image with that person in it. In this view, there will be a little 
box around the person’s face.  If there is a face that Lightroom did 
NOT recognize, you can manually drag out a box over the person’s 

face by clicking on the little icon at the 
bottom of the Facial Recognition inter-
face. Then, you can type in the person’s 
name. 

Here, we are dragging selected faces from the Unnamed section over a face in the 
Named section, indicating that it’s the same person.

Click here to manually drag out 
a box over a person’s face
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In the area for viewing all of your Named people, you can dou-
ble-click on a person and it will show you all the images of that 
person. 

Here, we are manually dragging out a Facial Recognition box and typing in the per-
son’s name

You can see that, when viewing an image as a whole, you can see the different 
names of all the people who have been tagged.
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Back in Lightroom’s Library module, you can search for any of the 
people who have been tagged via the Facial Recognition feature. 
That’s because the people’s names are being added as keywords, 
and you will see them in your Keyword List on the right side of the 
Library module interface. You can also search for them in any area 
where you would normally search by keyword, including the Filter 
Bar and the Keywording panel. 

In the Keyword List, you can 
double-click on one of the 
names to get a dialog box 
with some settings related 
to the keyword. At the bot-
tom of this dialog box, there 
is a “Person” check box. If 
the name was added using 
the Facial Recognition fea-
ture, this check box will au-
tomatically be turned on. 

I like to organize my keywords by category, one of those categories 
being People, or Model. To do this, you would fir t click on the little 
plus button at the top left corner of the Keyword List tab. You will 
get the Create Keyword Tag dialog box. In this example, I’m going 
to type in “Model,” as in the people who appear in my photographs, 
and click Create. Then, I will select all of the names in my keyword 
list and drag them over the word “Model.” This will make them child 
keywords of the parent keyword, “Model.” You can also specify that 
all future keywords that have the “Person” check box turned on  
should become child keywords of “Model.” Right click on the par-
ent keyword’s name and choose “Put New Person Keywords Inside 
this Keyword” from the pop-up menu. 

As a general note about this feature in Lightroom, Facial Recogni-
tion is a really useful feature for tagging people quickly, but I don’t 
recommend that you rely on it to tag all of the people in your li-
brary. That’s because it can have difficult when we have side views 
of people, when people are wearing sunglasses, etc.  

The “Person” box in the Edit Keyword settings 
will specify that the keyword is for a person. 
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HOMEWORK:
EXPLORE THE MAP

DRAG IMAGES TO THE MAP
TAG YOUR OWN IMAGES

CREATE PARENT KEYWORD FOR PEOPLE KEYWORDS
CONVERT EXISTING KEYWORDS INTO PEOPLE KEYWORDS

TAG IMAGES WITH PEOPLE KEYWORDS
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Today’s homework includes a Lightroom catalog file that you can open 
by launching Lightroom and choosing File>Open Catalog. (I do not 
suggest importing any of the homework catalogs into your main cata-
log since it can simply clutter things up unnecessarily.) Also, this cata-
log does not contain smart previews, so you will not be able to adjust 
the photos that are included (that was to keep the download smaller). 

In the homework catalog, you’ll find a collection named “Photos with 
Location Tagged.” Click on that collection to view the images con-
tained within and then switch to the Map module to see where each of 
the photos were taken. I used a hardware GPS device (Canon GP-E2) 
to capture the specific location where each photo was taken, which 
automatically tagged the images with GPS coordinates. Choose  
View>Show Map Key to get a better understanding of what the vari-
ous markers represent on the map. 

Notice that you can drag any of the markers to a different location. Do-
ing so will change the GPS coordinates that the images are tagged with. 
You can choose View>Lock Markers to prevent the markers from being 
moved. 

EXPLORE THE MAP
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While you’re at it, try the + and - icons near the bottom of your screen 
(or use the + and - keys on your keyboard) as well as holding Option 
(Mac), or Alt (PC) and dragging a rectangle on the map to zoom into a 
specific area. 

Hover over a marker to view the photos that were taken in that specific 
location. 

If you want to be able to quickly return to the same location in the fu-
ture, then consider clicking the + icon next to the Saved Locations head-
ing on the left side of the Map module. Why not search for areas that 
you commonly shoot (like your home town, workplace, etc.) and save 
them as locations so you can quickly return the next time you need to 
drag images to the map?
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DRAG IMAGES TO THE MAP
Now it’s time for you to add location data to images that don’t already 
appear on the map. Start by clicking on the collection that’s called “Pho-
tos to drag to Map” and then switch to the Map module. Since those im-
ages do not already have a location, the map will most likely remember 
the last location you were viewing. Since these images were captured in 
San Francisco, click on the Search Map field near the upper right of the 
map and enter that location and press Return to move the map to San 
Francisco. You can follow along with today’s video lesson and practice 
placing the various images in the proper locations on the Map. 

If Lightroom asks you if you’d like to Enable address lookup, then click 
Enable so that dragging images to the map will automatically tag the 
image with country and state metadata that can later be used to search 
using the metadata tab in the Filter Bar that appears at the top of the 
Library module. 
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TAG YOUR OWN IMAGES
Switch to your normal catalog by choosing its name from the File>Open 
Recent menu. Try to find some of your own images where you remem-
ber where they were shot. I often add such images to the Quick Collec-
tion since they are sometimes located in multiple folders. With those 
images visible, switch to the Map module. Click on the first image within 
the filmstrip at the bottom of your screen, then enter the location in the 
search field that’s found in the upper-right of the map and then drag the 
image to the appropriate location. Repeat that process for the rest of 
the images until you’ve tagged at least a dozen images. 

Once you’ve tagged some images, return to the Library module, click 
on the All Photographs choice that’s found under the Catalog heading 
on the left side of your screen type Command-A (Mac), or Ctrl-A (PC) 
and then return to the Map module to see the location of all the  
location-tagged images on the map!
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I like to keep all my people keywords in one spot within my keyword 
list. You can do the same by creating a keyword that will serve as a par-
ent to all newly added people keywords. 

I start with a non-exporting keyword called “WHO #”, where the # is 
my visual reminder that the keyword is non-exporting. I then right-click 
on that base keyword and choose Create Keyword Tag inside “WHO 
#” and create a keyword called “Model”. After doing that, I right-click 
on the Model keyword and choose Put New Person Keywords Inside 
This Keyword. Just beware, if you’ve set up my catch-all parent key-
word of “zUnsorted” in which all new keywords reside, then you’ll 
need to expand that keyword to find the WHO # keyword that I men-
tioned below and drag it to the base-level of the keyword list to get it 
out of the zUnsorted parent. 

CREATE PARENT KEYWORD FOR 
PEOPLE KEYWORDS
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CONVERT EXISTING KEYWORDS 
INTO PEOPLE KEYWORDS
If you have previously tagged photographs with the names of people 
who appear within images, then it would be best if you convert those 
keywords into officially being people keywords. You can accomplish this 
by double-clicking on an existing keyword and turning on the Person 
checkbox so that it is considered a person keyword. That will not make 
Lightroom suddenly recognize the people within that photograph since 
it will not have any people regions defined in the photo, but it will make 
that keyword available within the People area of the library module. 
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TAG IMAGES WITH PEOPLE KEYWORDS
Now is a good time to get started tagging your personal photos so that 
Lightroom can help you quickly identify people in the future. 

The first time you click on the People icon at the bottom of the Library 
module, you will have the choice to either recognize faces on demand, 
or in your entire Lightroom catalog. If you did not turn on the feature 
for your entire catalog and later want to change your mind, then choose 
Catalog Settings from the Lightroom menu (Mac), or Edit menu (PC) and 
turn on the Automatically detect faces in all photos checkbox. You can 
also pause or resume the facial recognition feature by clicking on your 
identity plate that appears near the upper left of the Lightroom window 
and toggling on or off the Face Detection setting.

Watch today’s lesson and then start tagging some of your photos to get 
used to the process. 

If you run into anything unique, have questions, or have problems, then 
let us know on the class’ Facebook Group page at  
https://www.facebook.com/groups/BenWillmore/ 
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BLACK & WHITE
As photographers, many of us enjoy converting our images to black 
and white. Lightroom gives us a handful of great tools for doing that. 

Open an image in Lightroom’s Devel-
op module and look at the Basic tab, 
at the top of the adjustment panel on 
the right. At the very top, you will see 
the words Color and Black & White. If 
you click on Black & White, all the color 
will be taken out of your image. I like to 
think of this as a starting point, because 
there are many more adjustments we 
can make from here.

In the right adjustment panel, there is 
a tab called HSL/Color/B&W. (We talk-
ed about the HSL adjustments earli-
er in this course.) Click on this tab and 
choose the B&W setting. When you ex-
pand that, you will see sliders for var-
ious colors. These are the colors that 
used to be in your image. If you move 
the sliders to the right, you can bright-
en those individual colors (or the areas 
where those colors used to be) and if 
you move the sliders to the left we can 
darken them. 

But when you look at the black and 
white picture, you might not remember 
what colors were in various areas. Be-
cause of that, I like to use the targeted 
adjustment tool, which looks like a little 
donut in the top left of the sliders. Click 
on it to activate the tool. Now, if you 
move your mouse over the image, it will 
think about what color was originally in 

Click to convert your image to 
black and white. 

The B&W tab contains sliders for 
each individual color. 

The Targeted Adjustment Tool
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the area. Click on the image and drag up if you want to brighten and 
drag down if you want to darken. When you click and drag on vari-
ous areas, Lightroom will automatically move the adjustment sliders 
that represent the individual colors you’re targeting. By dragging up 
and down on various areas, we can fine-tune our end esult. 

In the two versions of the image above, different treatment was given to the slid-
ers under the B&W tab. You can see how each color can be adjusted individually in 
order to create your ideal black and white image. 
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There is also an Auto button at the bot-
tom of the color sliders. Clicking this will 
cause Lightroom to move all of the slid-
ers based on what it thinks will optimize 
your image the most. This may be a good 
starting point. To see a before and after 
view, toggle the little light switch to the 
left of the panel name. 

Split Toning After you convert some-
thing to black and white, you might 
want to consider adding a split tone ef-
fect. Split toning allows us to force color 
into the bright and/or dark parts of an 
image and you can find the settings for 
it under the Split Toning tab on the right 
side of the Develop module. (Note that 
we covered this feature in more detail 
during a previous session in this course.)

In the Split Toning tab, there are separate sets of sliders for High-
lights and Shadows. Under the Highlights section, use the Hue slider 
to choose what color you’d like to go into the bright parts of the 
image. You’re not going to see any change in the picture until you 
move the Saturation slider, which will determine how intense the 
effect will be. If you hold down the Option Key (Alt on Win) as you 
drag the Hue slider, it will act as if you temporarily moved the Sat-
uration slider all the way up, just so you can see what color you’re 
choosing. When you let go, it will take the Saturation slider back to 
normal. After choosing the Hue, you can then use the Saturation slid-
er to introduce as much of the chosen Hue as you feel looks good. 

For the Shadows, you will follow the same procedure. Finally, you 
can use the Balance slider to determine where the shadows end and 
the highlights begin. Again, you can hold down the Option Key (Alt 
on Win) to get a view with 100% Saturation, which makes it easier to 
see where the color is going. 

Click on the light switch to 
temporarily deactivate the 
settings within the panel. 

The Split Toning settings
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Presets can be really useful when working with Split Toning. Your 
Develop presets can be found on the left side of Lightroom’s Devel-
op module. There are a bunch of presets that come with Lightroom 
and you can save your own presets as well. Once you create a split 

tone effect that you like, click the lit-
tle plus icon (+) at the top of the Pre-
sets tab and a dialog box will appear. 
Here, you can give your new preset a 
name and designate a folder for it (if 
you have a lot of presets and like to or-
ganize them that way). Then, you can 
use the check boxes below to specify 

The Split Toning settings were used to take a 
black and white image (far left) and push cool 

tones into the highlights and warm tones into the 
shadows.

The Presets tab is on the left side 
of the Develop module
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which adjustment settings should be included with the preset. For a 
preset like this, I like to turn off all of the check boxes except for the 
Split Toning one. When you click the Create button, your new preset 
will be located in the Presets tab.

After you’ve created a preset, you can open another image in the 
Develop module and click on the name of the preset to apply all 
those saved settings to the other image. Tip: If you keep the Navi-
gator tab expanded (at the top left of the interface), and you hover 
your mouse over the various presets, you will see a preview of how 
your image would look with each preset applied. 

To copy settings from one image and apply them to multiple imag-
es, fir t select the image in the Library module and right-click on it. 
From the pop-up menu, choose Develop Settings > Copy Settings. 
Then select all of the images you’d like to apply the settings to, right-
click on them and choose Develop Settings > Paste Settings. 

At left is the New 
Develop Preset dia-
log. For this preset, 
the only settings we 
want to be copied 
are the Split Toning 
settings, so that’s 
the only check box 
we have turned on.
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Dehaze for Black and White There is another technique that I use in 
optimizing black and white images and it involves the Dehaze slider. 
This is a setting that wasn’t designed for black and white images, 
but I find it c eates a nice effect. 

The Dehaze slider can be found under the Effects panel in the Devel-
op Module. Moving the slider to the right will create a good amount 
of contrast, concentrating on the dark portion of the image, pushing 
it closer and closer to solid black. Once it gets close to solid black, 
the slider starts focusing on the next brighter shade in the image.

If you’d like to create a high impact black and white image, drag the 
Dehaze slider all the way to the right. The image will look pretty dra-
matic at this point. If it’s too much, you can counteract the effect  by 
adjusting the Contrast slider in the Basic panel. I also like to adjust 
the Whites slider to control the brightest portion of the image and 
the Blacks slider to control the darkest portion. 

At left, you can see the 
dramatic effect created 
by moving the Dehaze 
slider to 100.
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When adjusting the Blacks and Whites sliders, you can hold down 
the Option key (Alt on Win) to get a view of your images that shows 
you where the blacks are (when using the Blacks slider) and where 
the whites are (when using the Whites slider). 

I like to create a series of develop presets that use different combi-
nations of the Dehaze and Contrast settings. This way, I can hover 
over the different combinations so the Navigator window shows a 
preview of what my image would like with them applied. 

We are holding down the Option key while dragging the Blacks slider in order to 
get this view of the image that shows what areas are solid black. 

I have created a series of develop 
presets that incorporate different 
combinations of the Dehaze and 
Contrast sliders.
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Grain The Grain settings can be found under the Effects panel and 
they can be used to create a vintage feel to your black and white im-
ages. The Amount slider is going to add texture into your image to 
make it look more like an old black and white photograph. The Size 
slider will control the size of the grain and the Roughness slider will 
control how random the grain is. 

HIGH DYNAMIC RANGE (HDR) 
Sometimes the brightness range of a scene is greater than what our 
cameras can capture. This is common when shooting in the midday 
sun or other high-contrast scenarios. When this happens, we’ll of-
ten get an image where the shadows look ok but the highlights are 
blown out, or we’ll get an image where the highlights are good but 
the shadows are completely black. 

HDR is a technique that allows us to achieve a larger brightness 
range than we could get with a regular image, and therefore main-
tain good exposure in both the highlights and the shadows. In order 
to do this, we need to shoot multiple images with different exposure 
settings and then combine them later. That’s where Lightroom is 
going to come in.  

The Grain sliders 
can be found under 
the Effects panel 
and can be used 
to create a vintage 
feel to your black 
and white images.

ADJUSTMENT WORKFLOWS FOR B&W, HDR & PANOS  |  234



Copyright 2018 by Ben Willmore. All Rights Reserved

LIGHTROOM CLASSIC: THE COMPLETE GUIDE
ADJUSTMENT WORKFLOWS FOR B&W, HDR & PANOS

Camera Settings for HDR

Auto Bracketing: The general setting for this is three exposures at 
two stops apart. (You might have to narrow to one stop apart if you 
have really bright and really dark things right next to each other, like 
a neon sign at night.)

Aperture Priority Mode: You want to use this mode so the depth of 
field is onsistent in each shot.

After taking the shots, look at the darkest image and make sure you 
have highlight detail. If you do, then that image is dark enough. If 
the highlights are blown out, you might have to re-take it, making it 
darker. In the lightest image, you want to make sure that you can see 
detail in the important parts of the shadows. If you can’t, you’ll need 
to get a brighter image.

To combine a series of images you shot for HDR, fir t select them 
all in Lightroom’s Library module. Then go to the main menu and 
choose Photo > Photo Merge > HDR.  When you choose this, it will 
attempt to combine the selected exposures into a single image. 

The HDR Merge Preview window will appear, and it’s important to 
know that your image won’t look great here. But that’s ok. All of the 
toning on the image will be done later. The Auto Align setting will 
attempt to align the images, compensating for any small amount of 
camera movement. I generally keep this setting turned on. 

If you would like to get a general idea of what the image might look 
like after toning, turn on the Auto Settings check box. The Auto Set-
tings check box will apply some toning settings to the image auto-
matically. 

This bracketed set of images was shot with the intention of merging for HDR.
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If there is any movement in the scene (leaves moving in the wind, 
a waving flag, etc.), then you might have a ghosting issue. In this 
case, use the Deghost Amount settings on the right. The higher the 
setting, the more aggressive the correction will be. If you can’t tell 
where the Deghosting correction was applied, turn on the “Show 
Deghost Overlay” checkbox, which will put a red overlay on your 
picture wherever it detected motion. When you’ve applied any nec-
essary settings, click the Merge button in the lower right.

After hitting the Merge button, you’ll be taken back to the Library 
module, where you will see a new file that ends in .dng. This will 
be a special image that contains the brightness range from all of 
the merged photos. Note that if Lightroom is not set to sort by file
name, then the merged image may appear at the end of the file li t. 

Select that merged file and move into the Develop module to do 
your adjusting. Here, you are free to use all of the settings as you 
normally would when adjusting your images. 

Here is the system I use for adjusting my merged HDR images. As 
a starting point, I’ll move the Highlights slider all the way down and 
the Shadows slider all the way up. Then, I’ll grab the Exposure slider 
and use it as an overall brightness adjustment. From this point on, I’ll 

The HDR Merge Preview dialog
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treat this as any other image. That might include going back to fine
tune the Shadows and Highlights. If I want to add a little pop to my 
image, I’ll turn to the Vibrance, Clarity and Contrast sliders. 

I sometimes find that the highlight areas can appear a bit dull after 
processing an image for HDR. If this is the case, I will use the Ad-
justment Brush to paint over the highlight areas with the Highlights 
slider moved to the right. 

If you move the Highlights slider all the way down 
and/or the Shadows slider all the way up and 
find that you still aren’t able to bring as much 
detail in as you’d like, there’s a trick for taking 
these adjustments further. Open the Tone Curve 
panel and make sure that the sliders beneath 
the curve chart are visible. If they’re not visible, 
click the little square icon at the bottom right 
corner of the panel. Here, you can use the High-
lights and Shadows sliders to further pull detail 
out of the bright and dark areas.

Lastly, the Adjustment Brush can also be used to fine-tune the results 
of a merged HDR image. I find that I often times paint in a Dehaze 
or Contrast adjustment to any areas that might be lacking contrast.

In the final imag , 
after being merged 
for HDR and having 
tone adjustments 
made, we can see 
detail in both the 
highlights and the 
shadows.

The Tone Curve panel
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PANORAMAS
Shooting Panoramas Panoramas give us the ability to fit more into 
an image than we were able to capture with a single shot from our 
lens. When shooting a pano, it’s important  that you use Manual fo-
cus. This way, when you move across the scene, it’s not varying in 
focus. You’ll also want to keep the exposure consistent through all 
of your images. Many cameras have an Auto Exposure Lock button 
(AEL) that you can hold down while shooting your entire pano. Make 
sure to overlap each image by at least one third of the frame width. 

Merging Panoramas The  advantage to merging panos in Lightroom 
over other software is that the final, merged image is still a raw file
and has all the qualities of a raw fil . This means that you don’t have 
to adjust the individual files one-by-one before you merge them. You 
can wait until afterwards and adjust the entire panorama as a whole. 
With other software, the merged file will be a tiff or a jpg, and would 
not maintain the same quality when adjusted. 

To merge a set of panorama images, fir t select them all in the Li-
brary Module, go to the main menu and choose Photo > Photo Merge 
> Panorama. It’s going to attempt to stitch those into a single image.

This series of 
images was shot 
to merge into a 
panorama. I made 
sure to overlap 
each shot by at 
least one third of 
the frame width.
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Once it’s done, the Panorama Merge Preview window will appear 
and you can specify how the images should be aligned using the 
options on the right (Spherical, Cylindrical & Perspective). I usual-
ly click through them to see which looks best. If you want to get a 
better view of how these settings are affecting your image, turn off 
the “Auto Crop” check box. This will prevent Lightroom from crop-
ping out any empty area from the edges. Whether or not you keep 
this check box turned on is a personal preference. Sometimes, I like 
to keep it off because I intend to fill in the empty areas later using 
Photoshop. 

The Boundary Warp slider is a feature that stretches the picture to 
try and fill in the empty areas. Sometimes it can make a big differ-
ence and sometimes it can distort things in a way that you might 
not like. I recommend playing with it to see how it works on each 
individual image.

When you’re done, hit the Merge button and you will be taken back to 
Lightroom’s Library Module where you will find your newly-merged 
panorama image. 

The Panorama Merge Preview dialog
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The merged panorama has all of the qualities of a raw fil , so you 
can move it into the Develop Module and optimize it using the same 
adjustments that you would use to adjust any other image. This is 
much more convenient than trying to adjust each image individually 
before the pano is merged.

Occasionally, Lightroom doesn’t do the best job at merging a pan-
orama. For example, there may be some instances where you find
uneven brightness between frames or you might see one of the 
stitch lines. If this happens, you can try merging the images in Pho-
toshop as well and then compare the results. Note that if you merge 
a pano in Photoshop, you will need to adjust the images fir t. That’s 
because the end result will not be a raw file so any extreme adjust-
ments may degrade the image quality.  

To merge a panorama in Photoshop, select all of the images, go to the 
Photo menu and choose Edit In > Merge to Panorama in Photoshop. 
The Photomerge dialog will appear and there will be some Layout 
settings on the left that determine how the images will be stitched. 
I usually set this to Auto. Leave the “Blend Images Together” check 
box turned on. The “Content-Aware Fill Transparent Areas” check 
box will tell Photoshop to attempt to fill in any empty area around 
the edges. After you’ve specified all the settings, click OK and then 
it will merge them and open them in the main Photoshop window. 

If Lightroom ever does 
a poor job of merging a 
panorama, you can try to 
merge in Photoshop. At left 
is Photoshop’s Photomerge 
dialog. 
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Panorama Tips:

• Your panoramas don’t always have to be horizontal. You can also
create vertical panoramas. A really tall waterfall or skyscraper
would be a good subject for a vertical pano.

• It’s very hard to create an out-of-focus background with a wide
angle lens. If you ever want to shoot a wide shot and still get your
background really out of focus, use a longer lens set to a small
aperture and use it to shoot multiple shots of the scene and then
merge them into a panorama.

• Panoramas don’t always have to be a single row of images. You
can also shoot them as grid of images.

• It’s even possible to create HDR panoramas. To do this, you would
have to shoot for HDR in every frame of the panorama. You’d fir t
merge each of the HDR frames and then take the final merged
HDR images and merge them into a panorama.

A blurry background was created here by shooting this wide scene in multiple im-
ages, using a long lens set to a small aperture, and then merging them into a pan-
orama. 
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LIGHTROOM PRESET GUIDE
INSTALLATION & USE OF BEN’S BONUS DEVELOP PRESETS

The installation method and file format used for presets has recently changed.  There-
fore, there are two versions of these presets that are included in this sample pack. To 
determine which version you need to use, launch Lightroom and choose About Light-
room from the Lightroom menu (Mac), or Edit menu (PC) and note the release number 
that appears near the top of the About screen. If you are using a version earlier than 
7.3, then you’ll need to use the folder of presets that includes “PRE 7.3” in the folder 
name and you should skip to the section of this guide that is titled “How to install (Pre 
7.3)” to learn how to install the preset. If you are using release version 7.3 or later, then 
you can continue reading. 

HOW TO INSTALL IN LIGHTROOM 7.3 OR LATER
Since Lightroom requires one file for each preset, and this sampler pack contains many 
presets, we’ve chosen to compress all those presets into a single .zip fil . Before you 
install the presets, you’ll need to “unzip” the file by double-clicking on it to reveal its 
contents. Once you’ve done that, you can discard the original .zip file since you have al-
ready extracted its contents and therefore no longer need the .zip fil . If you look at the 
resulting folder, you should find many folders inside. Those folders need to be moved 
into a special folder in order for Lightroom to use them as develop module presets. 

The easiest way to locate the folder to move the files into in newer versions of Light-
room is to select any image, head to the Develop Module and inspect the Presets area 
on the left side of the screen. If you don’t already have any user-created presets, then 
press the + sign to the right of the word Preset and choose Create Preset. When the 
window of options appears, just click the Create button and then right-click on the re-
sulting preset, then choose Show in Finder (on PC, the name will differ slightly) which 
should bring you to a folder called Settings, which is found within another folder called 
CameraRaw. All you have to do now is drag all the presets folders that you unzipped 
earlier into that special Settings folder and restart Lightroom.
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Since Lightroom requires one file for 
each preset, and this sampler pack 
contains many presets, we’ve chosen 
to compress all those presets into a 
single .zip fil . Before you install the 
presets, you’ll need to “unzip” the file
by double-clicking on it to reveal its 
contents. Once you’ve done that, you 
can discard the original .zip file since 
you have already extracted its con-
tents and therefore no longer need the 
.zip fil . If you look at the contents of 
the resulting folder, you should find a 
total of ten folders inside. Those ten 
folders are what we need to install in 
order to be able to access the presets 
from within Lightroom.   

In Lightroom, go to the menu at the top 
your screen and choose Lightroom > 
Preferences on the Mac, or Edit > Pref-
erences on a PC. Next, click on the Pre-
sets tab and then click on the “Show 
Lightroom Presets Folder...” button.

Next, locate the Develop Presets folder and drag the ten folders that you extracted 
from the .zip file so they end up inside that folder.  It’s important that a) you move the 
ten folders and not the base folder that contains them, and b) they end up inside De-
velop Presets folder and not the Lightroom folder that it resides within. NOTE: If you 
already received one of Ben’s sampler preset packs, then you might see some dupli-
cate presets. Only move the presets you don’t already have into this folder. 

Now, return to Lightroom, quit and then relaunch the program to cause it to utilize 
the newly installed presets. When Lightroom re-opens, you can confirm they’ve been 
installed properly by inspecting the Presets panel, which is found on the left sidebar of 
the Develop module.

HOW TO INSTALL (PRE 7.3)

The Preset Sample Pack folder unzipped, in the Finder. 

In Lightroom’s Preferences dialog box, click on the “Show Light-
room Presets Folder” button to open up the correct folder on 
your hard drive.

BEN’S LIGHTROOM PRESET GUIDE
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Once the presets have been loaded into Lightroom, they will appear inside the Presets 
panel on the left side of Lightroom’s Develop Module. You will see the names of the 
four preset folders (ex: 1A Ben’s Tonal Brighten) and if you click on the folder name, the 
contents will expand so that you can see all of the individual presets. 

If you open an image in the Develop Module and 
then hover your mouse over the different preset 
names (without clicking), you will see a preview 
of what the preset will look like applied to your 
image in the Navigator panel, which is located in 
the top left corner of the interface. When you find
a preset that produces a desirable preview, then 
click on the name of the preset to apply it to your 
image. Note that you can apply multiple presets 
to your image if you’d like. Also, after applying a 
preset, you can go and tweak the individual sliders 
in the Develop Module to fine-tune the e ect. 

Note that the name of each preset folder ends with 
a word indicating which adjustment sections were 
used (Basic, HSL, etc.) You can combine multiple 
presets as long as they use different adjustment sections. Applying two presets that use 
the same adjustment section can cause the second preset to override the fir t. 

Just like with presets folder, the individual 
preset names end using letters that indicate 
which adjustment sliders were used to pro-
duce the effect. (For example, ESH means 
that the preset uses the Exposure, Shad-
ows and Highlights sliders.) By comparing 
the name of each preset, you can determine 
whether one preset might override the ef-
fect of another by seeing if they use the 
same adjustment sliders. For instance, ap-
plying a preset that ends in ESH and then 

BEN’S LIGHTROOM PRESET GUIDE

HOW TO USE

The folders of presets installed as shown in Light-
room’s Presets panel.

The preset names end with letters that indicate which ad-
justment sliders were used. 
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another that ends in EHB will cause part of the fir t preset to be overridden (because 
they are using one of the same adjustment sliders), but combining a preset the ends 
in ESH with one that ends in VS (for Vibrance, Saturation) will work just fine since they 
don’t overlap in which adjustment sliders are used. A lowercase letter at the end of a 
preset name indicates that the slider being referenced will be reset to default settings.

You might find that the preview func-
tionality of the Navigator panel doesn’t 
work on some images. That’s usually 
because the image has been adjusted 
with a much older version of Lightroom, 
which featured different adjustment slid-
ers than the current version. Since the 
preset requires the adjustment sliders 
that are offered in the current version 
of Lightroom, it is in essence disabled 
for that particular image. To see if that 
is the case, look at the Histogram that 
is found above all the adjustment slid-
ers on the right sidebar of the Develop 
module. If you see a small lightning bolt 
icon beneath the histogram in Lightroom, then the image was adjusted with an older 
version and needs to be updated (by clicking on the icon) in order to be compatible 
with the preset. That should cause  the Navigator preview to work again on that image. 

BEN’S LIGHTROOM PRESET GUIDE

TROUBLESHOOTING

The lightning bolt icon indicates an image that needs updating.
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Today’s homework includes a Lightroom catalog full of images to prac-
tice on. The files are organized in various collections. The images for 
B&W and Presets can be used as-is because they have smart previews 
included. The images in the HDR, Panos, and HDR Pano collections are 
different. They require access to the original raw files. Those images 
will initially show up as being missing. To make them accessible, go 
to the Folders list in the Library module where you will find a folder 
called “Find Missing Folder” that will most likely have a question mark 
on it, right-click on that folder and choose Find Missing Folder. Nav-
igate to the same folder/directory that contains the catalog file you 
have open, which is where you should find a folder with a matching 
name. Click on the folder and then press the Choose button so Light-
room knows where the files are stored on your hard drive. Note: I do 
not suggest that you import these images into your main catalog since 
it will just clutter things up... just open the catalog when you need to 
use the images and then choose the catalog you were working from 
the File>Open Recent menu when you’re done. These files are to be 
used while following today’s lesson.
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You may find that you repeat the same adjustments again and again. 
For instance, I often end up moving the Highlights sliders to the left and 
the Shadows slider to the right and then increasing Clarity and Satura-
tion a bit. If you have similar tendencies, you can save a lot of time by 
saving those common adjustments as presets. 

To create a preset, open any image in the Develop module, click the Re-
set button in the lower right to wipe away any settings already applied 
to the image, dial in the exact settings you want to save and then click 
the + icon to the left of the Preset heading on the left side of the Devel-
op module. 

BRAINSTORM COMMON ADJUSTMENTS
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Saving a preset will cause Lightroom to prompt you for which specific 
settings you’d like to include within the preset. If you use the Check All 
button, then the preset will contain all settings that are applied to the 
current image. I do not suggest that since it will make things less flexi-
ble since applying one preset after another will cause the second preset 
to completely override the first. Instead, look through the options and 
only turn on the checkboxes for the features that were required to get 
the effect you’re attempting to save. 
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DEVELOP A USEFUL NAMING 
CONVENTION
When I have a develop preset, I include within the same a clue as to 
which adjustment sliders were required for the effect. That way I can tell 
if one preset might override or conflict with another. 

My system is to first control the order that presets are listed in by start-
ing each preset name with a number since they are sorted alphabeti-
cally. Then at the end of the folder that contains some presets, I include 
the name of the section of adjustment sliders that were required to 
create the effect so I can tell if one preset might cancel out another. I’m 
not saying that my system is right for you, but it can be useful to think 
through any naming conventions that might be useful before you create 
too many presets. 
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At the end of each of my preset names, I also add some letters to indi-
cate exactly which sliders were needed to complete the effect so I can 
tell if one preset will overlap another. For instance ESH stands for Ex-
posure, Shadows and Highlights. That let’s me know that an ESH preset 
will not cancel out the effect of a preset that ends with VS (Vibrance, Sat-
uration). My system is very granular and might be too detailed for your 
mindset, so consider your own needs and think through how you might 
organize and name your develop presets. 
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ORGANIZING KEYWORDS
In an earlier session, we covered 
keywords and how we use them to 
tag our images. In this session, we 
are going to dive a little deeper and 
learn how to organize our keywords 
into a more structured system.

All of your keywords can be seen 
within the Keyword List on the right 
side of the Library module. To the 
right of each keyword, there is a 
number that indicates how many 
images have been tagged with that 
keyword. Within this list, you can 
organize these keywords into hier-
archies. Just like you can have sub-
folders within folders, you can have 
child keywords within parent key-
words. For example, if you have the 
keywords Asia, China, Vietnam and 
Japan, you could make the three 
countries (China, Vietnam, and Ja-
pan) child keywords of the parent 
keyword, Asia. To do this, you would 
simply drag them over the keyword Asia and they will become child 
keywords. Then, the parent keyword will have a little arrow next to it 
that you can use to expand and contract the contents. 

When you search for a parent keyword (Asia), the search results will 
also include images tagged with the children keywords (Vietnam, 
China, Japan). 

There are several ways to create new keywords. One way is to click 
on the little plus icon ( + ) at the top of the Keyword List panel. The 
Create Keyword Tag dialog will appear where you can type in the 
keyword, add any synonyms and then click the Create button. 

The Keyword List in Lightroom’s 
Library module

Here, Buenos Aires is a child keyword
of the parent keyword, Argentina. 
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If you would like to tag an image with a new keyword and add it as 
a child keyword, fir t select the image and then right click on the 
parent keyword. A pop-up menu will appear and you should choose 
“Create new Keyword Tag Inside [parent keyword here].” A dialog 
box will appear where you can give the new keyword a name. You 
will also notice that the “Put inside [parent keyword]” check box is 
automatically turned on. Click the Create button. 

You may not always want to be work-
ing inside the Keyword List. If that’s 
the case, there is a way to designate 
parent/child keywords within the Key-
wording tab (just above the Keyword 
List), which is where I prefer to work. 
If you want to create a new keyword 
and specify that it should be a child of 
another keyword, you would use the 
greater than symbol (>). For exam-
ple, if I wanted to create the keyword 
“Singapore” and it should be a child 
of “Asia,” then I will type the following 
into the text field in the Keywording 
tab: Asia>Singapore. Then hit Enter.

The Create Keyword 
Tag dialog box is being 
used to create a child 
keyword within a select-
ed parent keyword. The 
“Put inside...” check box 
is turned on. 

Here, we are telling Lightroom that 
“Singapore” should be a child key-
word of “Asia.” 
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You can make your keyword hi-
erarchy as complex as you want, 
with multiple levels of parent/
child keywords. If you look at 
the hierarchy on the right, we 
have United States of America > 
California > San Francisco > Coit 
Tower. Because of this setup, any 
image that I tag with Coit Tower 
will also be found by searching 
for any of the parent keywords 
above it. 

When you have an image select-
ed, you will see the keywords at-
tached to it in the Keywording 
tab. Note that you can decide 
whether you want to see Key-
words or Keywords & Containing 
Keywords (meaning the parent 
keywords) in that window by us-
ing the dropdown menu at the 
top of the Keywording tab. 

It’s possible to have a child key-
word appear inside more than 
one parent keyword. For exam-
ple, the keyword “Ford” may be 
a child keyword of “Truck” and 
“Car.” If that’s the case, when 
you start typing in the word 
“Ford” to add a keyword, a pop-
up menu will appear, giving you 
the options of Car>Ford and 
Truck>Ford. Simply choose the 
one that’s appropriate. 

A more complex keyword hierarchy

You can choose whether to view Keywords 
or Keywords & Containing Keywords

If you type in a keyword that has more than 
one parent keywords, Lightroom will give 
you a pop-up list so you can choose the 
correct one.
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Cleaning up your Keyword List After a while, you can accumulate 
a lot of keywords and a lot of keyword hierarchies. I’ve found that it 
can be useful to create a system for cleaning up your keyword list 
and keeping it organized. Here is how I organize my keywords:

There are some keywords that I just use for organizational purposes 
and I don’t want to be included in the metadata when I export the 
image. An example would be the word “continent.” It’s useful for me 
to be able to place “Asia,” Europe,” North America,” etc. inside the 
parent keyword of “Continent” because it would tidy up my keyword 
list. However, “Continent” is not a useful keyword for someone else 
that I might send the image to. Therefore, I don’t want it to be export-
ed. When this is the case, I will double-click on the keyword “Conti-
nent” to call up the Edit 
Keyword Tag dialog. I 
will turn off the “Include 
on Export” check box. If 
the word has any syn-
onyms listed, I can spec-
ify whether they should 
be exported by using 
the “Export Synonyms” 
check box. 

I also try to make sure 
that it’s visually obvious 
that it’s a keyword that 
wont export, so I will add 
the pound symbol (#) at 
the end. This way, I can 
look down my keyword 
list and instantly be able 
to tell which keywords 
wont export. 

I include the pound symbol in my keyword name as a 
visual reference so I know it won’t be exported.
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Now let’s look at how we can 
make the keyword list useful with-
out being cluttered. I will create a 
keyword called zUnsorted and I 
will turn off the “Include on Ex-
port” check box. The reason I be-
gin with “z” is so that I know it will 
be at the end of my keyword list. 
Then I will right-click on the key-
word in my list and choose “Put 
New Keywords Inside this Key-
word” from the pop-up menu. That means that every new keyword 
I create will become a child of the zUnsorted keyword. I will also 
drag all other unsorted keywords into this keyword so that the only 
keywords visible  in my Keyword List are the ones that have already 
been structured in a hierarchy. Now, as I am keywording all of my 
newly-shot images, any new keywords (ones that don’t already exist 
in the list) will be added within the zUnsorted keyword.  This makes 
it so all of the clutter is automatically stored somewhere. I can later 
go to this keyword parent and place all of the children keywords into 
my structured keyword hierarchy.  

For my personal system, I have 
the following base level key-
words: Who, What, When, Where 
and How. Every other keyword ei-
ther goes inside the hierarchy for 
one of those or they go into the 
zUnsorted category. This makes it 
very easy to navigate the list and 
find a keyword. For example, let’s 
say I want to find the images shot 
at Coit Tower. I would expand the 
Where keyword and then click to 
expand  Continent > North Amer-
ica > United States > California > 
San Fransisco> Coit Tower. 

The only keywords not placed inside the 
zUnsorted keyword are those that already 
have a hierarchy. 

My system contains the above base level 
keywords. 
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Under my Details category, 
there is a keyword called “! 
Action Needed #.” All of the 
child keywords inside this 
keyword begin with an excla-
mation point and stand for 
something that needs to be 
done to the image. The ex-
clamation point makes it so 
these keywords will always 
be placed in the beginning of 
an alphabetical list and it lets 
me know that I need to take 
come kind of action with the 
images (retouch, rate, print, 
etc.). 

My base level keywords are in all caps and this makes them stand 
out. It also makes it easy for me to see if any additional keywords 
have snuck into the list. 

If you would like to throw away any unused keywords, go to the 
Metadata menu at the top of the interface and choose Purge Un-
used Keywords. I would not do this if I was using a keyword list that 
I bought from someone or that I carefully created to incorporate a 
hierarchy and categories.

Right-click on the magnifying glass icon within the search field
above the keyword list and a menu will appear. Choosing the People 
option will show you only keywords representing people, that were 
tagged with the face recognition feature. The “Show All Keywords 
Inside Matches” option will cause the search results to show all the 
keywords it found as well as the child keywords.

All keywords that begin with an exclamation 
point represent images that require some kind 
of action on my part.
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When you hover your mouse over 
any of your keywords in the list, a 
little arrow will appear to the right 
of the keyword. Click on the arrow 
to view all of the images that were 
tagged with that keyword. 

With an image selected, you can 
use the keyboard shortcut Com-
mand+K (Ctrl+K on Win) to open 
the Keywording panel and when 
you do this, the text field will automatically become active so you 
can start typing in a keyword. While you’re typing in keywords, you 
won’t be able to use the arrow keys to move between images. In-
stead, you can hold down the  Command key (Ctrl on Win) and then 
use the arrow keys.

You can actually download a pre-made keyword list and load it into 
Lightroom. If you do this, you’ll likely have a lot of keywords with the 
number zero next to them, indicating that there are no images with 
that keyword.

Exporting your Keyword List After your keyword list gets so large, 
there are various reasons why you may want to export it. Maybe you 
want to share it with someone else, or maybe you want to check it 
for errors like misspellings and such. Lightroom allows you to export 
your keyword list as a basic text fil . To do this, go to the Metadata 
Menu and choose Export Keywords. A Save dialog box will appear 
where you can give the list a name and click Save. This will create a 
text file out of your keyword list that you can open in any text editing 
software. You will see all of your base keywords with the child key-
words indented. If you have a spell check turned on, you can scroll 
down the list and see if there are any typos or other errors. (Note 
that you’ll need to correct these in Lightroom, not in the text fil .)

Looking at the keyword list text fil , all keywords that have brackets 
around them represent keywords that wont export. If a keyword has 
curly brackets, it represents a synonym keyword.

Clicking on the little arrow will show you all 
of the images tagged with that keyword. 
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Importing a Keyword List You can also import a keyword list that 
someone else created. To do this, you’d go to the main menu and 
choose Metadata > Import Keywords. If you do this, your keyword 
list would suddenly be populated with all of the words and organi-
zation of the new list. 

The only problem is that any keywords you already have organized 
and tagged are not going to conform to that keyword list. If you do 
import a list, I recommend creating a keyword called zUnsorted and 
then placing all of your current keywords inside of this one. Then 
import the list. This will keep the new list separate from your old list.  
I also recommend importing a new keyword list into a new, empty 
catalog before importing it into your main catalog. This will allow 
you to fir t inspect the list and make sure that it’s going to be rele-
vant to your workfl w. 

This is what a keyword list looks like after exported into a text fil .

{Synonym Keywords}

[Non Exporting Keywords]
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When organizing your keywords into a hierarchy, I find that the fewer 
base-level keywords, the better, since it makes for a clean and easy to 
navigate system. Below you can see what my keyword list looks like 
when the base keywords have been collapsed. My system will not be 
right for everyone, so brainstorm what is unique about the subject 
matter you shoot and your final uses for those images to see what you 
might need to deviate from my setup. Here are some details about 
how I organize my keywords within those base keywords:

BRAINSTORM IDEAL BASE KEYWORDS
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DETAILS: This is where I put keywords that have little to do with the 
subject matter or location of a photograph. Instead, this is where I keep 
track of which clients have received my images (via various Submitted>-
Date & Client Name children keywords). I also use this base keyword to 
track who still needs to be done to images, any legal info (like the pres-
ence or absence of a model release), Portfolio-related keywords, copy-
right registration info and print sales records. 

HOW: Keep track of compositional techniques (repetition, pattern, 
framed, etc.), camera techniques (motion blur, shallow depth of field, 
panning, etc.), lighting techniques (backlit, flash, silhouetted, light paint-
ed, etc.), post-processing techniques (border effects, HDR, retouched, 
B&W, etc.), and viewpoint (arial, close up, panorama, profile, underwa-
ter, etc.)

WHAT: This is where the vast majority of my keywords reside. Theses 
keywords describe what appears in my photographs and include sec-
tions such as Activities, Animals, Architectural elements, Colors, Materi-
als, Objects, Shapes, Sizes, etc.

WHEN: Contains keywords relating to what type of event or what time 
of year an image was captured (seasons, festivals, holidays, sunrise, sun-
set, etc.)
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WHERE: Dragging an image onto the Map is often not enough for me 
to keep track of the specifics of where the image was captured. Any 
additional information is tracked here, including Attractions (carnivals, 
fairs, circus, etc.), continents, countries, cities, museums, oceans, start & 
national parks, etc.

WHO: This is where I track information about the people who appear 
in my photographs. I have sections that include age-related info (adult, 
baby, newborn, teen, etc.), emotions (angry, fear, love, surprise, etc.), 
ethnicity, family relationships (father, son, daughter, etc.), poses, reli-
gions, roles (actor, beggar, clown, cowboy, etc.)

zUNSORTED: This base keyword is used as a catchall for newly created 
keywords. By right-clicking on this keyword and choosing Put New Key-
words Inside this Keyword, newly created keywords should appear as 
children to this keyword. That helps to keep my keyword list clean look-
ing. Then, every for months, I’ll inspect what has collected inside this 
keyword to see if it makes more sense to move any keywords into an 
alternative location among the other base keywords. 
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Try not to get too stressed about your keyword list. The most important 
thing about using it is to tag the images that you hope to be able to find 
in the future. Having a completely unorganized list is just fine and for 
many people preferable. It takes a tremendous amount of time to keep 
your keywords organized. You just have to determine if the time need-
ed will bring enough benefits to make it worthwhile. One of the main 
advantages of organizing your keywords is that tagging an image with 

a single keyword can then make it 
searchable based on any of that key-
word’s parent keywords. For instance, 
the keyword Coit Tower is located 
within Continent>North Ameri-
ca>North America>California>San 
Francisco, which makes it so any im-
age tagged with that single keyword 
will show up when searching for any 
of those choices. It also give you a 
different way to explore your images, 
where I can browse based on all sorts 
of things such as emotions, building 
types and materials, which wouldn’t 
be easy when using an unstructured 
keyword list. 
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CONSIDER PURCHASING 
A KEYWORD LIST
One shortcut to having an organized keyword list is to import an exist-
ing list. There is a starter list that comes with purchase of this class that 
you can use as a starting point if you’d like. Just beware that transition-
ing to a different keyword list is not always easy. Your existing keywords 
will not magically get moved into the new system and you can end up 
with some duplicate keywords. If your current keyword list is largest un-
organized and you plan to load a keyword list that you have purchased, 
then you might want to first create a base keyword called zUNSORTED 
and then drag all your existing keywords on top of it to clean up the 
base level of your list. I’ve been working on my keyword list for many 
years and offer it for sale at www.DigitalMastery.com/keywords Many 
other people sell their keyword lists and some are even available for 
free, so don’t consider this your only choice. You might find someone 
else’s list to be more useful, especially if you shoot within a specialty like 
weddings, seniors or shoot other subject matter that I do not commonly 
capture.
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Starting a keyword with a special character (!, #, =, ?, @, etc) can give 
you a few benefits that you might not have considered. If you use one 
of those characters consistently for a category of keyword (such as 
client approval levels), then you will be presented with a list of all the 
keywords that start with that character the moment you type it into the 
Click here to add keywords field. Note: In the example below, the # at 
the end of each keyword is my way to indicate that a keyword is set to 
not export. 

BRAINSTORM SPECIALTY KEYWORDS
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Think through how you work with images (maybe multiple people 
work on a catalog and you need to keep track of processing status... 
retouched, color corrected, etc.), vendors (keep track of which imag-
es have been sent for printing, which have been received back, which 
were delivered to client, etc.), and clients (images submitted, chosen by 
client, etc.). Those are all instances where using a special character at 
the beginning of a keyword might be useful so that you will be present-
ed with a list of the keywords that start with it. I personally store these 
specialty keywords within the base keyword of DETAILS.  Go ahead and 
create a few keywords that start with special characters and get practice 
entering them on a few images. 
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Once you’ve keyworded a good number of images, consider choosing 
Metadata>Export Keywords to save your keyword list as a text file. You 
can then open that text file in a word processor to inspect it in more 
detail. The hierarchy of your keywords will be shown using tab-based 
indenting, while synonyms will be displayed within {curly brackets} 
and non-exporting keywords will be shown in [square brackets]. This is 
also a great time to scroll through to see if your word processor’s spell 
checker finds any misspellings in your keywords. I’d make modifications 
to your keywords directly in Lightroom instead of the word processor, 
because re-importing a keyword list into a catalog that has duplicate 
keywords and an already defined structure can get messy. 

EXPORT & INSPECT YOUR KEYWORDS
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SEARCHING BASED ON FOLDERS & COLLECTIONS
It might sound like a stretch, but I actually can find any of my imag-
es in fi e seconds or less! The key to being able to do this is having 
a good tagging system and knowing how to use all of Lightroom’s 
search features. 

Folders Filter The fir t area we 
can think about searching for 
images is on the left side of the 
screen in the Library Module. 
At the top of the Folder List, 
there is a search field that can 
be used for fil ering your fold-
ers. Click on the little magnify-
ing glass icon on the left side of 
the search field and a menu will 
appear that allows you to spec-
ify whether Lightroom should 
search all of your folders or just 
your Favorite Folders. A folder 
can be designated as a Favorite 
by right-clicking on the folder 
name and choosing “Mark as Favorite” from the menu that appears. 
Folders marked as favorites will have little stars on top of their folder 
icons. 

To remove a folder from your Favorites list, right-click on the fold-
er name and choose Unmark Favorite from the pop-up menu. Just 
be aware that if you had more than one folder selected when you 
marked it as a favorite, Lightroom will not allow you to unmark one 
of them individually. What you will have to do is click on the  Folder 
menu that appears right above the Filmstrip at the bottom of the 
screen and choose the “Folders:...” option from the Favorite Sources 
section of the menu. This will highlight all of the folders you marked 
as favorites as a group and you can now unmark them.

The Folders fil er can be found at the top 
of the Folders panel on the left side of the 
Library Module.

The star icon indicates that a folder has
been marked as a favorite.
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Collections Filter There is also 
a fil er bar/search field at the 
top of the Collections panel on 
the left side of the interface. 
Use this to quickly search for 
a specific collection or collec-
tion set. Click on the magnify-
ing glass icon on the left side 
of the search field and you will 
get a menu that allows you to 
specify whether you’d like to 
search all collections or just synced collections. Synced collections 
are those that have been synced with Lightroom on the cloud and 
can be worked with on your phone, tablet, etc. If the search field
does NOT appear at the top of the Collections panel, click on the lit-
tle plus sign icon ( + ) and choose “Show Collection Filter” from the 
menu that appears. 

THE FILTER BAR
The Filter Bar is an extremely powerful way to search in Lightroom. 
It can be found above the main image window in the Library Module. 
If you don’t see it, know that you can toggle its visibility with the \ 
key. 

If you would like to search your entire catalog of images, click on 
“All Photographs” in the Catalog panel on the left side of the Library 
Module. Then, when you use the Filter Bar, you’ll be searching your 
entire catalog.

The Filter Bar allows us to search images based on a wide range of 
criteria. Let’s look at the different methods:

The Collections fil er can be found at the 
top of the Collections panel. Click the mag-
nifying glass to choose whether Lightroom 
should search all your folders or just your 
synced folders. 

The Filter Bar can be found above the image window in the Library Module.
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Attribute Search In the Filter Bar, one of the other search options 
is “Attribute.” If you click on this option, you will be able to search 
via things like Rating, Color [tags], Flags, etc. 

Note that when you search by Attribute, it’s going to remember the 
last settings you used, so you will have to manually turn them off 
and turn your new search parameters on. 

I don’t personally use the Attribute area of the Filter Bar too often.  
That’s because I can search for the same things using the Metadata 
area and this method works better for me. 

Metadata Search In the Metadata area, you will get a set of individ-
ual columns (or search categories). You change the type of data 
each column shows by clicking on their titles. The Metadata search 
allows you to fil er via a multitude of types of info. You can fil er by 
date, label, lens, camera, shutter speed, rating, file type, etc. The list 
goes on and on. 

When searching by Attribute, you can fil er images by star rating, flag, olor label, etc.

A fil er category is being selected in the Metadata section of the Filter Bar. 
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The nice thing about the Metada-
ta search is that when you choose a 
search type, Star Rating for example, 
you will get a list of the different star 
ratings you’ve applied and a number 
next to each one that indicates how 
many images have been given each 
rating. If you chose Lens, you’ll get 
a list of all the lenses your images 
were shot with and a number indicat-
ing how many photos were shot with 
each one. So the Metadata Filter gives 
you a little more information than the 
Attribute Filter. 

When using the Metadata setting, make sure that you start with 
the left column and work your way right. The fil er will search via 
the parameters in the left column fir t and then move to the right. 
In other words, it will take the results of the left column search and 
then fil er those results with the fil er settings to the right. (see 
screen shot for better explanation.)

When you fil er with the Metadata 
setting, you get numbers for how 
many images fit each esult. 

Above, the left column of the Metadata fil er area is set to search for all Flagged 
images. The second column is searching those flagged images or those that have 
a 5-star rating. The third column is searching all flagged, 5- tar images for those 
marked with the “Done” label. Each column narrows our search down further. 
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Metadata View Options When using the Metadata fil er, you have 
some options for how to view the search results when using cer-
tain types of data. For example, if you search by Date, you will see 
a tiny menu icon at the top right of the title bar.  If you click on this 
icon, you’ll get a menu where you can choose between a Hierarchal 

view or a Flat view. If 
you choose the Hi-
erarchal view, then 
the results will be 
grouped into larg-
er date ranges that 
you can click on to 
expand. This can 
present the search 
results in a much 
friendlier way. 

This hierarchal view is also available when fil ering your images 
based on location. Using the fl t view, every single location is list-
ed individually, and this can present too many results to search 
through. When using the hierarchal view, the results are catego-
rized into countries, which can be expanded to view cities, and so 
on. 

The Metadata options also al-
low you to search based on 
whether your images have 
been edited. When using the 
menu at the top of one of the 
Metadata columns, choose Edit 
and you will see, listed below, 
how many of the images have 
been edited and how many are 
unedited. 

Setting up Filter Presets If there are any searches that you use all 
the time, you can save all of the Filter Bar settings as a preset. To 
do this, fir t set up your Filter Bar the way you like it. Then click on 

Searching by date, the Flat view is on the left and  
Hierarchal view is on the right.

The Metadata fil er allows you to search 
images on whether or not they’ve been 
edited. 
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the little dropdown menu to the left of the lock icon. There will be a 
list of presets in the menu, but you want to click on the option that 
reads “Save Current Settings as New Preset.” You’ll be prompted 
to give your new preset a name and then click Create. Now, your 
preset will be available as an option in that menu. 

Searching Individual Folders  The Filter Bar is going to search the 
images in the folder or folders you choose from the left side of the 
Library Module. Up until now, we had “All Photographs” selected 
in the Catalog panel on the left and this caused the Filter Bar to 
search our entire image catalog. If you would like to search one 
particular folder, select that folder in the Folders panel. If you do 
this, there is a setting to be aware of. In the Library menu at the top 
of the interface, there is a “Show Photos in Subfolders” setting. If 
this is turned on, the Filter Bar will search all of the images in the 
selected folder as well as all of the images in subfolders of that 
folder. If this setting is turned off, the Filter Bar will not search the 
images in subfolders. 

Text Searches One of the other search options in the Filter Bar is 
the Text search, and this will allow you to search your images based 
on keywords and other text associated with the files. To quickly 
open the text search in the Filter Bar, use the keyboard shortcut 
Command+F (Ctrl+F on Win). 

The Filter Bar preset menu can be accessed at the top right side of the Filter Bar. 
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By default, the text fil er will search the text in “Any Searchable 
Field.” This includes the file name, caption, keywords, etc. Use the 
Text menu in the Filter Bar to specify what text should be searched. 
I find it most useful to search by Keyword. (Note that you need to 
have a good keyword system in place for this to work effectively.) 

When searching by keyword, you can enter more than one keyword 
into the search field, separated by commas, and Lightroom will 
search for images that are tagged with all the keywords you enter. 

Searching in the Keyword List An-
other way to search your images is to 
use the search field that can be found 
at the top of the keyword list (on the 
right side of the interface). Remember, 
this method will only work if you have 
implemented a good keywording sys-
tem. When you type in a search term, 
the list below will become limited to 
only the keywords that include that 
term. When the search results appear, 
you can hover your cursor over one of 
the results and then click on the right 

We’re using the text fil er menu to specify that the text search be limited to key-
words only. 

A Keyword List search
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arrow icon that appears to the right of the keyword name in order 
to view all of the images tagged with that keyword. 

Toggle a search on and off by using the keyboard shortcut Com-
mand+L (Ctrl+L on win).  This will switch between showing you the 
results of your search and showing you all of your images.

Extra Search Tips:

Change the search folder[s] 
Let’s say that you do a Text 
search and then decide that 
you’d like to limit that search 
to a particular folder or Col-
lection. You can go to the Folders or Collections panel and choose 
the folder you’d like to search, but when you do this, the Text search 
becomes cleared out and reset. If you don’t want this to happen, 
click on the little lock icon that appears above the search field.

Searches & Stacking Whenever you do any kind of search, Light-
room is going to ignore images that are not on the top of a stack. 
If you have a group of images that are stacked together, the search 
results will only recognize the images on the top of the stack. If you 
would like all of the images to be included in the search, you will 
have to expand the stack. If you stack your images a lot, you might 
want to expand all of the stacks within a folder before running a 
search. You can do this by going to the main menu at the top of 
the interface and choosing Photo > Stacking > Expand All Stacks. 

Invert Selection After doing a search, you can choose to view the 
opposite of the search results. To do this, go to the Edit menu and 
choose Invert Selection.

Stacking types of searches In the Filter Bar, you can use more 
than one of the sections at a time. For example, you can use the 
Metadata section and search for something like Date. Then you can 
click on the Text section and refine the results further by fil ering 
by keyword as well. 

Lock a search by clicking this icon.
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EXPERIMENT WITH THE FILTER BAR
Take it easy today. All you need to do is experiment with 
the Filter Bar at the top of the Library menu, set it up the 
way you like and then save a preset so you can quickly 
get back to those settings again in the future. Other than 
that, take the rest of the day off. 
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SLIDESHOWS
Lightroom gives you a few different options for presenting your 
work, and slideshows are one of them. There is an entire Lightroom 
module dedicated just to creating slideshows.

Impromptu Slideshows Before moving into the Slideshow module, 
know that there is a fast, on-the-spot way of showcasing a group 
of images in a slideshow. Make sure that the folder or Collection 
you want to present is active and then go to the Window menu 
and choose Impromptu Slideshow. Alternatively, you can use the 
keyboard shortcut Command+Return (Ctrl+Enter on Win). The Im-
promptu Slideshow will begin and it will display the images based 
on a specific set of settings. These are the settings we will work with 
in the Slideshow Module. 

The Slideshow Module Access the Slideshow module by clicking on 
“Slideshow” in the upper right corner of the interface. As with many 
of Lightroom’s other modules, you’ll find Templates on the left and 
settings on the right. Because there are so many settings to work 
with, I like to start on the left and browse the Templates until I find
one that will serve as a good starting point for my slideshow. Then, I’ll 
use the settings on the right to customize it. As you mouse over the 

Lightroom’s Slideshow Module 
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different templates, you will see a 
preview in the upper left corner. 
(Just make sure the Preview tab 
is expanded.) When you click on a 
template, it will load all of the set-
tings relating to the template on 
the right side of the interface. 

Let’s take a look at what the differ-
ent settings do so that you know 
how to customize your slideshow: 

PLAYBACK

This tab contains settings for how 
your slideshow will be played. At 
the top of the tab, you’ll choose 
a playback mode. Automatic will 
set the slideshow to play by itself. 
You just specify how long each 
slide should remain on screen and 
how long the transitions should 
take. The Manual setting will not 
auto-play. You’ll have to manually 
click to move to the next slide. 

Fit to Music If you have the music 
feature turned on, you will have 
some special options available 
within the Playback tab. One of 
them is the “Fit to Music” feature. 
If you turn this on, it will calculate 
how long it will have to keep each 
image on screen in order to make 
your slideshow the same length as 
the music.

The Template Browser can be found on 
the left side of the Slideshow Module. 

The Playback settings
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Audio Balance If your slideshow includes any video files, the Audio 
Balance slider will let you decide which audio you would like to dom-
inate. If you move the slider toward the video side, the audio from 
the video will dominate. If you move the slider toward the music 
side, the audio from the music will dominate. 

Pan & Zoom Turn this check box on if you would like the images to 
move and zoom slightly as they are being displayed. The slider be-
low will determine how extensive the movement will be.

Repeat Slideshow Turn this setting on if you would like the slide-
show to continue to replay by starting over after it finishes

Random Order Turning on this check box will play your images in a 
random order, and not the order that you have them in the selected 
folder or collection.

OPTIONS

This tab gives you settings for zooming, borders and drop shadows. 

Zoom to Fill Frame The “Zoom to 
Fill Frame” check box is something 
you’re going to want to pay attention 
to. It will determine whether your im-
ages will be cropped to fit the entire 
area within the margins or if they 
should be scaled down so that you 
see the entire image. 

Stroke Border The “Stroke Border” 
check box will create a frame, or 
outline, around your image. This can 
be useful to make the image stand 
off from the slideshow background 
when both the image and the back-
ground are light (or when both are 
dark). When you turn the check box 

The Options panel allows you to add 
stroke borders  and drop shadows.
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on, you will have access to the color picker, to determine the color of 
the stroke, and the Width slider, to determine how thick it should be.   

Cast Shadow If you turn this check box on, you will get a drop shad-
ow effect on the image. This won’t be useful if your slideshow back-
ground is black, but will be noticeable when you use a lighter back-
ground. When you turn the check box on, you will be given access 
to a series of sliders that will allow you to specify how the shadow 
should look. 

LAYOUT

The Layout tab contains the Margin set-
tings. There are sliders for the left, right, 
top and bottom margins, where you can 
specify how much space there should be 
on each side of the image. 

Link All When the “Link All” setting is 
turned on, all the sliders will move together 
and the margins will be equal on all sides. 

We clicked on the swatch next to the Stroke Border setting to get the color picker, 
where we can specify the color of the stroke that will outline each image.

The Layout settings
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Show Guides The “Show Guides” check box will make the gray guide 
lines visible or not visible. I like to keep these on to begin with in or-
der to get a better idea of where my margins are. 

Aspect Preview This setting determines whether the slideshow 
should be sized based on the shape of the computer screen you’re 
using or if it should be sized for a different type of screen. I will usu-
ally choose the 16:9 ratio if I am going to show the slideshow on a 
projector or a television.

OVERLAYS

Lightroom allows you to overlay things on your image slides. Here 
are the choices of what you can use: 

Identity Plate The Identity Plate is the textual or graphical image 
that goes in the top left of your Lightroom interface. If you custom-
ized your own Identity Plate, you can have it appear as an overlay 

The gray lines over the frame are the guides. You can toggle their visibility by using the 
“Show Guides” check box in the Layout tab. 
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on your slideshow. When you choose 
this option, you can manually move and 
scale it within the image window. As 
you move it around your image, you’ll 
see that an anchor line with a square 
snaps to different areas of your screen. 
This will allow you to specify where the 
Identity Plate will be anchored on ev-
ery slide, and the line will determine 
how it appears relative to each photo. 
In the Identity Plate preview within the 
Overlays tab, you can switch between 
your identity plates by clicking on the 
little arrow at the bottom right. Here, 
you can also create new Identity Plates 
by choosing the Edit option from the 
menu. 

If the Identity Plate is textual, you can 
use the “Override Color” check box to 
change the color of the text.

If the Identity Plate overlays your im-
age, you might want to use the Opacity 
slider to lower the opacity.

The Overlay options

The Identity Plate overlay option was turned on and we are positioning the chosen 
Identity Plate within the slideshow. 
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Watermark If you have any custom watermarks set up, you can also 
use these to overlay on your slideshow. When you turn the “Wa-
termark” checkbox on, you will get a menu that contains all of the 
watermarks you have created. If you would like to create a new one, 
choose “Edit Watermarks” from the dropdown menu. 

You can even get creative with how you use your watermarks. If you 
create a graphic that is basically an inverted shape, where the shape 
is a hole, you can use this as a watermark and fill the screen with it 
so that the image only shows through where the hole shape is.  

Rating Stars Turn this check box on if you’d like an overlay of the rat-
ing you have applied to the image. Just like with the Identity Plate, 
you can drag the stars around to specify where they should go. 

Text Overlays When you choose this option, you can use the text 
field at the bottom of the image window to add text for each slide. 
You can also click the dropdown menu and tell it to display different 
kinds of info, like exposure, date, etc. 

BACKDROP

This tab contains the settings for controlling the background of your 
slideshow. You can choose between three different kinds of back-
grounds: A Color Wash (which is like a gradient), a Background Im-
age (where you specify the image) and a Background Color (this is 
simply a solid color.)

Color Wash This setting adds a color gradient to the background. If 
the Color Wash check box is on, you will have access to the settings 
that control the color, the opacity and the angle of the gradient.

When using the Text Overlay option, use the menu below the image window to deter-
mine what kind of text should be displayed. Here, we chose Custom Text. 
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Background Color This setting is for when you just want a simple 
background color. When you turn the check box on, you can use the 
color picker to specify the color. 

Background Image You can also use a photo as the background 
for your slideshow. If you choose this option, you can simply drag a 
photo into the Image box within this setting. I like to use photos of 
simple textures as the background image for slideshows.  

TITLES

You can think of Titles as your start screen 
and your end screen.  If you turn the check 
boxes on for these screens, you will be able to 
choose the color of the screen and whether or 
not it should display an Identity Plate. You can 
choose from your pre-made Identity Plates  
or you can opt to “Edit [Identity Plates]” and 
create a new one. 

In the case of my ending slide, I would proba-
bly create one that has my website on it. For 
example, “To see more, visit www.yourweb-
sitehere.com.” 

The color picker is being used to set the background color of the slideshow.

The Titles options
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MUSIC

Lightroom allows you to choose 
a song (or songs) to play along 
with your slideshow. At the top 
left of the Music tab, you will have 
to turn the little “light switch” in 
order to add songs. Then, click 
the little plus symbol (+) and you 
will be able to navigate to your 
desired song file on your hard 
drive. You can choose more than 
one song, and all of your chosen 
songs will be displayed as a list 
within the Music tab. 

PREVIEW & PLAY 

You can watch your slideshow at 
any time during the customization 
process using the two buttons 
in the bottom right of the inter-
face. The Preview button will play 
your slideshow without hiding 
the Lightroom interface. The Play 
button will take over your screen, 
playing the slideshow full screen. 

SAVE A TEMPLATE

Once you’ve worked your way through all of the slideshow settings, 
you might want to consider saving these settings as a Template so 
that you can use them again on another slideshow in the future. 
You can do this by clicking the + symbol at the top of the template 
browser on the left side of the Slideshow module and then giving 
your new template a name. 

Use the Music settings to add songs to 
your slideshows.

The Preview and Play buttons allow 
you to watch the slideshow at any time 
during the editing process.
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EXPORTING THE SLIDESHOW

Once you’re completely done with your slideshow, you can export 
it, either as a PDF file or as a video fil . You will find those options in 
the bottom left side of the interface. 

CREATE SAVED SLIDESHOW 

Once you create a slideshow that you really like, you can save it for 
use in the future. That means that it will play with the same images, 
music, settings, etc. If you click this button, you’ll be prompted to 
give the slideshow a name and then click Create. Then your slide-
show will be available in the Collections list on the left side of the 
interface, both in the Slideshow module and in the Library module.

SETTING THE DEFAULT, IMPROMPTU SLIDESHOW

In the beginning of this lesson, we men-
tioned that you can quickly play an on-the-
spot slideshow by going to the Window 
menu and choosing Impromptu Slideshow. 
When it plays, it will be using the template 
you have designated as your default tem-
plate. Assign a template as the default by 
right-clicking on its name and choosing “Use for Impromptu Slide-
show” from the menu that pops up. A little plus symbol will show up 
next to the name, indicating that it is your default slideshow. 

Create a Saved Slide-
show by clicking the 
button above the image 
window. After you’ve 
created a Saved Slide-
show, it will appear 
within the Collections 
list and you can play 
it by clicking the little 
right arrow to the right 
of the Slideshow name.

The plus symbol represents 
the default slideshow.
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TIMELAPSE IN THE SLIDESHOW MODULE
This is something that Lightroom wasn’t really designed to do, but 
actually lends itself to very well. We can use the settings in the Slide-
show Module to create a timelapse video.  

Start with a template where the image fits the entire screen so you 
don’t see any background area. Then, go to the Titles panel on the 
right side of the interface and make sure that the Intro and Ending 
Screens are turned off. 

Now we need to make sure that this 
slideshow will play as fast as it possi-
bly can. Go to the Playback panel and 
move the Crossfades slider all the 
way to the left, ensuring that there 
will be no transitions between slides. 
Then move the Slide Length slider all 
the way to the left. This sets the slide 
length to one second. One second 
is still going to be too long, so we’re 
going to have to “hack” Lightroom in 
order to get faster playback. 

Save these current settings as a new template by clicking the plus 
sign icon to the right of the Template Browser header. Give the tem-
plate a name that you’ll remember and then click the Create button.  
Now the template will appear in the Template Browser. Right-click 
on it and choose Export from the menu that pops up. Save it to a 
location that you’ll remember. 

Navigate to the exported file s location and you 
will see that it ends with the extension .lrtem-
plate. You’ll need to be able to edit this file as a 
text fil , so change the extension to .txt. Dou-
ble-click on the file to open it in your computer’s 
default text editor. The text will consist of a lot of 
code, and you’ll want to look for the Speed set-
ting. To search the document, use the keyboard 

In the Playback panel, the Slide 
Length and Crossfades sliders are 
moved all the way to the left.  

The template fil
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shortcut Command+F (Ctrl+F 
on Win) and type in Speed. 
The Speed entries will become 
highlighted and you’ll want to 
change the speed setting from 
1 to .03336670003 (this equals 
about 30 frames per second, 
29.97 to be exact). Save and 
close this text file and then 
change the file extension back 
to .lrtemplate. 

Back in Lightroom, go to the Template Browser, right-click on any 
one of the templates and choose Import from the menu that ap-
pears. Navigate your hard drive to the file you just saved and click 
Import. When the template is loaded into the Template Browser, 
you can rename it to something memorable. We used “Time Lapse 
@29.97FPS.” 

To export your images as a 
timelapse, go to the Filmstrip and 
make sure that all of the timelapse 
images are selected. You can use 
the “Use” menu in the Toolbar be-
low the image window to speci-
fy whether the slideshow should 
use all the photos in the Filmstrip 
or just the Selected Photos. Final-

ly, make sure the timelapse template is selected and then click the 
Export Video button. You’ll be prompted to give the timelapse a 
name and choose the size. After it’s exported, the file will play back 
as a timelapse. 

The Speed entry is being changed.

The Use menu in the Toolbar below the 
image window is used to determine which 
images will exported with the slideshow.
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CREATING BOOKS WITH LIGHTROOM 
The Book module of Lightroom allows you to design custom books 
with the images from one of your Collections. You can even have the 
book printed from right within Lightroom, using Blurb, a company 
that prints and binds custom book projects. Alternatively, you can 
have your book exported as jpegs or a pdf if you would like to print 
with a different service. 

Select the Folder or Collection that contains the images you’d like 
to use in your book. If you want to use images from several different 
folders, it’s a good idea to take those images and place them into 
a Collection as this will make it so you don’t have to move between 
modules while creating your book. Open the Book Module by click-
ing on “Book” in the upper right of the interface. Within the Book 
module, the settings will be inside the panel on the right and your 
Collections list will be on the left. The main window is where you will 
see your book layout. 

Lightroom’s Book Module
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PREFERENCES

Before starting, you’ll want to start by setting some preferences. 
From the Book menu at the top of your screen, choose Book Pref-
erences. A dialog box will appear with some dropdown menus and 
check boxes.

Default Photo Zoom One of 
the fir t things you’ll want to 
do is specify whether your 
images should zoom to fill
the frames (where your im-
ages will be cropped to fill
the image windows) or zoom 
to fit the frames (where your 
images will be scaled down 
so there’s no cropping). The 
dropdown menu is called 
“Default Photo Zoom.” I like 
to fit my images so that they 
appear as I intended, with no 
cropping. 

Start New Books by Autofilling This means that Lightroom will au-
tomatically populate your book using the images from your chosen 
Collection. Note that you can still customize your book even if you 
have this setting turned on. If you keep this check box turned off, 
you will manually populate the book yourself. 

View Options You have several different 
viewing options for how your book will 
be displayed in the main window. First of 
all, you may see some text in the upper 
left corner of the window, which includes 
the size of your book, how many pages 
it has and the estimated cost (if printed 
with Blurb). If you would like to hide this 
info, go to the View menu and turn off 
the “Show info Overlay” check box. 

Use the View Options within 
the Book Preferences to view 
or hide the info overlay, shown 
above.

The Zoom option within the Book Preferences
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The options for how the book pages 
will be displayed can be found in the 
lower left of the main book window. 
You can choose between viewing mul-
tiple spreads at once, a single spread 
or a single page. If you are viewing 
multiple spreads, you can control how 
large they are by using the Thumb-
nails slider at the bottom right of the 
main window. If you’re viewing a sin-
gle page or a spread, you can move 
between pages by using the arrow 
buttons below and center of the main 
window. 

BOOK SETTINGS

The panel on the right side of the 
Book Module contains all of the 
settings for designing your book. 

Book settings Here, you can de-
cide whether to output the book 
to Blurb, a pdf or jpeg files. Once 
you select one of these options, 
you’ll get a series of settings per-
taining to that option. For exam-
ple, the settings for Blurb include 
size, paper type, cover type, etc. 

Auto Layout The Auto Layout 
tab gives you the options to clear 
your current layout or generate 
an auto layout (like the setting in 
the Preferences dialog box.)

The page view options can be found 
below the main image area.

The Book Settings panel is where you 
choose the book format, size, etc. 

The Auto Layout options
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Page The settings in 
the Page tab will let you 
choose individual settings 
for your pages. You can se-
lect a specific page layout 
by using the right-pointing 
arrow and selecting one 
from the pop-out menu.  
Click the “Add Page” but-
ton to add that page to 
your book. In this tab, 
there is also a check box 
for page numbers. If you 
turn that on, you will be 
given the option of which 
corner you would like the 
page number to appear in.

Guides In this tab, you can decide whether you want to see the 
guides for your pages and you can use the check boxes to specify 
which types of guides you will see. I find that the “Text Safe Area” 
guides are useful for printing with Blurb. These will give you a box 
around your page and all important elements should be kept inside 
that box to make sure they wont be cut off in the trimming process. 

Cell If you have a 
particular photo lay-
out and you feel that 
the photos are too 
close together, you 
can click on the pho-
to and then drag the 
Padding slider within 
the Cell tab and this 
will put some space 
around it. 

The Page panel allows you to choose a layout for 
each individual book page.

The Cell panel contains the Padding slider, which can be 
used to add space around a single image.
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Text You can also add text to your different layouts. If you would like 
to do this, turn on the “Photo Text” check box within the Text tab. 
Use the dropdown menu at the right to specify what kind of text 
you want to appear. You can choose custom text or various other 
kinds of image info (taken from the metadata). The offset slider will 
determine how far the text should appear from your photo. In the 
main window, you can drag the text box above or below the photo, 
and use the text field to type in your desired text (if you chose the 
“custom text” option). 

The Page Text option means that the text will be attached to a page 
instead of to a photograph. If you turn this check box on, a text field
will appear at the bottom of the page. You can enter in your text and 
drag the text wherever you would like it to appear on the page. 

Type If you want to control the appearance of the text, you would 
use the controls in the Type tab. Note that you would have to have 
some page text already added in order for these settings to be ac-
cessible. 

The Type settings in Lightroom are going to be very similar to those 
in other programs. You have settings to control the font, color, size, 
tracking, etc. At the bottom of this panel, you have options for how 
the type should be aligned (left, right, top, etc.). 

The Text settings 
are being used to 
add Photo Text 
(directly adjacent 
to the image) and 
Page Text (on the 
top or bottom of 
the page).
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Background You can also have a background on your book’s pages.   
At the top of this tab, there is a checkbox for “Apply Background 
Globally.” If this setting is turned on, the background you choose will 
be added to every page in your book. If you turn it off, it will only 
be added to the selected page.  Within the Background tab, you 
can drag an image that you’d like to use as your background into 
the preview window. Alternatively, you can choose from Lightroom’s 
background templates by clicking on the little down-pointing arrow 
to the right of the preview window. A menu will appear that includes 
a few different categories of background templates that you can 
choose from. You can also turn on the “Background Color” check 
box and use the color picker to select a solid color to use as the 
background for your page[s]. 

The Background 
settings can be used 
to set the page back-
grounds as imag-
es, colors or one of  
Lightroom’s custom 
background templates 
(shown).
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Populating the Book Because each book is template-based, each 
page is using a preset for how to display the images. If you would 
like to change the preset used, hover your mouse over a page and 
click on the little down-pointing arrow on the bottom right. A menu 
will appear where you can select a different layout. The options at 
the top allow you to fil er the different types of layouts. 

Drag an image directly from the Filmstrip into the book page and the 
image will be placed there. To move images around within the lay-
outs, you can simply click and drag them to the frame where you’d 
like them to appear. Use the Zoom slider to make the image larger 
or smaller within the frame. 

In the film strip at the bottom, you’ll notice that some (or most) 
images have numbers on them. That number represents how many 
times that image was used in the book. 

Left: An image is being dragged from the Filmstrip directly onto a book page. 
Right: The Zoom slider is being used to size the image within the frame.

The numbers above 
the image thumbnails 
indicate how many 
times they are used in 
the book.
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After you’ve added images to a page, you can double click on the 
page to make it fill the window. Alternatively, you can use the single 
page view or spread view icon at the bottom of the main window. 
When looking at a single page, you can control the zoom of each 
image by clicking on the image and then dragging the Zoom Slid-
er that appears. You can also right-click on the image and choose 
“Zoom Photo to Fill Cell.”

EXPORTING A BOOK

After you’re finished creating your book, you can export it by click-
ing the Export button in the bottom right corner of the interface. 
The text on the button will be different, depending on what type of 
book you chose in the Book Settings. If you chose to create a pdf, 
the button will say Export to PDF. 

You can also save the book within Lightroom (for later viewing or use) 
by clicking the “Create Saved Book” button at the upper right of the 
main window. You’ll be prompted to give the saved book a name. I 
also turn on the check box for “Include only saved photos.” Click the 
Create button. Then, the book can be found within the Collections 
tab, exactly as you created it, with all the settings and all the images 
you used. The number to the right of the name indicates how many 
images are used in the 
book. To view the book 
or edit the book fur-
ther, hover your cursor 
over the book in the 
Collections panel and 
then click on the little 
arrow that appears to 
the right of the name.

Book layout tip One of the main constraints with Lightroom’s Book 
module is that you are limited in the number of template layouts you 
can use on your pages. Here’s a trick for getting more layouts. Go 
to the Print module and create your layout there. The Print module 

If you created a Saved Book, it will appear within the
Collections panel.
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has many more layout templates, including some where the images 
overlap each other. You can also use the Custom Package option, 
within the Layout Style panel, making sure that the page size match-
es the book page size, and create a completely custom layout. Once 
you have a layout with photos in it, export that page as a jpeg fil . 
Then load that jpeg file into the Collection you’d like to use for your 
book and use it as a full-page layout. 
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CREATE SLIDESHOW TEMPLATES
In the slideshow module, experiment with the 
settings and make slide show templates for any 
kind of slide show you desire. Here are a few 
ideas, but feel free to deviate and make whatev-
er fits your fancy. 

Simplistic Black: Black background, no text or music with the image 
fitting the screen all the way to at least two edges, but not cropping 
(meaning size to fit, not fill). Once you have this one saved, right-click 
on its name within the template list and choose Use for Impromptu 
Slideshow so that it will be used anytime you choose Window>Im-
promptu Slideshow or type Command-Return (I’m assuming that’s 
Ctrl-Enter on a PC, but I’m not sure, so look in the menu to double 
check for yourself)

Portfolio: For this slideshow consider adding a Intro Screen (in the 
Titles section) that includes your name which will appear at the start 
of your slide show and an Ending Screen that includes your web site 
address to finish the slide show. You might also want to include music 
with this one. 
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Framed with Name: Use a white background (or a wash), a stroke 
border around the image, add space around all sides of the image so 
it does not fill the screen. Add extra space at the bottom and then in-
clude an Identity Plate of your name (you can click the down-pointing 
arrow on the IP preview to edit it) that should appear centered below 
the image so people can see it the entire time your slide show is run-
ning. 

Custom: Think through how you’d like to present your images and 
create a few more templates so that you’re always ready to show your 
images in the style you prefer. 

SHOWCASING YOUR WORK WITH SLIDESHOWS & BOOKS  |  305

IP change to Identity Plate



DAY 15
WEEK3

Spend some time getting comfortable with Lightroom’s Book module 
by creating a 16-page portfolio of your photography. Start by organiz-
ing your images into a collection, then, while viewing that collection, 
switch to the Book module. Continue by setting the Book pop-up 
menu in the Book Settings area to PDF, choose the size you desire and 
then click the Clear Layout button under the Auto Layout section to 
start from scratch. Now drag the image you’d like to use for the cover 
and back to the appropriate page in your layout. At this point you’ll 
only have page 1 to fill, so click on the down-pointing arrow  in the 
Page section to choose the type of page you’d like to add and then 
click the Add Page button and then drag the images you’d like to 
use onto the page. Repeat this process until you have a book that is 
at least 16 pages long. When you’re finished, press the Create Saved 
Book button near the upper right of your screen to make your proj-
ect show up in your collections list so you can easily return to it in the 
future. That should give you a good amount of experience laying out 
books in Lightroom.  

CREATE A 16-PAGE PORTFOLIO BOOK
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IMAGE ADJUSTMENTS: START-TO-FINISH
In this lesson, we’re going to walk through the image adjustment 
process on a variety of photographs. This will give you a better feel 
for how Lightroom’s adjustment tools can be used together in re-
al-world situations in order to correct and enhance a raw capture.

This guide will display the “before” version, followed by the sequen-
tial changes that were made in the Develop Module, and then the 
end result. 

Image 1: Flower Petals on Stairs
The Goal: To draw attention to the fl wer petals and the highlights 
on the stairs. 

Image 2: Burma Temple Scene
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The Goal: The image was originally hazy and foggy, so the goal was 
to increase contrast, cut through the haze and make the image pop.
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Image 3: Thailand Buddha Statue
The Goal: With this image, I really wanted to make the statue stand 
out from the background. 

Crop
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Post-crop vignette
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Image 3: Blue Swallow Motel
The Goal: Pull detail out of the highlights and shadows and refine the 
colors.  

Crop
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8 instances of the Adjustment Brush
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Today’s homework involves experimenting with the images contained 
in the homework catalog. Each of the images in this catalog has Smart 
Previews that will allow you to adjust the images even though you 
do not have the originals. I would not import this catalog into your 
main catalog file because things can start getting cluttered if you do. 
Instead, use this catalog by choosing File>Open Catalog and when 
you’re done working on it, choose File>Open Recent and choose the 
name of the catalog you were working on previously. 

Each of the images in today’s catalog has a Snapshot attached. That 
will allow you to choose any image, switch to the Develop module and 
then inspect how each image has been adjusted. I’d suggest that you 
toggle the light switch-like icon to the left of each section of the de-
velop module to see how it affects the image. When you find a section 
that causes a dramatic change in the image, then expand that section 
and see if you can learn from the adjustment that is being applied. You 
can also click the Reset button in the lower right to bring that image 
back to its unadjusted state and then adjust the image from scratch. 

EXPERIMENT WITH IMAGE ADJUSTMENTS
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How often do you get the change to inspect the exact adjustment 
settings someone used to get to their end result? This is a unique op-
portunity to get a glimpse into how I adjust images. You’ll find that on 
some images, only basic adjustments were used, while on others, just 
about every feature seems to have been used. 

Many of these images have their full adjustment history included. You 
can find a list of the steps that were performed to get to the end result 
shown by inspecting the History area on the left side of the Develop 
module. Not every step will be easy to understand, but you can hover 
over a history step and then watch the Navigator above to see what 
the image looked like back when that step was being applied. If you 
start at the bottom of the History and slowly hover your mouse higher 
and higher, you can see the progression from start to finish. 

Note: If you see steps in the History that show a feature being repeat-
edly enabled and disabled that is usually a sign that I was toggling the 
light switch icon next to a section to see if I liked its effect on the im-
age. 
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If you’ve clicked the Reset button and attempted to optimize one of 
the images, then do the following to compare it to the result that is 
contained in my snapshot. 
1) Click the YY icon near the bottom left of the Develop module to
enter Before/After view.

2) Right-click on the snapshot and choose Copy Snapshot Settings to
Before. At that point you can continue to adjust the image while you
compare it to the result I had achieved. When you’re done, click on the
icon to the left of the YY icon to only see the end result.
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PHOTOSHOP ROUND-TRIPPING
There are some image adjustment tasks that are just too complex 
for Lightroom and that’s when you’d need to move your image 
into Photoshop. After you’re done with the Photoshop work, you’ll 
want to seamlessly get your image back into Lightroom, and that 
is what this lesson is about. We’re going to cover how to effectively 
get your image from Lightroom to Photoshop and back, as many 
times as you need, while still maintaining the ability to adjust the 
image at any stage. 

WHY BRING AN IMAGE TO PHOTOSHOP?

I, personally, like to do at least 70% of my image processing in 
Lightroom. With Lightroom, I like that the changes are saved as 
text, which takes up very little space on the hard drive. I love that 
you can copy settings from one image to another and that there is 
a full history of the image, where you can easily revert to any stage.

In Photoshop, the moment you open an image and make changes, 
you’re going to have a much larger fil , especially if there are layers 
involved. Also, not everything in Photoshop is undoable, unless you 
take certain steps to keep it that way.

There are some tasks, however, that Lightroom is incapable of, or it 
would be extremely inefficien to do them in Lightroom (like com-
plex retouching or certain creative effects). That’s when we’ll move 
to Photoshop.

BASIC ROUND-TRIPPING

To take an image from Lightroom to Photoshop, make sure the im-
age is active in Lightroom, go to the Photo menu and choose Edit 
in > Photoshop. Alternatively, you can use the keyboard shortcut 
Command+E (Ctrl+E in Win). The image will open in Photoshop 
(providing you have Photoshop installed on your computer) and 
you can do whatever work you need to do. 
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To get the image back to Lightroom, simply close the file and when 
the dialog appears asking whether you’d like to save the image, 
choose Save. 

After bringing an image from Lightroom to Photoshop and back, 
there will be two versions of the fil . This is because the original 
version is a raw file and you cant save things back into a raw file or 
update what’s already there. Instead, Photoshop creates either a 
tiff or psd file format, and that is what is saved back into Lightroom. 

To move an image into Photoshop, we are going to the Photo menu and choosing 
Edit In > Edit in Adobe Photoshop. 

From Photoshop, we 
closed the adjusted file
and this dialog appeared. 
We are choosing to save 
the changes. 
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THE DETAILS OF ROUND-TRIPPING

Preferences There are some Lightroom preferences for how imag-
es are managed when moved to other programs and you can find
them by going to the Lightroom menu at the top of the screen and 
choosing Preferences. (In Windows, it will be found under the Edit 
menu.) In the Preferences dialog, click on the External Editing tab. 

At the top of the dialog, there will be a series of settings, and these 
pertain to how Lightroom will open images in your current version 
of Photoshop. Let’s look at each of these settings:

• File Format: This is where you choose whether your image
should be saved in a tiff or Photoshop file format when it moves
to Photoshop.

• Bit Depth: You have the choice of working in 8-bit or 16-bit. If
you don’t need to make radical brightness or color changes to
your images, then 8-bit is generally sufficient Your file size will
also be smaller. If you ARE going to be making radical changes
to the image, or if you will be retouching across areas that are
smooth (like skies), then it’s better to use 16-bit. Your file size will
be twice as big, but you will have thousands of brightness levels
(as opposed to the 256 with 8-bit), which are useful for extreme
adjustments.

• Color Space: The color space determines how vivid of a color
range we can use. The sRGB  option is the most limiting color
space, but the vast majority of images you see on the Internet
are in sRGB. The Display P3 option is designed to display im-
ages on an iPhone or iPad. Use Adobe RGB if you print your

Use Lightroom’s External Ed-
iting Preferences to specify 
how files should be b ought 
into Photoshop.
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own images or if you send your images off to other people to 
be printed (and you’ve confirmed with the printer that it’s the 
appropriate color space). ProPhoto RGB is for people who want 
to push their colors to the limits, who print their own work and 
have a solid understanding about how the color space works. 
It’s not for beginners. 

• Resolution: There is no resolution with a raw fil , but when the
image moves to Photoshop, it needs a resolution. The setting
you use here will be dependent on how you use your images,
but 240 is usually fine or most applications.

• Compression: This menu is only available when you choose the
tiff format. You have the choice of None or ZIP. With ZIP, the
compression creates a smaller file size, but the quality is still the
same. The only negative is that the file may take a little longer
to save.

Lightroom Preferences: Edit in Other Application We already cov-
ered that, in order to move an image into Photoshop, you would go 
to the Photo menu and choose Edit In > Edit in Adobe Photoshop. 

There is, however, anoth-
er option under the Edit In 
menu, right below the Edit 
in Photoshop option, and 
that is to Edit in Other Ap-
plication. What application 
will be used here depends 
on the settings you have 
specified in your Preferenc-
es. Under the External Ed-
iting tab in the Preference 
dialog, there is a group of 
settings for Additional Ex-
ternal Editor. This is where 
you choose what the “Oth-
er Application” should be. 

You can set up external editing preferences for 
another application by using the settings at the 
bottom of the File Handling Preferences.
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Personally, I don’t use any other applications, so I create a second 
instance of Photoshop, using different settings. This way, I have 
one external editing option that has Photoshop open the image in 
Adobe RGB and another editing option that has Photoshop open 
the image in ProPhoto RGB. 

Photoshop Preferences In Photoshop, there are also some prefer-
ences regarding saving files that you should pay attention to, To 
access Photoshop’s preferences, go to the Photoshop menu and 
choose Preferences > File Handling. (In Windows, this will be un-
der the Edit menu.) In the Preferences dialog, you might want to 
change some settings under the File Compatibility section. I like 
to turn off the “Ask Before Saving Layered TIFF Files” so that it 
doesn’t present me with a dialog box every time I save. 

I will also set the “Maximize PSD and PSB File Compatibility” menu 
to Always. This will save a fl ttened version along with all of your 
layered files and therefore will enable other programs [that don’t 
understand layers] to read the fil . 

In Photoshop’s File Handling Preferences, pay attention to the “Ask Before Saving 
Layered TIFF Files” setting and the “Maximize PSD and PSB Compatibility” menu.
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Edit Original After you move an 
image from Lightroom to Pho-
toshop and back, the newly-im-
ported file will have the same file
name, but it will end with -Edit 
and your chosen file extension. 
Now, if you choose to bring that 
file back into Photoshop, you’ll be 
presented with a dialog, asking you if it should edit the original or 
a copy. I generally choose to Edit Original. When you’re done edit-
ing in Photoshop, follow the same procedure. Close the document, 
and when the dialog box appears, choose to Save the fil . Back in 
Lightroom, that file will be updated. You can move it back and forth 
between Lightroom and Photoshop as many times as you like, and 
it will continue to update that same file (as long as you choose to 
“Edit Original”).

Now, let’s say that you 
edit an image in Photo-
shop, bring it back into 
Lightroom and then ap-
ply further adjustments 
in Lightroom’s Develop 
Module. Lightroom saves 
all changes you make to 
an image as a separate 
text fil . This means that 
the layered Photoshop 
file remains unchanged. 
If you take that file and 
move it back into Photo-
shop, you will now need 

to be careful in deciding how the file should be handled. If you 
choose “Edit Original” from the dialog that pops up, Photoshop will 
open the original file and it will not reflect the adjustments made 
in Lightroom. That’s because the original file remained unchanged. 

After moving an image from Lightroom 
to Photoshop and back, the new file
will have the same file name but will
end with “Edit.”

When you move an image from Lightroom to Pho-
toshop more than once, you’ll be asked what kind 
of file o edit. 
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The adjustments were 
saved as a separate text 
fil . If you edit the im-
age in Photoshop, close 
and save the fil , it will be 
moved back into Light-
room and the Photoshop 
changes will be visible, 
but the Lightroom ad-
justments are not. You 
will need to manually tell 
Lightroom to apply those 
settings. To do this, open 
the History panel on the 
left side of the Develop 
Module  and click on the 
top-most step in the His-
tory list. Lightroom will 
then re-apply all of the 
adjustments.

Edit a Copy When moving an image from Lightroom to Photoshop, 
you can also choose the “Edit a Copy” option. This will create a 
second version of the original fil . After editing the image in Pho-
toshop and then saving it, there will be a version from the fir t time 
you moved it into Photoshop and there will be a version from this 
most recent edit. The latter version will have the word “Edit” at the 
end twice. 

To reapply edits that were made in Lightroom to 
an image that was moved to Photoshop, click the 
top item in the History panel. 

This image was 
moved into Photo-
shop twice. The ver-
sion on the right is 
the original raw fil . 
The version on the 
left is from the fir t 
Photoshop edit. The 
middle version is the 
second Photoshop 
edit. The filename
ends in Edit-Edit.
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Edit a Copy with Lightroom Adjustments When moving an image 
from Lightroom into Photoshop more than once, there is also the 
option to “Edit a Copy with Lightroom Adjustments.” When you 
do this, any adjustments you made to the image will be reflec ed 
in Photoshop. However, it will be a fl ttened fil , without any layers 
you may have created in the last Photoshop edit. 

Choosing Save As from Photoshop In previous examples, when 
moving an image back into Lightroom (from Photoshop), we sim-
ple closed the file and chose to save it. We can also go to the File 
menu and choose Save As (instead of Save). If you do this, the Save 
dialog will appear and you can give the file a different name if you 
choose. You might do this if you don’t want the file to automatical-
ly end with ”Edit-Edit.” The save location will automatically be the 
same folder that the file originated. If you’re saving as a TIFF, the 
TIFF Options dialog will appear. For the Image Compression set-
ting, I usually choose ZIP. The settings on the right side of this dialog 
don’t really matter unless you’re using really old software. The Lay-

er Compression set-
tings will only be 
available if your 
document contains 
layers and you can 
choose the ZIP op-
tion if you would like 
a smaller file size. 
After clicking the 
OK button, the new, 
renamed file will au-
tomatically appear 
back in Lightroom.

If you choose the Save As command (in Photoshop) and 
are saving as a TIFF, you will get this TIFF Options dia-
log where you can choose compression settings. 
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Clean up the Lightroom Folder After editing an image multiple 
times, you may accumulate multiple versions of the image in your 
Lightroom folder. Personally, I prefer to see only the version I con-
sider to be my final. To clean up my folder, I will create a subfolder 
called Support Images. This 
is where I’ll place the original 
raw file and any other ver-
sions I used in the creation 
of the final. This folder is also 
where I’ll place the individual 
captures that created a final
HDR or panorama. 

Another way to make it so you don’t see multiple versions of an 
image at once is to change a setting in the External Editing Prefer-
ences (Lightroom menu > Preferences > External Editing). At the 
bottom of the Preferences dialog, there is a “Stack with Original” 
check box. If you turn this on, then Lightroom will create a stack 
of the various versions of your image. You can then expand and 
collapse the stack to view and hide the versions. This dialog also 
contains a file naming section (at the very bottom) where you can 
use the Template menu to decide what is added to the file name 
after an image is edited in Photoshop. By default, the word “Edit” is 
added but you can choose the “Edit…” option at the bottom of this 
menu, you can change it to something else. 

I place the original image and all other ver-
sions leading up to the final in a sub older 
called Support Images.

In the External Editing section of Lightroom’s Preferences dialog, the Stack with 
Original setting and File Naming settings can be found at the very bottom. 
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Hold Off on Cropping & Vignetting There are some things I will not 
do in Lightroom if I know I’ll be sending the image into Photoshop. 
Those things are cropping and vignetting. That’s because these are 
things that are difficul to undo or change in Photoshop. I will hold 
off on those things until the image is back in Lightroom because 
then I know I’ll be able to adjust or remove those settings as many 
times as I like.

ROUND-TRIPPING WITH  MULTIPLE IMAGES
Open Multiple Images as Layers in Photoshop One of the things 
that Lightroom does not have is the ability to composite more 
than one image. For a task like this, we’ll need to use Photoshop 
and we’ll need to move more than one image from Lightroom into 
a single Photoshop document. First, select all of the images you 
want to composite, go to the Photo menu at the top of the screen 
and choose Edit In > Open as Layers in Photoshop. You will end up 
with a single Photoshop document where there will be a separate 
layer for each image. 

Two images were selected in Lightroom and we’re choosing to Open as Layers in 
Photoshop.
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You can then do any compositing work necessary. In the video ex-
ample, we had monkeys in two images and we wanted to take a 
monkey from one image and add it to the other image. I used a 
layer mask to do this, painting on the mask to make the layer visible 
only in the area where the monkey was located.  

When you’re done compositing or doing any Photoshop work nec-
essary, you can close the image and tell Photoshop to save it (when 
the dialog box pops up). Alternatively, you can go to the File menu 
and choose Save As so that you can give the file a different name. 
Make sure that it’s being saved back into the same folder that the 
images originally came from so that Lightroom will recognize it. 

Open an Image as a Smart Object  You can also move an image from 
Lightroom to Photoshop so that it will automatically be a Smart Ob-
ject. A Smart Object will be a layer that contains a full copy of the 
original raw file and it will allow you to change the develop settings 
afterwards, in Photoshop. To open 
an image as a Smart Object, se-
lect the image in Lightroom, go to 
the Photo menu and choose Edit 
In > Open as Smart Object in Pho-
toshop. When the image opens 
in Photoshop, there will be a little 
icon in the bottom right corner of 
the thumbnail in the Layers panel 
and this indicates that the layer is 
a Smart Object. 

There are several advantages to using Smart Objects, but because 
the topic is beyond the scope of this class, I’ll just quickly mention 
a few:

• If you double-click on the layer thumbnail, the image will open
in Camera Raw and it will show the various adjustment settings
that can be applied to the image. These are the same settings
that you see in Lightroom’s Develop Module. In Camera Raw,
the various adjustment categories are split into tabs, which run
across the top of the adjustment panel on the right side of the

A Photoshop layer can be identified as
a Smart Object by the little icon that 
appears in the bottom right corner of 
the layer thumbnail.
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screen. Click the different tab icons to switch between adjust-
ment categories.  Make any adjustments you need here and then 
click the OK button in the bottom right. The layer will then up-
date back in Photoshop’s main interface. Just know that editing 
this way does not modify the original raw file in Light oom. 

• If you ever apply a fi -
ter, that fil er will appear
as a Smart Filter, which
is not permanent in the
way a fil er would be if
applied to a regular lay-
er. Below the image lay-
er thumbnail in the Lay-
ers panel, there will be 
an indented Smart Filter thumbnail. Double-click on the name 
of the fil er at any time to modify the fil er settings. 

• You can use the Transform command and it will not be perma-
nent in the way it would be had you transformed a regular layer.

You can also open an image as a Photoshop Smart Object by click-
ing on the image in Lightroom and dragging directly into an ex-
isting Photoshop document. The image will automatically open in 
Camera Raw, where you can click the OK button in the bottom 
right and the image will open in Photoshop as a Smart Object. 

Additional Tips on Photoshop Round-Tripping
Updating the preview If you ever edit an image in Photoshop, bring 
it back into Lightroom and don’t see the changes you made in Pho-
toshop, try the following. Open the image in the Develop Module 
and click within the image window to zoom in and view the image 
at 100%. This forces Lightroom to read the full, high resolution pic-
ture (instead of a saved preview) and it should update the changes 
and generate a new preview.

When a fil er is applied to a Smart Object, it 
will be added as a Smart Filter and will be listed 
below the image layer in the Layers panel.
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Original file required In order 
for Lightroom to be able to 
move an image into Photoshop, 
it needs to have access to the 
original raw fil , which means 
that the hard drive containing 
the image must be connected 
to your computer. If you’re only 
working with previews, the op-
tion won’t be available. You can 
tell whether the original file is 
available by looking at the text 
directly beneath the histogram 
chart. If the text includes “Orig-
inal,” then Lightroom does have 
access to the fil . 

If Lightroom Doesn’t Auto-Import For various reasons, there will 
be instances where Lightroom will not automatically import the 
image you edited in Photoshop. As long as you saved the file into 
the same location as the original image, you can quickly fix this. Go 
to the folder that’s supposed to contain the image in Lightroom’s 
Folders panel. Right-click on the folder name and choose to Syn-
chronize Folder from the pop-up menu. This will tell Lightroom to 
inspect the hard drive, compare it to what Lightroom is showing 
and then synchronize the two. 

Collections & New Image Versions If the image you move to Pho-
toshop and back is included in a collection, the new version of the 
image will be included in the collection ONLY if you moved it into 
Photoshop from that collection. 

Keywords Applied to New Version If your image has any keywords 
applied to it, the same keywords will also be added to the version 
of the image that was edited in Photoshop and then sent back to 
Lightroom.

You can tell if Lightroom has access to the 
original image file y looking at the text 
below the histogram. If the word “Orig-
inal” is included, then the image can be 
moved into Photoshop.
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HOMEWORK:
SET EXTERNAL EDITING PREFERENCES

SET PHOTOSHOP FILE HANDLING PREFERENCES
TEST ROUND-TRIP AN IMAGE

TEST SAVING FROM PHOTOSHOP
TEST OPENING AS LAYERS IN PHOTOSHOP
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SET EXTERNAL EDITING PREFERENCES
The first step to successfully sending an image to Pho-
toshop and having it appear in Lightroom once  you’re 
done is to set up Lightroom’s Preferences for the task. 

1. Choose Preferences from the Lightroom menu (Mac), or Edit menu
(Win)

2. Under the External Editing tab choose file format and settings that
you’d like Photoshop to use as a default when saving an image that
has been opened from Lightroom

3. Set up Additional External Editor settings if you need to open im-
ages in a program other than Photoshop. You can also use this area
to set up a secondary preference for opening images into Photo-
shop. For instance, I set the Edit in Photoshop settings for my most
commonly used settings (16 bit ProPhoto TIFF) and then I setup the
Additional External Editor to also send images to Photoshop, but
this time I use 8 bit AdobeRGB.

4. Choose if you prefer to stack the original image under the layered
file that Photoshop generates (if so, turn on the checkbox near the
bottom). I personally prefer to move the original images that de-
rivatives are based on to a subfolder called “Support Images”. By
doing so, I can easily prevent those files from showing up in Smart
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Collections, which would be more difficult if they resided in the 
same folder as the layered file. 

I *do not suggest* that you simply copy the settings that I use since 
they are not the most ideal for the majority of people. I personally 
think 8-bit Adobe RGB TIFF @ 240 is the most universally useful set-
ting for most users. You could set up the Additional External Editor 
setting for the same as above, but have it use 16-bits for those times 
when you know you’ll be making radical changes or retouching across 
a smooth sky since those are times when 16-bits would improve qual-
ity. That’s what I’d suggest if you “just want to know what to plug in 
without having to think about the details”. 

SET PHOTOSHOP FILE HANDLING 
PREFERENCES
Now that Lightroom’s External Editing preferences are 
set, let’s setup similar settings in Photoshop. The settings 
we are about to change will only be used when you save 
your images via Photoshop’s File>Save As command.
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1. Choose Preferences from the Lightroom menu (Mac), or Edit menu
(Win)

2. Under the File Handling section, turn off the Ask Before Saving Lay-
ered TIFF Files checkbox and then set the Maximize PSD and PSB
File Compatibility pop-up menu to Always.

TEST ROUND-TRIP AN IMAGE
Now, it’s time to test that everything is working proper-
ly when sending files from Lightroom to Photoshop and 
back again. 

1. Choose any raw file (JPEG if you don’t have any raw), head to the
Develop module and optimize the image’s general appearance
then choose Photo>Edit in Photoshop. That should cause the image
to open in Photoshop.

2. In Photoshop, create a layer and make a visually obvious change to
the image (like adding text, or painting) and then either type Com-
mand-S (Mac), or Ctrl-S (Win) or choose Edit>Save.

3. Return to Lightroom and see if the newly created layered file shows
up. The View>Sort setting you’re using might cause the image to
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appear at the bottom of the list if you’re not sorting the images 
alphabetically my filename. Also check to see if the original image 
is stacked under the layered file or not (it all depends on the prefer-
ences you chose earlier). 

4. With the layered TIFF file selected, head over to the Develop mod-
ule and make a visually obvious change such as extreme cropping
or converting the image to B&W.

5. Return to the Library module and choose Photo>Edit in Photoshop
and when prompted choose Edit Original. While in Photoshop you
will not see any of the changes you made in Lightroom since you
told it to open the original underlying image instead of actually
applying the Lightroom changes, which would have caused the
image to become flattened (no layers). Don’t worry, you’ll be able
to get back the changes you made in Lightroom once you’re done
editing the image in Photoshop. While you’re at it, make another
visually obvious change to the image and then close the image,
which should cause Photoshop to prompt you to ask if you’d like to
save the changes. Save the changes and then return to Lightroom
to see if your updated image appears. It sometimes takes up to 45
seconds after Photoshop is done saving before Lightroom realizes
that a change has been made. If the image does not update, then
head to the Develop module to see if the changes show up there.
You’ll occasionally have to zoom up on the image to 1:1 view to
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force Lightroom to inspect the actual file instead of relying on the 
preview file that it has stored in your LR catalog file. 

6. At this point your image probably looks just like it did in Photoshop
where you don’t see your second round of Lightroom adjustments.
If that’s the case, inspect the History list on the left side of the De-
velop module and click on the top-most step in the list. That should
force Lightroom to reapply those second-round changes.

7. For extra credit, rename the image using the settings in the Metada-
ta panel on the right side of the Library module (maybe change the
default “-Edit” at the end of the file to something more descriptive.

8. Feel free to loop to Photoshop and back again as many times as
you’d like. Just be sure to choose Edit Original when prompted to
make sure the Lightroom changes are not permanently applied
since that would also flatten the image in Photoshop.
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TEST SAVING FROM PHOTOSHOP
Now let’s make sure you know what to do with files that 
originate in Photoshop. 

1. Head over to Photoshop, choose File>New and create an image in
RGB mode (size and other settings are unimportant for the test).

2. Paint a squiggle across the document just so you’ll have something
to recognize if it were to show up in Lightroom when we’re done.

3. Choose File>Save As, turn on the Embed Color Profile checkbox,
then point it to a folder that you know has already been imported
into Lightroom and save the image in TIFF file format.

4. Switch to Lightroom and navigate the Folder list on the left side of
the Library module to the location in which you saved the image. (I
doubt it will show up at all at this point)

5. If the image does not show up when viewing the folder in Light-
room, then right-click on the name of the folder in the Folder list on
the left side of the Library module and choose Synchronize Folder.
Be sure the Import New Photos checkbox is turned on and then
click Synchronize to force Lightroom to reinspect the folder and
add any missing images.
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TEST OPENING AS LAYERS IN PHOTOSHOP
Now let’s make sure you know how to stack a bunch of 
images on top of each other as layers in Photoshop. 

1. Select a series of 5-10 images that are all the same orientation (hor-
izontal/vertical) and size (meaning from same camera). You can do
that by clicking on the first image in a series and then holding Shift
before clicking on the last image in the series. If you need to de-
select an image, then click on it while holding Command (Mac), or
Ctrl (Win).

2. Choose Photo>Edit In>Open as Layers in Photoshop and wait for
any progress bars to finish (they often appear near the Identity Plate
in the upper left) before switching to Photoshop to see if you ended
up with a multi-layered file. If it fails to work, then try a second time.
I find that on occasion you’ll end up with a single image and one
empty layer if it doesn’t work.

3. In Photoshop, choose Select>All Layers and then change the Blend-
ing Mode pop-up menu at the top of the Layers panel to Soft Light
which should produce an interesting result.

4. Close the file and when prompted to save changes, choose Save.
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5. Return to Lightroom to see if the image appears. It should be in
the same folder as the original images, but might be located much
further down the list due to your View>Sort setting. If it doesn’t ap-
pear, then right-click on the folder and choose Synchronize Folder.

6. Since the resulting image probably not something you want to
keep, click on the image and then press the Delete (Mac) or Back-
space (Win) key and choose Delete From Disk when prompted. Just
make sure you only have that single file selected and not all the
images it was created from.
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WHEN THINGS DON’T GO AS EXPECTED
Once you have used Lightroom long enough, it’s bound to happen. 
You’ll get a strange error or something won’t work the way it’s sup-
posed to. That’s why we’re including this session on troubleshooting. 
Here, we’ll cover a variety of issues you may come across and how 
to deal with them.

Lightroom won’t allow you to change a file name If you attempt to 
change the name of a folder or file and Lightroom does not allow 
you to do so, the likely reason is that the hard drive that contains 
the original file is not attached. When you move or rename a file in 
Lightroom, the program automatically makes the change on your 
hard drive, so it needs to be there in order to rename. You can tell if 
a hard drive is connected to your machine by looking at the name 
of the hard drive in the Folders panel on the left side of the Devel-

op Module. If there is a little 
green light next to the hard 
drive name, it’s connected. 
If that little “light” is gray, it’s 
not connected. (If the light 
is orange, it means that your 
hard drive is connected, but 
almost full.)

Parts of the interface are missing You 
can make entire sections of the interface 
disappear and reappear. If you do this 
by accident, it might be really frustrating 
when an entire area of settings is gone! 
To toggle the visibility of different tabs in 
the left and right panels of the interface, 
right-click in one of the blank areas in a 
tab heading. A pop-up menu will appear 
where you can turn off and on check box-
es to toggle the visibility of the different 
areas.

Right-click in a blank area to 
toggle the visibility of settings 
categories.

The green “light” to the left of a hard drive 
name in the Folders panel indicates that the 
drive is connected. 
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Missing folders If you go to 
your folder list and find question 
marks on some of your folder 
icons, that means that Lightroom 
is looking for the folder with that 
name but can’t find it. This prob-
ably is happening because you 
made a change to the folder 
from outside of Lightroom. Instead, you either moved, renamed or 
deleted a folder using your operating system. This confuses Light-
room. To fix this, right-click on the folder name and choose “Find 
missing folder” from the pop-up menu. You can then manually nav-
igate to the folder on your hard drive and it will be updated within 
Lightroom. To prevent this from happening in the future, be sure to 
initiate all file changes f om within Lightroom. 

Images not showing up in Lightroom If you use your operating 
system to add an image to a folder that you use in Lightroom, then 
Lightroom won’t immediately know that the image file is there. It 
only knows that an image or folder was moved if that move (or ad-
dition) was made from within Lightroom. It also won’t know if you 
deleted a file or folder from within your operating system. Go to the 
folder in your folder list, right click on it and choose Synchronize 
Folder from the pop-up menu. A dialog box will appear that will 
indicate whether it recognizes any new or missing images from the 
folder and you can use the check boxes to specify that you would 

like new images imported 
and/or missing folders deleted 
from the catalog. If Lightroom 
detects a new photo and you 
want to see what that photo 
looks like before importing it, 
turn on the “Show import di-
alog before importing” check 
box. To avoid this problem in 
the future, import images us-
ing Lightroom’s import dialog. 

A question mark on a folder means that 
Lightroom no longer knows where the 
folder is on your hard drive. Right-click on 
it to manually update the location. 

The Synchronize Folder feature will compare 
what’s in your Lightroom folder to what’s on 
your hard drive. 
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You can’t delete an image To delete an image, right-click on the 
image thumbnail and choose Delete from the menu that appears. 
It’s important to know, however, that the image won’t actually be 
deleted if you are viewing it from within a Collection or from within 
the Catalog panel. If you are viewing an image inside a Collection 
and try to delete it, the image will only be removed from the Col-
lection but not from Lightroom or your hard drive. Make sure to 
navigate to the image within the Folders panel in order to truly 
delete it. When viewing an image in a Collection, you can quickly 
locate the image within the file structure by right-clicking on the 
image and choosing Navigate to Folder on Hard Drive.

You can’t delete a folder If you right-click on a folder, you’ll find that 
there are no options within Lightroom for deleting that folder. That’s 
because Lightroom ignores all non-image files and doesn’t want you 
to accidentally delete a folder that may have other types of files in 
it. In order to delete a folder, you will have to right click on it and 
choose “Show in Finder.” Then you will have to manually delete the 
folder from your hard drive using your operating system. Back in 
Lightroom, the deleted folder will have a question mark icon on it. 
Right-click on it and choose to remove the folder from your catalog.

Missing Images If you ever see a little 
exclamation point icon on an image, it 
means that Lightroom thinks that the 
file is missing. The text beneath the his-
togram will also read “Photo is Missing.” 
The fir t thing I’ll do in this case is right-
click on the image and choose “Go to 
Folder in Library.” I will make sure that 
the green light for the containing hard 
drive is turned on. If it’s not, I’ll know 
that the image is missing because the 
hard drive containing it is not connect-
ed. If the hard drive IS connected, I will 
then look at the icon for the folder con-
taining the image. If there is a question 

An exclamation point icon on an 
image indicates that Lightroom 
can’t find the imag . 
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mark on it, then it means I’ll need to locate/update the folder like we 
did in the tip above. If there is nothing wrong with the folder, then 
I might right-click on it and choose Synchronize. If the image was 
renamed outside of Lightroom, this could fix the problem.  I’ll then 
look at the image itself. Chances are, the image was re-named or 
moved. To find it, look at the capture date for the image’s metadata 
and then do a search for that data on your hard drive. That might 
help you find the image. When you do find the image, click on the 
exclamation point icon to update the file loc tion. 

If none of the above solutions work, then the image may have ac-
tually been deleted from your hard drive. If this is the case, the fir t 
thing I would do is check any backup drives for the image. As a last 
resort, I will take a screen shot of the image in Lightroom so that I at 
least have a screen-resolution version.

Can’t find an existing Collection or Folder If you look in your Col-
lections panel and find that some or many of your Collections are 
missing, a fil er setting may have been changed by accident. Right-
click on the little magnifying glass icon on the left side of the search 
field at the top of the Collections list and make sure that the menu is 
set to All and not Synced. If you have this menu set to Synced, then 
you’ll only be viewing Collections that you chose to be uploaded to 
Adobe’s cloud server. Set the menu back to All and the rest of your 
Collections should appear in the list. 

The troubleshooting process will 
be the same if an existing fold-
er or folders are not showing up 
in your folder list. Right-click on 
the magnifying glass to the left 
of the search field and inspect 
the menu that pops up. In the 
case of the folder list, you can be 
viewing either All of your folders 
or just your Favorite Folders. If this menu is set to Favorite Fold-
ers, then only the folders you designated as favorites will appear in 
the list. (To mark a folder as a favorite, right-click on the folder and 
choose Mark as Favorite from the menu that pops up.)

Click on the magnifying glass icon to get a 
menu that lets you specify what the panel 
should display.
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Missing Keywords In your Key-
word List, you might have an 
instance where you’ll find that 
many keywords are not appear-
ing and that your list is much 
shorter than usual. If that’s the 
case, you may have turned on a 
fil er that only shows you peo-
ple keywords. Click on the mag-
nifying glass icon to the left of 
the Keyword List search field
and make sure that the menu is 
not set to People. 

Messy folder names You can specify how your folders should be 
displayed in the Folders panel on the left side of the Library Module. 

If you’re seeing too much info 
along with the folder names, 
you might have it set to also 
display the paths for navi-
gating to the folders on your 
hard drive. To fix this, click on 
the little plus symbol ( + ) to 
the right of the Folders pan-
el header and choose to view 
Folder Name Only.

Switch to a different hard drive If something happens to the hard 
drive containing your image library, you’ll have to switch to your 
backup drive and tell Lightroom to change drives. The following 
steps will also be required if the hard drive containing your images 
gets renamed. This could happen if you are using Windows and the 
hard drive letter is changed by your operating system. 

To make this update, you will need to tell Lightroom to show you 
the path that is used to get to your main hard drive. Changes are, 
you are only seeing the folders containing your images, but not the 
parent folders they belong in. Right-click on one of the base folder 
names and choose Show Parent Folder from the menu that pops 

Click on the magnifying glass icon to speci-
fy what the Keyword List should show. 

To view only the folder names within the Fold-
ers panel, choose Folder Name Only from the 
plus icon menu.
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up. Then, right-click on that parent folder and choose Show Parent 
Folder again. Continue repeating this process until you get to the 
name of your base hard drive. Right-click on the hard drive name 
and choose Find Missing Folder. Then, you can navigate Lightroom 
to a different hard drive (or the same, renamed hard drive).

Image[s] edited outside of Lightroom not updated If one of your 
images was adjusted using Bridge and Adobe Camera Raw, those 
adjustments will not automatically be reflec ed back in Lightroom. 
In Lightroom, there will be an icon to the right of the image thumb-
nail that looks like an upward-pointing arrow. This indicates that the 
metadata was changed externally. Click that upward-pointing arrow 
and a dialog box will appear, asking you whether you’d like to import 
the changes or overwrite them. If you choose to import the changes, 
then Lightroom will read the changes made by the other program 
and update the image file o reflect them

If you ever need Bridge and Camera Raw to 
recognize any changes made to an image 
in Lightroom, select the image in Lightroom 
and use the keyboard shortcut Command+S 
(Ctrl+S on Win). This will save the settings 
as a little text file that will be readable by 
Bridge and Camera Raw. 

Left: The arrow icon indicates that changes were made 
to the image’s metadata outside of Lightroom.  
Below: Click on the arrow to get this dialog, where you 
can decide whether you’d like Lightroom to accept 
those changes.
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Wrong sliders appear in Develop module If you ever find that you 
have the wrong sliders in Lightroom’s Develop module, it just means 
that the image was originally adjusted in an old version (where the 
sliders were different) and Lightroom is trying to maintain the ap-
pearance that you created in the old version. If you would like to use 
the more modern sliders, then look below your Histogram (or next 
to the word “Histogram” if the tab is collapsed) for a little lightning 
bolt icon. This icon indicates that the image was originally adjusted 
in an older version. If you click the icon, it will update the image to 
apply the modern sliders. If you want to switch from the current 
sliders to the sliders used in an older version, scroll down to the Cal-
ibration tab and use the “Process” dropdown menu to choose which 
older version you’d like to use. 

Export jpegs to lock in adjustments When you save a jpeg image 
in Lightroom, it’s not saving the full changes you’ve applied to the 
jpeg fil . It’s just recording the settings you used as a separate set 
of instructions. If you navigate to that jpeg on your hard drive and 
open it (or send it to someone), none of the adjustments you made 
in Lightroom will be reflec ed in the fil .

If you want to “bake in” the changes/adjustments you made, you will 
need to go to Lightroom’s File menu and choose Export in order to 
export the file with the changes you made in Lightroom. Then use 
that exported file o view or send to someone else. 

Left: Click the lightning bolt to update to the current version’s sliders. Right: Use the 
Process dropdown menu if you want access to the Develop sliders from an older ver-
sion of Lightroom.
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Changing time stamps Let’s say that you were traveling and you 
forgot to change the clock on your camera to match the time zone 
of your travel location. This might not be a big deal if you don’t rely 
on the times, but if you do make use of the time stamps, it might 
present an issue. To change the capture times of your images, select 
them in the Library module and then click on the Metadata Menu  at 
the top of your screen and choose Edit Capture Time. A dialog box 
will appear where you can either type in the new time or opt to shift 
the capture time by a certain interval. Click the Change button to 
lock in the settings. 

All of your images are backwards If, for some reason, you find that 
all of your images in Lightroom are suddenly backwards, meaning 
they have been mirrored, then the “Enable Mirror Image Mode” was 
somehow activated. To turn it off, you can find it under the View 
menu and you just need to turn the check box off.

Forget where a certain feature is? If you ever forget where a partic-
ular feature is within Lightroom, click on the Help menu at the top of 
your screen. At the very top of this menu as a search field and you 
can enter in the feature you were looking for. 

You can change the capture time on your images by using the Edit Capture Time dialog, 
which can be accessed via the Metadata menu. 

BASIC TROUBLESHOOTING  |  355



Copyright 2018 by Ben Willmore. All Rights Reserved

LIGHTROOM CLASSIC: THE COMPLETE GUIDE
BASIC TROUBLESHOOTING

Keyword search results are missing images In the Keyword List 
(within the Library Module), the number to the right of each key-
word indicates how many images have been tagged with that key-
word. Hover your cursor over the keyword and an arrow will appear 
to the right. Click on that arrow to see the images. Sometimes, the 
number next to the keyword doesn’t match up with the number 
of images that appear when you click on the arrow. This will hap-
pen if some of the images are stacked. If you have stacked some 
of these images, the number that appears above the Filmstrip will 

be less than the number that 
appears to the right of the key-
word. That’s because Lightroom 
is counting the stack of images 
as a single image. To expand all 
of the stacks and view every im-
age, you can select them all, go 
to the Photo menu and choose 
Stacking > Expand all Stacks.

Empty thumbnails If you ever open Lightroom and can’t see any im-
age thumbnails, it means that your Previews file or your Lightroom 
Catalog file got renamed or moved. Your Lightroom catalog file and 
your previews files have to match names perfectly in order for them 
to sync up. Navigate to where your catalog file lives on your hard 
drive and make sure that you see the catalog file and the preview 
file s] and that all the names match. 

The number to the right of the keyword 
indicates how many images have been 
tagged with it. Click on the little arrow icon 
to view all of the images. 

The names for the 
Lightroom catalog 
file and the p eview 
files mu t all match 
perfectly (except for 
the file xtension at 
the end. )
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FEEDBACK IN THE FACEBOOK GROUP
Think through all the lessons you’ve watched so far and 
consider where you have the most frustrations while 
working in Lightroom. 

Head on over to the class Facebook group at  
https://www.facebook.com/groups/BenWillmore/  
and let me know what you have in mind so I might be 
able to address it when I record future Q&A videos. 
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DESKTOP + LAPTOP:  
LIGHTROOM CATALOG WORKFLOWS 
Many of us work with Lightroom on two computers: a desktop (as 
the home computer) and a laptop (as the travel/on location com-
puter). Keeping the two machines in sync can take a bit of work 
and you have different options for how to accomplish this.

CATALOG OPTIONS

Simple: Pure Travel Catalog With the simplest option, you would 
create a new, separate Lightroom catalog every time you leave 
home and work on your laptop. 

Intermediate: Master on External Drive With this option, you would 
use one Lightroom catalog file and leave it on an external hard 
drive that travels between your two computers. 

Advanced: Master & Master + Travel With the advanced option, 
you would have a master catalog (the one you consider most up-
to-date) on your desktop computer and then travel with a copy of 
that catalog on your laptop, adding new photos to the catalog as 
you are out traveling. When you get home, you will have to sync 
the master catalog on your laptop to the one on your desktop. 

Alternative: Use Bridge for Travel With this option, you would not 
use Lightroom at all on your Laptop. You would instead use Bridge 
to view you images and Adobe Camera Raw to edit them. When 
you get home, you would import the images to Lightroom. 

Now let’s take a closer look at each of these choices, included the 
details, execution and pros and cons of each. 
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SIMPLE: PURE TRAVEL CATALOG

With this option, you would create a new catalog for each trip. 

Advantages

• Simplicity

• Small catalog sizes (They only contain the images that you’re
shooting on that particular trip.)

• New images can be contained on internal laptop drive

Disadvantages

• No easy access to photo archive

Tips

• Create template catalog with presets, keywords, etc. Each time
you leave for a trip, copy this catalog folder to your laptop so
the presets and preferences are always consistent.

Workfl w Create a master catalog that stays on your desktop com-
puter. This is the catalog that will contain all of your past photo 
shoots and it’s the one you’ll be returning to each time you come 
back from a trip. 

Create a new catalog on your laptop computer each time you leave 
to create more images. If that new catalog file is based on a tem-
plate, it can have all of your preferences, keywords, presets, etc. 
already inside of it. Add all new images captured during your trip 
to this catalog.

When you return to your desktop machine, import the images from 
the laptop catalog. To do this, go to the File menu and choose Im-
port from Another Catalog. Then direct it to the new catalog you 
had been using on the laptop. You can move the catalog to your 
desktop be using a memory card, external hard drive, etc. 
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INTERMEDIATE: MASTER ON EXTERNAL DRIVE

With this option, the one catalog is stored on a single hard drive 
and the hard drive simply moves between machines.

Advantages

Easy file management (You never have to worry about the catalog 
file getting out of ync.)

Access to full photo archive

Easy to keep in sync

Disadvantages

External hard drive could get damaged/dropped

Difficult o work on planes and other small spaces

Tips

Back up catalog before switching machines 

Workfl w In Lightroom, open the Preferences dialog, click on the 
presets tab and then turn on the “Store Presets with Catalog” check 
box. This will ensure that when you open the catalog on a different 
machine, the presets will go along with it. Then, you will need to 
quit Lightroom and copy the entire catalog folder to an external 
drive. You want to copy the entire folder because it contains not 
only your catalog file but also the previews that allow you to view 

If you keep a 
single catalog 
that’s stored on 
an external hard 
drive, be sure 
to open Light-
room’s prefer-
ences and turn 
on the “Store 
presets with this 
catalog” check 
box.
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your pictures even when the main hard drive is not connected. It’s 
also important that you copy this folder when Lightroom is not 
running. Next, you will delete the Lightroom catalogs from both 
your desktop and your laptop. This will ensure that you never open 
the wrong catalog. You’ll always open the catalog that’s contained 
on the external drive. Now, you can move the external drive be-
tween machines for regular use of the catalog. When you shoot 
new images, store them on that same external drive. If you store 
your photo archive on a different drive connected to your desktop 
computer, then drag the files from your travels to that drive within 
the Lightroom folder list upon returning. It’s important that you use 
Lightroom to move the files. If, instead, you moved them using your 
computer’s operating system, Lightroom will no longer be able to 
locate them. With this workfl w, if you use Windows, you’ll need to 
watch out for the letter assigned to the hard drive changing.

ADVANCED: MASTER & MASTER+TRAVEL

With this workfl w, you will copy the master catalog to your laptop 
and add to it while traveling. 

Advantages

• Access to full photo archive

• Can live on internal laptop drive

Disadvantages

• Challenge to keep both machines in sync

• Syncing can be time-consuming

• Problems occur when you make changes to both catalogs be-
fore sync

• Easy to end up with laptop and missing previews

Tips

• Export travel shots as a catalog before syncing back
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Workfl w To work using this method, you’ll need to copy your full 
master catalog from your desktop to your laptop. Make sure that 
you copy the Smart Previews file from your desktop to your laptop 
as well. Upon return, you’ll export your new captures as a separate 
catalog. Then, go to the master catalog on your desktop, go to the 
File menu and choose Import from Catalog in order to update the 
desktop machine master catalog. If you happened to make chang-
es to your archive images (your older files that existed before the 
trip), then you’ll need to import the entire catalog. 

ALTERNATIVE: USE BRIDGE FOR TRAVEL

If you decide to use this alternative workfl w, you will adjust your 
images using Bridge and Camera Raw while on your laptop and 
then import the images to Lightroom when you return to our desk-
top, along with the .XMP files th t include the adjustments. 

Advantages

• Simple

• Zero problems with syncing on return

Disadvantages

• Cannot use Collections, Virtual Copies, Smart Previews, etc.

• The Camera Raw interface may seem less familiar than Light-
room

Tips

• Set Camera Raw preferences to use sidecar file

Workfl w Keep Lightroom on your desktop computer and keep 
Bridge/ACR on your laptop computer. In Camera Raw, change the 
Preferences to save .XMP files. These .XMP files will include devel-
op settings, keywords, ratings, etc. Upon returning to your desk-
top machine, copy the entire folder to your photo archive drive. 
On your desktop, open Lightroom and click the Import button to 
import the new images (using the Add setting at the top of the 
Import dialog) from their new location on the photo archive drive. 
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As long as you specified that Camera Raw save .XMP files, all of the 
adjustments/edits to your images will stay intact when you import 
them to Lightroom. 

LIGHTROOM TIPS & TRICKS
Easily find keyboard shortcuts If you ever can’t remember a key-
board shortcut in Lightroom, there are a few different ways of fin -
ing out what they are. When you click on the different menus at the 
top of the screen, the keyboard shortcuts will be listed to the right 
of each command. If it’s the shortcut for a tool you need, hover 
your cursor over the tool’s icon and a tool tip will appear, listing the 
shortcut.  You can also hold down the Command key (Ctrl on Win) 
and tap the forward slash key ( / ) to get a nice list of keyboard 
shortcuts for the module you’re currently in. Click somewhere with-
in the list to make it go away.

To ensure that Camera Raw saves .XMP files, go o the Adobe Bridge menu at the 
top of the screen and choose Camera Raw Preferences. (If you are using Windows, 
this will instead be under the Edit menu.) In the Preferences dialog, change the “Save 
images settings in” menu to “Sidecar .xmp files” and click OK. hen viewing an im-
age thumbnail in Bridge, you can tell if it had edits that were saved into an .xmp file
because there will be an icon (or icons) above the top right corner of the thumbnail. 
These icons indicate whether the image has been adjusted or cropped.  
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Set your default Lightroom catalog You can specify which Light-
room catalog should open when you launch the program. Go to 
the Lightroom menu and choose Preferences. This will be under 
the Edit menu on Windows. Under the General tab, there is a De-
fault Catalog setting, and this will determine which Lightroom cat-
alog will open when you launch Lightroom. The menu will present 
you with a list of recently-used catalogs, or you can choose the 
Other option to specify a different catalog. You can also opt to 
have Lightroom load the most recently used catalog or you can tell 
Lightroom to prompt you to choose a catalog every time you open 
the program. You can also hold down the Option key (Alt on Win) 
as you launch the program and it will ask you to choose a catalog. 

Hold down the Command key (Ctrl on Win) and tap the forward slash key to get a list 
of keyboard shortcuts for the module you’re working in.
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Importing images  After you import images into Lightroom, the Li-
brary Module will open and it will present the images in the Latest 
Import section within the Catalog panel. Many times, I don’t want 
Lightroom to do this because it ends up taking me out of the folder 
I was previously viewing. I would rather it continue displaying the 
last folder that was open. You can achieve this by opening the Gen-
eral tab within the Lightroom Preferences dialog and turning off 
the “Select the ‘Current/Previous Import’ collection during import.” 

The General tab in the Preferences dialog has some additional set-
tings under the Import Options category that you should be aware 
of. Let’s look at a few:

There is an import setting here where you can decide whether you 
want Lightroom to “Show import dialog when a memory card is 
detected.” I like to keep this on.

If you happen to have your camera set up to capture raw+jpg, then 
the “Treat JPEG files next to raw files as separate photos” check box 
will be important to you. If you turn this on, both the raw version 
and the jpg version will be displayed separately in Lightroom. If you 
keep the setting off, then you will only see one version. 

The General tab in the Preferences dialog includes Import settings and the option to 
choose which catalog to use when Lightroom launches.
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Catalog Settings Lightroom has a separate preferences dialog for 
catalog settings. To open it, go to the Lightroom menu and choose 
Catalog Settings. The General tab will give you basic information 
about the catalog and a menu that lets you choose how often 
Lightroom should back up the catalog fil .

Quickly show a slideshow To show a slideshow on the fl , use the 
main menu and choose Window > Impromptu Slideshow. You can 
also use the keyboard shortcut Command+Return (Ctrl+Enter on 
Win). This will show your selected folder or collection of images in a 
full-screen slideshow. You can also customize how this slideshow will 
look. In a previous lesson, we talked about how to use templates and 
create custom slideshows in the Slideshow module of Lightroom. 

Use the highlighted menu in the Catalog Settings dialog to specify how often the 
current catalog should be backed up.
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From the Template browser on 
the left, you can right-click on 
one of the templates you like 
and choose “Use for Impromp-
tu Slideshow” from the pop-up 
menu that appears. A little plus 
symbol will appear next to the 
template name, indicating that 
it’s the one that will be used 
for Impromptu Slideshows. 
Then, whenever you use that 
Impromptu Slideshow feature, 
the template that you chose 
will be used.

Quickly Rate Images You can assign ratings to images by using the 
number keys on your keyboard, and there is a trick for making this 
process really fast. First, hit the Space Bar to make the fir t image fit
the screen, then use the number keys to rate the image, and then hit 
the right arrow key to move to the next image and repeat. Here’s the 
trick though: You can speed up the process by hitting the Caps Lock 
key, which will set Lightroom to auto-advance to the next image 
after you’ve hit a rating key. This way, you can just use the number 
keys and Lightroom will auto-advance every time you set a rating. 
You can also hold down the Shift key while applying the rating if you 
want to only temporarily use the auto-advance feature. This also 
works when clicking on star ratings within the Toolbar below the 
main image window.

Deselect multiple images When you have multiple images selected 
in Lightroom, you can click on the different image thumbnails and 
the one you click on will become brighter. This does not mean that 
the other images are not selected. It just means that the one you 
clicked on is the most selected. If you’d actually like to deselect the 
other images, then go to the image you want to stay selected and 
click just outside of the image thumbnail. All of the other images will 
be deselected. 

You can use any slideshow template for the 
Impromptu Slideshow feature. 
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Making your catalog file smaller If you have a lot of images in your 
catalog, you might notice that your catalog file can become pret-
ty huge. There are steps you can take for making your catalog file
smaller and therefore easier to back up. I like to create a Smart Col-
lection that searches for images that I have deemed not great. How 
does it know which images aren’t great? Well, I create a folder for 
every shoot that’s titled “Outtakes” and all of the images I’m not 
happy with go into that folder. 

Create a Smart Collection by clicking on the + icon at the top of the 
Collections tab. I will then tell that collection to search for all images 
that are in my Outtakes folders (see screen shot below) and I will 
call this Smart Collection “Outtakes” as well. When my Lightroom 
catalog becomes bloated, I will select all of the images in this folder 
and go to the Develop module. Then go to the main menu, choose 
Develop > Clear History. This will clear the develop history for the 
images and lessen the file si e of the catalog. 

The Smart Collection setting to include all images in your Outtakes folders. 

All three images are selected and the middle one is the most selected. Clicking on 
the images will change which is the most selected. If you’d like to like to deselect 
the other images, click just outside of the image thumbnail (where the target is). 
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Quickly see an image on the map If your image has GPS data, the 
coordinates will appear in the Metadata panel on the right side of 
the Library Module. To the right of the coordinates is a little arrow 
and if you click on it, the Map Module will open and zoom in to that 
image’s location pin on the map. If you hold down the Option key 
(Alt on Win), while clicking on the arrow icon, it will open Google 
Maps in your web browser, placing a pin on the location the photo 
was taken.

Merge multiple HDR images or panos at once In a previous lesson, 
we covered how to merge HDR and panorama images. If you are 
working through a shoot, you may want to merge images like this 
quickly, and Lightroom allows you to merge more than one set at a 
time. You will have to go to the Merge dialog box once, in order to 
specify your settings, so choose the set of HDR images you shot 
and either choose Photo > Photo Merge > HDR or use the keyboard 
shortcut Ctrl+H. This will open the HDR Merge window and you can 
specify your settings and hit the Merge button. Now, you can se-
lect your next series of HDR images and use the keyboard shortcut 
Shift+Ctrl+H.  This will cause Lightroom to merge the images to HDR 
in the background, without opening the Merge dialog but using the 
same settings that you used last time. You can use this shortcut as 
many times as you want, merging many sets of HDR images all at 

Above, the image’s GPS data is listed 
within the Metadata panel. Click on the 

arrow to the right and Lightroom will 
show the image on the map.
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once. The same thing goes for panoramas, but the keyboard short-
cuts are different. To access the Panorama Merge dialog, hit Ctrl+M. 
To run the panorama merge in the background, add the Shift key, 
hitting Shift+Ctrl+M. 

Image Profile Settings When you import raw images into Lightroom, 
they may look a bit more dull than if you had shot them as jpegs. 
That’s because jpeg files are processed in-camera, so they already 
have some automatic settings “baked in.” Raw files come into Light-
room with default settings and can therefore look a bit dull. If you 
would like the images to be imported looking more similar to what a 
jpeg would look like, open an image in the Develop Module, click on 
the Profile menu at the top of the Basic Panel and choose Browse. 
Alternatively, you can simply click on the icon that looks like four 
rectangles to get the same options. 

In the menu that appears, click to ex-
pand the Camera Matching category. 
These profiles will match the appear-
ance of the jpeg files that your cam-
era would create. The choices here are 
the same choices you have available in 
your camera and you can choose the 
one you like to use. When you click 
on a profil , Lightroom will adjust the 
raw file so that it looks like it would 
have, had it been a jpeg with a certain 
style applied. If you’d like this profile
to always be applied to your images, 
go to the Develop menu and choose 
Set Default Settings. When doing this, 
make sure that the adjustment sliders 
are set to their default positions be-
cause, when you choose to set de-
fault settings, it will include ALL the 
settings that have been applied, not 
just the camera profil . 

The Profile B owser can be found 
at the top of the Basic panel. 
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ADJUSTMENT SLIDER TIPS

Set adjustment sliders to default settings To set an adjustment slid-
er back to its default settings, double-click on the slider itself or on 
the name of the slider. 

Auto settings for one slider If you hold down the Shift key and 
double-click on a slider, it will have Lightroom intelligently decide 
what it thinks is the best setting and then automatically adjust the 
slider. This is basically applying the Auto setting to just one slider. I 
will often times do this with the Blacks slider because I like having 
a small part of my image that goes to solid black and this is a quick 
way of achieving that. 

Expand adjustment sliders for more precise control You can click 
and drag left and right on the border that separates the adjustment 
panels from the image window and this will make the panels wider 
or narrower. When you make the panels wider, the adjustment slid-
ers get longer as well and this makes it so you have more precise 
control when moving a slider. 

ADJUSTMENT BRUSH TIPS

Erasing with the Adjustment Brush If you hold down the Option Key 
while you use the Adjustment Brush, you will switch to the Erase set-
ting. Once you let go, you’ll go back to the paint setting. 

Change the color of the Adjustment 
Brush Overlay When you use the Ad-
justment Brush, you can turn on the 
“Show Selected Mask Overlay” check 
box (in the Tool Bar below the image) 
to get a colored overlay that shows 
you where you’ve painted. But what 
if the color doesn’t work for you? If 
you go to the main menu and choose 
Tools > Adjustment Mask Overlay, you 
can choose between a few other colors. Alternatively, the keyboard 
shortcut Shift+O will cycle between the colors. 

The Mask Overlay is set to red
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Auto Mask Settings When you are using the Adjustment Brush, there 
is an Auto Mask check box at the bottom of the adjustment sliders 
for the brush. If this is turned on, then it will  look at the crosshair in 
the middle of the brush and only apply the adjustment to areas that 
match that color. This can be useful when you need to apply the ad-
justment on a more complex object where it would be hard to paint 
without getting overspill. If the Auto Mask setting is turned off and 
you hold down the Command key (Ctrl on Win) while painting on 
the image, it will temporarily activate the setting. If the check box 
is turned on, then holding down the Command key will temporarily 
turn the setting off. 

Quickly change the size and hardness of the brush While using the 
Adjustment Brush, you can change the size of the brush by using 
the scroll wheel on the mouse (or by dragging two fingers up or 
down on a track pad). To change the brush hardness, do the same 
thing, but hold down the Shift key as well. 

Standard Preview Size When you import images into Lightroom, 
there is a setting on the right that lets you choose the side of your 
previews. One of those options is Standard Preview Size. Know that 
you can specify what the Standard Preview Size is within the Cata-
log Settings dialog (Lightroom menu > Catalog Settings). The Auto 

setting will look 
at the size of the 
screen you’re using 
and scale the pre-
view for that. This 
can be ideal if you’re 
working on your 
main computer. 
If, however, you’re 
working on a small-
er laptop and know 
that you’re going to 

be viewing the images on your larger desktop, then the preview 
may end up being too small. In that case, use the dropdown menu 
to choose the appropriate size for your larger screen.

Choose the Standard Preview Size in the Catalog  
Settings dialog.
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HOMEWORK:
EXTEND LIGHTROOM WITH A PLUG-IN

LOAD CLASS END MARKS
SET LIGHTROOM BACKUP SETTINGS

SET NEW DEFAULT SETTINGS
CREATE TIP SHEETS
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EXTEND LIGHTROOM WITH A PLUG-IN
Visit http://regex.info/blog/lightroom-goodies and 
choose at least one plug-in to install. Follow the installa-
tion instructions listed on the site and see how Lightroom 
handles managing plug-ins. I really like the Metadata 
Wrangler plug-in, but look through the list since everyone 
has different needs.
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Note: I have never met the person who runs the site mentioned above 
and have zero connection to him whatsoever. I just find it to be the 
most useful collection of plug-ins for Lightroom, which is the only rea-
son I’m sending you there. I don’t make a cent if you pay for a plug-in 
on the site.

Also consider performing a Google search to find additional Light-
room plug-ins to see if there is anything that aligns with your specific 
needs (add words such as wedding, portrait, etc depending on what 
you shoot).
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LOAD CLASS END MARKS
This class includes a set of End Marks that you can load. 
To find the end marks, head to the class page, click on 
Class Materials and then download the file called Ben’s 
Lightroom Endmarks. The file comes with installation 
instructions, so load the images and choose which end 
mark you’d like to have visible on the bottom of Light-
room’s side bars. 
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SET LIGHTROOM BACKUP SETTINGS
Choose Catalog Settings from the Lightroom menu (Mac), or Edit 
menu (PC) and set the Back up Catalog setting to Every time Light-
room exits. That way Lightroom will ask if you want to make a backup 
each time you quit the program. The next time you exit Lightroom, it 
should bring up a window asking if you’d like to back up your catalog 
file. In that window, be sure to press the Choose button and specify 
where the backup should be stored. I do not recommend storing the 
backup on the same hard drive as your working catalog since a failure 
of that drive would also wipe out your backup. I have mine set to back-
up to an external drive (either that, or I manually copy it to an external 
on regular intervals, like when I’m traveling). The two check boxes at 
the bottom of the window are optional. Turn them off if you’re in a hur-
ry and turn them on if the amount of time it takes to make a backup is 
not critical. 

ADVANCED TIPS & TRICKS  |  379



DAY 19
WEEK 4

I like having Lightroom ask me each time I quit if it should perform a 
backup. That way I can quickly decide if I’ve made any critical edits to 
my images, or if I’ve just been browsing and haven’t done anything 
worthy of a fresh backup. 
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SET NEW DEFAULT SETTINGS
When you first view an image in Lightroom, it is displayed 
using Lightroom’s default settings. Those defaults are not 
necessarily ideal. You can change what’s considered the de-
faults and often end up with much better starting images. 

Think through what you typically do to your images. Do you almost 
always increase the Vibrance and Clarity sliders? If so, why not incor-
porate those ideas into your default settings so that all your images 
start with more Vibrance and Clarity? Below are the settings that I dial 
in and save as my defaults. Don’t think of these settings as being ideal 
for everyone... evaluate your own images to figure out what might be a 
more ideal default setup. 
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Once you’ve dialed in the settings you’d like to use as your defaults, 
choose Develop>Set Default Settings. That will prompt you if you’d 
like to Restore Adobe Default Settings (which you could always use if 
you accidentally saved some settings and later decided you like the 
original defaults better), Cancel (which would not change your de-
faults), or Update to Current Settings (which saves the settings that 
are applied to the active image as your new defaults). You might get 
scared to read the phrase “Please note that these changes are not 
undo-able.” All that means is that if you had previously saved new 
defaults, you will not be able to get back to those previous default 
settings (unless you can find an image that has them applied), you’ll 
only be able to assign new ones or get back to the factory defaults. 
Changing your default Develop settings will only affect images that 
have never been adjusted in Lightroom. Any images that already have 
Develop settings applied will not be affected.
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CREATE TIP SHEETS
Review today’s lesson and create 5 post-it notes full of the 
tips that most apply to you... then put one on your screen 
until you remember contents before switching to the next. 
That will help you actually remember the tips and start to 
apply them on a daily basis. 
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LIGHTROOM CC
Sync with Lightroom CC There 
will be times when you’d like 
to access your images while 
you’re away from your com-
puter. Maybe you want to show 
them to friends, or work on 
them from your phone or tab-
let. You can do this by syncing 
your Lightroom images with Adobe’s Creative Cloud server. You’ll 
fir t need to enable this functionality and you can do that by click-
ing on the Identity Plate in the upper left corner of the Lightroom 
interface. Here, you will have the option to Sync with Lightroom CC. 
This means that you will be storing a copy of your images on Ado-
be’s servers. It will not store the full resolution images because we’re 
using Lightroom Classic, which is the version that stores images on 
the desktop. If you see a little Pause button next to the Sync with 
Lightroom CC setting, you know that the sync is in progress. If you 
see a Play button, you’ll need to click on it to turn on the sync. 

Create collections Once you 
have  turned on the ability for 
Lightroom to sync with Ado-
be’s servers online, you need 
to organize your images into 
collections. It is these col-
lections that will be synced 
with the cloud. Note that you 
must be using regular collec-
tions, and not Smart Collec-
tions. To create a collection, click on the little plus icon to the right of 
the Collections panel header and choose Create Collection from the 
menu that appears. Drag and drop images over the collection name 
to add them to the collection. 

Click on the Identity Plate to turn on the
ability to sync with Lightroom CC. 

Click on the plus icon at the top of the Collec-
tions panel to create a new collection.
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Sync collections In your Collections panel, you will see a little square 
to the left of each collection name. If you hover your mouse over 
one of them, you will see that it turns into a little lightning bolt icon. 
If you click on that icon, it will sync that collection with Adobe’s 
servers online. Alternatively, you can right-click on the name of a 
collection and from the pop-up menu that appears, choose “Sync 
with Lightroom CC.”  

After you click to sync a col-
lection, you will see an indica-
tor above your Identity Plate 
that says how many photos it’s 
syncing. You need to be online 
for this to work. What this pro-
cess is actually doing is creat-
ing Smart Previews for the se-
lected images and it is sending 
those previews to the cloud. In 
the Collections panel, a little 
lightning bolt icon will appear 
to the left of every collection 
that has been synced. If you’d 
like your Collections panel to 
show only synced collections, 
click on the magnifying glass 
icon the left of the search field at the top of the panel and choose to 
view Synced Collections from the pop-up menu.

Lightroom CC web version Now that you’ve set up some collections 
to sync online, let’s learn how to view them online. Right-click on 
the name of a collection and choose Lightroom CC Links > View on 
Web. Your web browser will open and it will take you to lightroom.
adobe.com. If you had previously logged in to Adobe’s website, then 
you should already be logged in and your pictures will appear here. 
If, however, you are not logged in or you are working on someone 
else’s computer, you will need to go to lightroom.adobe.com and log 
in with your Adobe user name and password. This will take you to 

This icon indicates that a collection has
been synced. 

To view only synced collections in the 
Collections panel, click on the magnifying 
glass icon and choose Synced Collections.
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all of your synced collections. They will be listed on the left side of 
the interface and you can click on them to view the collection in the 
main image window on the right. 

Click on an image to 
view a larger version 
of it. When viewing a 
single image, some 
settings will appear 
at the bottom and 
these can be used to 
flag and rate the im-
age. When you make 
a change to an im-
age online in Light-
room CC, the change 
will automatically 
be synced with the 
desktop version. 

In the web version of Lightroom CC, all synced collections will be listed on the left.

When viewing an image large, there will be rating op-
tions at the bottom. 
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In the upper left of the image window, there is an Edit this Photo 
button. Click on it to access the adjustment sliders. The adjustment 
options are very similar to the adjustments you find within the Basic 
panel in Lightroom Classic. 

When you make adjustments to an image online, it’s saving those 
adjustments as a small text file and that is what is being synced with 
the desktop version. This makes it so the syncing process is fast. 
When an image has been adjusted online in Lightroom CC, the His-
tory panel will have a step that reads “From Lightroom Mobile.” 

Click on the Save & Exit button in the upper left when you are done 
working with the adjustment sliders. Go go back to viewing all of the 
images in the collection, click on the little X in the upper right corner. 

Comments You can add comments to images in Lightroom CC, but 
in order to do this, you must fir t make the collection public. In the 
desktop version (Lightroom Classic), right-click on the name of the 
collection and choose Lightroom CC Links > Make Collection Public. 
After doing this, a public link will appear in that same pop-up menu 
and this will enable you to send the link to someone else so they can 

The adjustment sliders on the web interface are similar to those found in the Basic 
panel on the desktop. 
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view your images without having 
to log in. When viewing an image, 
there will be a little speech bub-
ble icon to the right. Click on it 
to add a comment. I like to use 
this to add instructions on what 
needs to be done with the im-
age. Back in Lightroom Classic, 
that comment will appear within 
the Comments panel on the right 
side of the Library Module. From 
here, you can also respond to a 
comment. If an image has been commented on, a little speech bub-
ble icon will appear over the image’s thumbnail. 

Working on a phone or tablet  Adobe also has a Lightroom app that 
will enable you to view and adjust your synced images on a phone or 
tablet. When you fir t open the app, you’ll need to log in with your 
Adobe ID, and then you will have access to your images. The main 
screen will display a list of synced collections. Tap on one to view all 
of the images inside. Tap on a single image to view it full-screen. At 
the top of the interface, there is a back arrow that will take you back 
to viewing the collection, and then viewing the collection list. 

After a comment has been added in the 
web version, it will appear in the Com-
ments panel on the right side of the 
Library Module.

The Lightroom app on the iPhone
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It will display text in the top cor-
ner of the images, indicating 
which ones are raw files. In the 
bottom right corner of the inter-
face, there is a camera icon and 
when you tap this, you can ac-
tually capture raw files with your 
phone if you have new enough 
hardware. This is nice because it 
enables you to maintain higher 
fidelity when adjusting the im-
ages, especially when bringing 
detail out in the shadows and highlights. To adjust an image, tap on 
an image to view it full screen. The adjustment icons will appear on 
the right side of the interface. Tap on one and the settings related to 
it will expand. 

Offlin access By default, the Lightroom app is using the Internet 
to access your synced images. But what if you want to view and 
work with the images when your device is not online? There’s a way 

Tap the camera icon to capture an image
with your phone.

An image is being adjusted on the iPhone. Tap on the adjustment icons along the 
right to expand the settings panel.
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to enable this. In the collection list, there are three little dots ( …) to 
the right of each collection name. Click on it to access some options 
for that collection. One of the options is Store Locally. If you choose 
this, it will tell you how much space it will take up on your device. 
Click the download button to save the images to your device.  

Importing images from your camera roll You can add images from 
your camera roll to the Lightroom app by tapping the Add Image 
button on the bottom right corner (next to the camera icon). This 
will show you the images in your camera roll and you can tap on 
the image you want to view it large and then tap on the little check 
mark in the upper right to import the image to the app. This will, in 
turn, sync with the desktop version so it’s a great way to get images 

shot with your phone into 
Lightroom. In Lightroom 
Classic on the desktop, 
your device name will be 
listed along with the hard 
drives within the Folders 
panel and any images im-
ported from your phone 
will appear here.  

To enable offline v wing and editing, tap on the three dots ( ...) to the right of a 
collection name and choose Store Locally from the menu that appears. 

If you have imported images from your device, it 
will be listed along with the hard drives. 
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PUBLISH SERVICES
Lightroom’s Publish Services 
give you the ability to directly 
upload photos from Lightroom 
to services like Facebook, 
Flickr, Smugmug, etc. The Pub-
lish Services tab can be found 
on the left side of the screen in 
the Library module. All of the 
Publish Services you currently 
have set up will appear within 
this tab. To add a new service, 
click on the little + icon at the 
top of the tab and choose “Go 
to Publishing Manager” from the pop-up menu that appears. The 
Publishing Manager is essentially an abbreviated export dialog box. 
Let’s look at some of the publish services that you can set up.

PUBLISH TO HARD DRIVE

One of the options in the Publishing Manager is Hard Drive. Let’s 
say that you want a folder on your hard drive that is always for your 
portfolio. This will make is really easy to access your best images and 
send them to people. Click on the “Add” button on the left side of 
the Publishing Manager. From the box that appears, use the drop-
down menu and choose “Hard Drive.” Then give this publish service 
a name and click Create. Now, you will use the series of options with-
in the main Publishing Manager window to specify the settings. 

Export Location Use the Export Location area to choose which spe-
cific older the images should be exported to on your hard drive. 

File Naming Use the File Naming area to specify whether the file
names should stay the same or whether you would like them to be 
renamed to something new that you type in. 

Video The Video area is where you can decide whether or not to 
include video files

The Publish Services tab can be found on
the left side of the Library module.
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File Settings Just like in the regular Export dialog box, this is where 
you can choose what file format should be exported, the quality of 
the image file and the olor space. 

Image Settings If you would like to resize the image, you can set the 
size limits here. If you’re going to be using these images for email or 
web viewing, it’s a good idea to scale them down to a good screen 
size and resolution (72 dpi). 

Output Sharpening This area gives you the option to apply sharpen-
ing on export. You can choose between print or screen, depending 
on your intended use of the images. And of course, you can also 
choose “none.” 

The Publish Services dialog box
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Metadata Just like in the regular Export dialog, you can choose how 
much metadata will be included with the files. Remember, the last 
two options in this menu include keywords. The fir t two do not. 

Watermarking Again, you can apply one of your watermarks to the 
images exported to this publish service. All of the watermarks you 
have previously created should show up in the dropdown menu here. 

Once you have gone through all of the above settings, click the Save 
button in the lower right. Now, your new publish service should be 
visible in the Publish Services tab within the Library module.

HOW TO PUBLISH PHOTOS

To send images to a publish service, simply drag them within the 
publish service on the left side of the interface. You will see the num-
ber of images that have been sent there next to the name. Note that 
the images wont be published automatically though. To publish the 
photos, click on the name of the publish service and all of the images 

to be published will 
appear in the main 
image window. At 
the top right, click 
on the Publish but-
ton. You will see a 
progress bar ap-
pear in the upper 
left of the window 
as the images are 
being published. 
In the case of the 
Hard Drive publish 
service, the imag-
es are being sent 
to the folder you 
specified on your 
hard drive.  

Any unpublished images will appear on the top half of the 
window. Click the Publish button to publish them.
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If you end up making additional adjustments to an image after you 
have published it, Lightroom will let you update the file to the pub-
lish service. If you click on one of the services to view the images 
that have been published there, you will see an area called “Modified
Photos to Re-Publish” if there are any published images that Light-
room knows you changed. Simply click the Publish button again and 
Lightroom will replace the published image with the updated image. 

CREATING A PUBLISH SERVICE FOR AN ONLINE SERVICE

You can also create Publish Services for your accounts with Face-
book, Flickr, Smugmug, etc. To do this, you will again click on the 
little + icon at the top of the Publish Services tab and use the drop-
down menu to choose which service you want. Give it a name (op-
tional) and click Create. Now, you will get all of the same options as 
we talked about above when publishing to the hard drive, but there 
will be an additional area for entering in your account info. If you 
are publishing to something like Facebook, you will have to click 
the “Authorize on Facebook” button, which will send you to a web 
browser where you will have to enter your account info and autho-
rize Lightroom to publish to Facebook. 

You will also have a few options that will be specific to the service 
you chose. This might include what album or folder the image should 
be published to. 

When setting up a publish service for something like Facebook, you will need to enter 
account information. 
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BEST PRACTICES FOR WORKING IN LIGHTROOM
As we wrap up this month-long course, here are some final thoughts 
on how you can make the most of your experience with Lightroom.

Consistency is Key

• Unique and useful file names (YEAR_MO Shoot Name XXXXX

• Standardized folder naming (add -- to end of folder of not us-
ing a system) My standard system includes the following fold-
ers: In Progress, Outtakes, Support Images, Personal Images,
Skies, etc.

• Take advantage of as much automation as possible to save
time and energy. This includes making use of Smart Collec-
tions, Keyword hierarchies, etc.

• Redundant backups that are kept up to date.  This includes a
RAID or Drobo, on-site backup and off-si e backup

Keep Lightroom in the Loop

• After importing, make all folder and file name changes within
Lightroom

• Move files within Lightroom folders to move them on your hard
drive

• Open an image in Photoshop starting from within Lightroom

• Save images from Photoshop in TIFF or PSD format (with the
Maximize Compatibility setting on)

• When re-editing a layered fil , choose Edit Original in order to
retain layers

• If something isn’t in sync, choose Synchronize Folder to update it
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FILE FORMAT MINDSET

WORKING FILES

A working file is one that you plan to re-open and continue to work 
on at a later date. What’s most important with these files is that 
there is no loss of information or quality when the image is saved 
and re-opened and that all features used to create the image are 
supported. 

RAW with XMP

• There are two different ways Lightroom can store the adjust-
ment changes you made in the Develop module: 1) in the Light-
room catalog fil , 2) in both the catalog file and as a separate
.XMP file that is stored in the same folder as the original image
and has an identical file nam .

• I think of the .XMP file as extra assurance so that if anything
ever happens to my Lightroom catalog fil , or Lightroom won’t
launch at the moment I need it, then I can still access the original
file via Adobe Bridge and it will be able to show me the results
of my adjustment by reading the .XMP file that is in the same
folder. Some people don’t like the idea of using .XMP files be-
cause you then have twice as many files on your hard drive re-
lated to your images. Those extra files take up very little space,
so I’m not worried about it.

• In fact, it gives me great pleasure to know that I can copy not
only the original raw fil , but also the adjustments that have
been applied by just copying both files when I need to. Not only
that, but I can backup all my adjustments by replacing any exist-
ing .XMP files on my backup drive with more up to date versions
that reflect changes that I’ve recently made. Just don’t freak out
about backups since all your adjustments are also contained in
your Lightroom catalog fil , so you’re set if you have that file al-
ready backed up. This is just a second level of backup that I like
to have.
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• Some people convert their raw files to DNG files because one of
the benefits of that file format is that the information that would
usually be stored in the .XMP file can be included directly in the
image file so there are not two files for each image. The only
problem is that now you have to copy the entire multi-mega-
byte image file (43MB each in my case) to update your backup
if you’ve made additional adjustments. I prefer using a raw fil
plus .XMP file so, all I need to copy to update my backup files is
the tiny .XMP files (about 8-32KB each), which can happen very
quickly. I use a program called Beyond Compare to compare
my main image hard drive to my backup and see exactly which
.XMP files are out of date on my backup. I’m not trying to talk
you out of using DNG files. They’re fin . I just want you to know
why I personally prefer to use raw+.XMP.

Layered TIFF This is my default file format for layered files that were 
generated in Photoshop. There is no quality difference between 
PSD and TIFF files, so it’s largely a personal preference which one 
you use. You could flip a coin to decide. Having said that, there are 
a few advantages that TIFF has over PSD, which is why I use TIFF 
for most of my layered files.

• 4GB maximum file si e (PSD is limited to 2GB max)

• No maximize compatibility setting to deal with (if you forget
to have that turned on with PSD, then the file won’t display in
Lightroom)

• Can save 32-bit HDR images from Photoshop or other programs
in this format and then adjust them in Lightroom. Lightroom
does not support this feature with PSD files.  (although I mainly
use DNG for HDR images since that’s what Lightroom generates
when you merge to HDR)

• TIFF is a more widely supported general file format, while PSD is
considered a little bit more of a specialty file format and there-
for not as widely supported by other programs.

• If I open a JPEG file in Photoshop and plan to make additional
changes later, then I save the result as a TIFF (although PSD
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would be fine too) so the quality is not degraded when the file
is re-saved. JPEG is a good delivery file format, but is not good 
for working files

• When saving a layered TIFF fil , I usually use default settings.

Layered PSD

• There is absolutely no problem using this file format with Light-
room. You just have to make sure to turn on the Maximize Com-
patibility checkbox if you are ever prompted when saving a fil .
If you don’t see it as an option, then a preference in Photoshop
has most likely been set to always include use the setting.

• There is zero quality difference between PSD and TIFF. If you
are currently using PSD and are not running into the items I
mentioned above about TIFF, then there is no reason to switch
to using TIFF files

Large Document Format PSB

• Both TIFF and PSD have a limit on how large of a file they can
save (2GB for PSD, 4GB for TIFF). When you run into that limit,
then you have to use the PSB (known as Photoshop Big, or large
document format). The only problem is that Lightroom is not
compatible with this format. For that reason, I usually fl tten my
image and then re-save it as JPEG to load into Lightroom and
then note in the file name that there is an associated PSB fil
present, so I know I can manually open it in Photoshop if I need
to do additional work.

DELIVERY FILES

I use the term Delivery Files for any finished image that is being 
given to someone else or uploaded onto any kind of service or web 
site. The key distinction is that the image is 100% done from an ad-
justment and retouching standpoint. In this case, I’m willing to use 
a file format that will slightly degrade the quality of my image if 
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that will produce a smaller and therefore more convenient fil . 

JPEG The most universally accepted image file format on earth. 
Just about any program that can display an image can open a 
JPEG fil . JPEG files cannot contain layers and are limited to 8-bits 
of data (means just over 250 brightness levels between black and 
white). If you have the quality setting turned up to at least 80% 
when exporting, then most people would not notice any degra-
dation of the image in general. Maxing it out to 100% would be al-
most compatible to a TIFF file in quality. This is the file format I use 
95%+ of the time when I’m sending photographs to anyone. I’ll use 
setting below 80% when file size is more important than quality. I 
might do that when I’m sending 200 files to someone, or when I 
want an email to go out quickly. This file format is a less than ideal 
choice when saving solid-colored graphics such as signatures and 
logos. 

PNG I use this format for small graphics. It’s a good format for lo-
gos, signatures and other solid-colored graphics that need to be 
displayed online. I also use it for many of the End Mark images that 
I load into Lightroom and display at the end of the left and right 
panes. 

TIFF I rarely use this format to deliver final files, but would save 
a fl ttened (no layers) image in this format if I though the person 
who I was sending it to might do additional work on the image and 
I would like to maintain the same quality as the original. This for-
mat can save 16-bits of data (thousands of brightness levels). Most 
people don’t want to deal with the larger files that TIFF produces, 
so I only use it in special circumstances. Most of the time a JPEG 
with 100% quality will produce similar quality in a much smaller fil .

ARCHIVE FORMATS

These are the file formats that I might consider using when a proj-
ect is 100% finished and I want to finali e and optimize the files for 
my long-term archives. 
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Lossless DNG (for good raw images)

• You can convert any image to DNG format by choosing Li-
brary>Convert Photo to DNG. I use that setting with the Delete
Originals checkbox turned on and the Use Lossy Compression
turned off. By leaving the compression turned off, the resulting
DNG file is as high quality as the original raw fil . This newly
created file will include the information that would usually be
stored in an .XMP fil , so only one file is needed to store both
the photo and the develop settings that have been applied to it
in Lightroom. Note: There is generally no good reason to turn on
the Embed Original Raw File since it would produce a huge fil .
I’d rather not convert to DNG than turn that on.

• One of the main advantages of DNG is the ability to check the
integrity of the file to make sure it has not become corrupt by
choosing Library>Validate DNG Files. A file can become corrupt
if there are problems with your hard drive. If that feature reports
an error, then replace the file with a copy from your backup
drive.

• DNG files can also be a bit smaller than your original raw file
because it applies lossless compression to the image.

Lossy DNG (for outtake raw images)

• Converting an image to DNG (as mentioned above), but using
the Use Lossy Compression checkbox can produce significantl
smaller files while retaining the raw characteristics of the image.
I wouldn’t do this to my portfolio-quality images, but it’s a nice
way to reduce the amount of hard drive space that my Outtakes
folder takes up. I only convert to lossy DNG when a project is
done, which is when I don’t think I’ll need to use the images in
the Outtakes folder. Many people would not notice the quality
difference, between the original raw and a lossy DNG, but you
might start to notice if you apply extreme adjustments to the
images.
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TIFF or PSD (for layered images from Photoshop)

• Either of these file formats works great for layered files that were
created in Photoshop or similar software.

FINALIZING A SHOOT OR PROJECT

• Delete empty In-Progress folder to indicate folder needs no ad-
ditional work

• Hero Images: Stack similar images, Rate as Superhero (5 stars),
shoot hero (4 stars), second level (3 stars)

• Keyword all hero images and convert to lossless DNG (possibly
with full-size preview)

• Outtakes: Convert to lossy DNG, remove Smart Previews, clear
history (and optionally remove outtakes folder from Lightroom,
but retain on hard drive)

• Add Superhero images to portfolio Publish Service

• Export as Catalog to archive with original file
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GET STARTED WITH LIGHTROOM MOBILE
If you own an iPhone, iPad, or Android device, then download Light-
room from the appropriate app store (it’s free). Launch the app and 
sign in with your Adobe ID, so the app knows which account you are 
using. Return to Lightroom on your computer, click on the Identity 
Plate that appears in the upper left of the screen (which might contain 
your name, or a generic Lightroom badge) and be sure that “Syncing 
to Lightroom Mobile” has been enabled. You can also inspect the set-
tings found under the Lightroom Mobile tab in Lightroom’s preferenc-
es window to make sure you’re set up on the same Adobe ID. 

Now, create some collections on the desktop version of Lightroom 
(not smart collections) and then click to the left of the collection name 
where you find a small square to make the collection sync to Light-
room mobile. This is a great time to create a portfolio collection so you 
can always have the portfolio available on your mobile device. 

NOTE: Above I refer to the web-based and phone/tablet version as 
Lightroom Mobile even though Adobe has changed the names of 
those products to Lightroom CC. Just because Adobe changed the 
names does not change its relationship to Lightroom Classic. Adobe 
happens to also have a desktop application called Lightroom CC that 
stores your photos on the cloud, but the web/phone/tablet versions 
that have a matching name work just fine with Lightroom Classic. I 
use the name mobile above so you don't confuse it with the desktop 
version that stores your images on the cloud. 
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Wait at least five minutes and then switch to your mobile device. You 
should see a list of all the collections you synced with Lightroom mo-
bile. To the right of each collection will be three circles (an ellipsis), 
click on that icon and choose Enable Offline Editing, which will cause 
Lightroom mobile to completely download the Smart Previews for ev-
ery image in the collection so that you can view them even when you 
are not connected to the Internet. 

WORKFLOW REFINEMENT & SUMMARY  |  405



DAY 20
WEEK 4

CREATE PUBLISH SERVICES
In today’s lesson, we covered how to create Publish Ser-
vices that can link Lightroom to many social media web 
sites. If you use Facebook or Flickr, create a new publish 
service for that web site and post at least one image to 
make sure everything is working. 

Also, consider creating a Hard Drive publish service for a portfolio 
folder on your hard drive, so you can quickly save JPEG images to a 
special folder and always have your portfolio available even when you 
are not running Lightroom. The details of how to accomplish this are 
mentioned in today’s video lesson.
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GIVE ME FEEDBACK IN 
THE FACEBOOK GROUP
Go visit the class Facebook Group at  
https://www.facebook.com/groups/BenWillmore/  
and let me know what you thought of the class as a 
whole. I’d love to know what you’d still like to learn that 
I didn’t happen to cover during class as well as what you 
found to be most useful about the class. 
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